Phylogenetic Analysis Using Parsimony
* and other methods

Version 4.0 beta version

David L. Swofford

Beta Documentation

This documentation is currently under construction, therefore, we cannot guarantee the accuracy of the information described herein. A much more user-friendly manual is in progress. Revisions will be made available to registered users over the World Wide Web at http://paup.csit.fsu.edu. A list of frequently asked questions is also available at this website. Many of the commands and options described in this document are hyper-linked to facilitate and promote on-line use until a final draft is complete. Comments regarding this document should be addressed to paup-support@csit.fsu.edu.
PAUP* 4.0 beta version disclaimer and user agreement

The version of PAUP* 4.0 currently available is a beta version. We are not aware of bugs that would cause the program to obtain incorrect results, but they could certainly exist. Other bugs could cause the program to terminate abnormally or misbehave in other ways. Your use of this software implies your acceptance of its unfinished status. We would greatly appreciate receiving reports of any problems you encounter. Send them by email to: paup-support@csit.fsu.edu. Please include all details necessary to reproduce the problem, including: (1) type of machine and operating system version; (2) specific version number of PAUP* (e.g., PAUP*4.0b8); (3) a specific sequence of operations that will cause the problem to occur, beginning with start-up of the program; and (4) a sample data file and any other associated files that will enable the problem to be reproduced.

The following license agreement and disclaimer apply both to the beta copies and to the final release version:

PAUP* is licensed to individual users for the sole purpose of facilitating the scientific research of the licensee. This software may be used in more than one location or by more than one person provided that there is no possibility that it will be used by two or more people simultaneously. Generally, this qualification means either of the following: (1) the program may be used by a single researcher on any number of machines in his or her possession, or (2) the program may be installed on a single computer and used by one or more individuals who have access to that computer.

THIS SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND. DAVID L. SWOFFORD AND SINAUER ASSOCIATES DO NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE SOFTWARE OR DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, RELIABILITY, CURRENTNESS, OR OTHERWISE. IN NO CASE WILL THESE PARTIES BE LIABLE FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR OTHER DAMAGES THAT MAY RESULT FROM USE OF THIS SOFTWARE.

Suggested Citation

PAUP* 4.0 is in many ways comparable to a monographic article. In its approximately 180,000 lines of code, PAUP* implements numerous original concepts and ideas and contains many new algorithms. For these reasons, citation of the program in a book format is recommended:


# Table of Contents

- Table of Contents ................................................................................. 1
- Command Reference ............................................................................ 5
- Command Format .................................................................................. 5
  - Identifiers .......................................................................................... 6
  - Common Command Elements ............................................................... 8
- Commands used in the TAXA Block .................................................... 10
  - Dimensions ....................................................................................... 10
  - TaxLabels .......................................................................................... 10
- Commands used in the CHARACTERS Block ....................................... 11
  - Dimensions ....................................................................................... 11
  - Format ............................................................................................... 12
  - Eliminate ........................................................................................... 15
  - TaxLabels .......................................................................................... 16
  - CharStateLabels ............................................................................... 16
  - CharLabels ....................................................................................... 16
  - StateLabels ...................................................................................... 17
  - Matrix ............................................................................................... 17
- Commands used in the DATA Block ................................................... 18
- Commands used in the ASSUMPTIONS Block ..................................... 19
  - Options ............................................................................................. 20
  - UserType .......................................................................................... 20
  - TypeSet ............................................................................................ 21
  - WtSet ............................................................................................... 21
  - ExSet ............................................................................................... 22
  - AncStates ......................................................................................... 22
- Commands used in the SETS Block ..................................................... 22
  - CharSet ............................................................................................. 23
  - TaxSet ............................................................................................. 24
  - CharPartition, TaxPartition ................................................................. 24
- Commands used in the TREES Block .................................................. 25
  - Translate .......................................................................................... 25
  - Tree ................................................................................................. 25
- Commands used in the CODONS Block ............................................. 27
  - CodonPosSet .................................................................................... 27
Commands used in the DISTANCES Block...............................................27

Dimensions .................................................................................................. 28
Format ............................................................................................................. 28
TaxLabels ........................................................................................................ 30
Matrix .............................................................................................................. 30

Commands used in the PAUP Block.................................................................30

Options And Subcommands Affecting Multiple Commands .......................30
? .......................................................................................................................... 33
! .......................................................................................................................... 33
Agree ................................................................................................................... 33
AllTrees ............................................................................................................. 35
Ancstates ......................................................................................................... 36
Assume ............................................................................................................. 36
BandB ............................................................................................................... 37
BaseFreqs ....................................................................................................... 39
BootStrap ....................................................................................................... 39
CD ...................................................................................................................... 42
CharPartition ................................................................................................. 42
CharSet ............................................................................................................ 42
ClearTrees ..................................................................................................... 43
Condense ........................................................................................................ 43
Constraints ..................................................................................................... 44
ConTree .......................................................................................................... 44
CStatus ......................................................................................................... 47
CTYPE ............................................................................................................ 48
Defaults ......................................................................................................... 49
Delete .............................................................................................................. 49
DerootTrees ................................................................................................. 50
DescribeTrees ............................................................................................... 51
DOS .................................................................................................................. 53
DScores ......................................................................................................... 53
DSet ............................................................................................................... 55
Edit .................................................................................................................. 59
Exclude ......................................................................................................... 60
Execute .......................................................................................................... 60
Export ............................................................................................................ 61
ExSet .............................................................................................................. 62
Filter .............................................................................................................. 62
Factory ........................................................................................................... 64
FStatus .......................................................................................................... 65
GammaPlot .................................................................................................... 65
GenerateTrees ............................................................................................... 66
GetTrees ........................................................................................................ 67
Help ................................................................................................................. 69
HomPart ........................................................................................................ 70
HSearch ........................................................................................................ 71
Include .......................................................................................................... 76
# Table of Contents

- InGroup ................................................................. 77
- JackKnife .............................................................. 77
- Lake ........................................................................ 79
- Leave ...................................................................... 81
- LoadConstr .......................................................... 81
- Log .......................................................................... 82
- LScores .................................................................... 83
- LSet .......................................................................... 87
- MatrixRep ............................................................ 92
- MPRSets ................................................................. 94
- NJ ............................................................................. 94
- Outgroup ............................................................... 96
- PairDiff ................................................................. 96
- Permute .................................................................... 97
- Pscores ..................................................................... 98
- PSet ......................................................................... 101
- Puzzle ...................................................................... 103
- Quit ......................................................................... 105
- RandTrees ............................................................. 105
- RateSet ...................................................................... 106
- Reconstruct ........................................................... 107
- Restore ...................................................................... 108
- RevFilter .................................................................. 108
- Reweight ................................................................... 108
- RootTrees ............................................................... 109
- SaveAssum ............................................................ 110
- SaveDist ................................................................... 111
- SaveTrees .............................................................. 112
- Set ............................................................................. 114
- ShowAnc ............................................................... 121
- ShowCharParts ....................................................... 122
- ShowConstr .......................................................... 122
- ShowDist .................................................................. 122
- ShowMatrix ........................................................... 123
- ShowRateSets ........................................................ 123
- ShowTaxParts ........................................................ 123
- ShowTrees ............................................................. 124
- ShowUserType ......................................................... 124
- SortTrees ............................................................... 125
- StarDecomp ............................................................ 125
- SurfCheck .............................................................. 126
- TaxPartition ........................................................... 126
- TaxSet ...................................................................... 127
- Time ......................................................................... 127
- ToNEXUS ............................................................... 127
- TreeDist ................................................................. 129
- TreeInfo .................................................................... 130
- TreeWts ................................................................. 131
- TStatus ..................................................................... 131
This document describes the PAUP* command format. Unless stated otherwise, these commands may be included in the PAUP block of a NEXUS file, or typed from the command line. The EDIT command may only be issued from the command line. All users will need to be familiar with the commands available in the TAXA, CHARACTERS, ASSUMPTIONS, SET, TREES, CODON, and DISTANCE blocks, which are normally placed in PAUP input files. In versions of PAUP* that provide a menu-based interface, only knowledge of these "block" commands is required, as other instructions to PAUP* can be accomplished through the menu system. Some users, however, may prefer a command-driven interface. Consequently, except for certain machine-specific features, PAUP* may be controlled entirely by a command-line system. Commands may also be placed into input files for convenience (i.e., to avoid repeated typing of complicated commands) and to provide a simple "batch" facility. If you have no experience using PAUP*, then we recommend reading the Quick Start Tutorial included on your distribution disk and also available on the World Wide Web at:

http://paup.csit.fsu.edu/downl.html

Command Format

The command descriptions below use some conventions that will be more fully described in subsequent editions of this reference document. Remember that upper-case items are to be entered as shown. Italicized items—e.g., user-item—represent variable items to be substituted by the user. Items inside of square brackets—e.g., [OPTIONAL_ITEM]—are optional. Items inside of curly braces and separated by vertical bars—e.g., { X | Y | Z }—are mutually exclusive options; only one of the choices indicated may be used. The default item (if any) is underlined, as in { ABC | DEF }. Options in commands are generally specified as "KEYWORD = VALUE" for options that have two or more potential values. For options that represent simple "on-off" ("Boolean") switches, KEYWORD = YES and KEYWORD = NO can be used to select or deselect options, respectively. Also, options may be selected by simply specifying KEYWORD.

Each command begins with a command-name and ends with a semicolon. Otherwise, the commands are completely free-format. A command may span any number of lines and whitespace (tabs and blanks) may be inserted at will. Input of PAUP* commands is case-insensitive, so you may enter command names, option keywords, etc., in any combination of upper- and lower-case characters (the only exception pertains to the MATRIX command). In addition, PAUP* allows abbreviation of command names and keywords to the shortest unambiguous truncation. Note that other NEXUS-conforming programs may not accept these abbreviations. MacClade 3.0, in particular, does not allow abbreviations, so if you want
your data file to be MacClade-compatible, then commands visible to MacClade (i.e., those not contained within a PAUP block) should not be abbreviated.

**IDENTIFIERS**

"Identifiers" are simply names given to taxa, characters, and other PAUP input elements such as character-sets, taxon-sets, and exclusion-sets. They may include any combination of upper- and lower-case alphabetic characters, digits, and punctuation. If the identifier contains any of the following characters:

```
( ) [ ] { } / \ , ; : = * ' ` + - < >
```

or a blank, the entire identifier must be enclosed in single quotes. Underscores (_) are translated to blanks, unless the identifier is enclosed in single quotes. For example, the identifiers Homo_sapiens and 'Homo sapiens' are equivalent, but distinct from 'Homo_sapiens'. To include a single-quote in the identifier, you must use two consecutive single quotes. Any trailing blanks are stripped before the identifier is stored; leading blanks are preserved.

Examples of valid identifiers:

```
subterraneus
Mus_musculus
H._sapiens
'H. sapiens #429'
'Fred''s new sp.'
'rusticus (1)'
"shoal bass"
AMNION
_23
x21.02
myType
```

PAUP* imposes limits on the lengths of identifiers as defined below. If you use identifiers that exceed these limits, PAUP* simply truncates them to the maximum acceptable length. If you use names that are longer than the maximum lengths (e.g., for other NEXUS programs that allow longer identifiers), you should make sure that identifiers in the same class will be unique after truncation by PAUP*.

MacClade will not accept all-digit character or taxon names. PAUP* allows them, with a warning that taxon/character names have precedence over numbers (e.g., if the tenth character is named "5", the command **EXSET *no_5=5 causes character number five to be excluded by MacClade and character number ten to be excluded by PAUP*). It is not advisable to use all-digit names in PAUP*, especially if you intend to also use the data file in MacClade. (See **ALLDIGLAB** on page 118 for a description of digit label handling.)
**Taxon identifiers**

For input, taxa may be referenced either by name or by number. The numbers are simply the row number of the taxon in the input data matrix. Note that if you delete taxa, the original taxon numbers are still used to refer to taxa.

The maximum length of a taxon name is 127 characters. However, in most output these names will be truncated to 16 characters due to overall line-length constraints. Thus, to avoid confusion you should make the first 16 characters of your taxon names unique. The full names will be used in graphical tree output. If you specify `SET TAXLABELS=FULL`, then full taxon names will be used for tree diagrams (but not in other contexts) in normal output as well (although they will still be truncated somewhat if the total output width cannot accommodate the long names).

Taxon names have priority over taxon numbers in input commands. This only becomes an issue if you use all-digit taxon names. For example, if five taxa in a data file are, for whatever reason, given the names

```
One
34
three
3
673
```

then the command `delete 3;` would cause deletion of the fourth taxon. Because of the potential confusion, you are strongly urged not to use all-digit taxon names.

The name "ALL" is reserved for a taxon list containing all of the taxa in the data matrix (see below). You may not name a taxon "ALL".

**Character identifiers**

Ordinarily, PAUP* refers to characters by consecutive integers starting with 1. These integers are used both for input commands and in the output. You may also assign alphanumeric character names if you wish. The maximum length of a character name is 127, but PAUP* truncates character names to 10 characters in its output. Thus, you should choose names that are unique up to at least the first 10 characters. If you assign alphanumeric character names, these will also be used to identify characters in PAUP* output.

The rules for including punctuation, underscores, and blank characters are the same for character names as for taxon names (see page 6).

As for taxa, character names have priority over character numbers. For example, if you used all-digit character names (e.g., sequence positions or restriction-map locations) such as
and issued the command `exclude 4-5;` then all but the first and last characters would be excluded (i.e., name "4" through number 5). Because of the potential confusion, it is suggested that you always include at least one non-digit in alphanumeric character names.

The name "ALL" is reserved for a character list containing all of the characters in the data matrix (see below). You may not name a character "ALL".

**Other names**

Identifiers are also used for `TYPESET`, `WTSET`, `ExSET`, ` CHARSET`, ` TAXSET`, and `ANCSTATES` definitions. These names follow the same rules as taxon and character names, and have a maximum length of 10 characters.

**COMMON COMMAND ELEMENTS**

The following elements are used in more than one command and are defined here to minimize redundancy.

**Taxon lists**

A *taxon list* is a sequence of one or more taxon identifiers (names and/or numbers. If two taxon identifiers are separated by a hyphen, this indicates that the range of taxa between the first taxon and the second taxon (inclusive) are to be included in the list. (The second taxon must have a higher number than the first taxon).

A taxon list composed of the reserved name "ALL" specifies all of the taxa in the data matrix.

Examples of valid taxon lists (assuming that corresponding taxon identifiers have been defined in the `TAXA` block) are as follows:

```
   heteroclitus
   M23-Q45 S1 T5;
   1 3 5-8
   all
```

**Character lists**

A *character list* is a sequence of one or more character identifiers (names and/or numbers). If two character identifiers are separated by a hyphen, this indicates that the range of characters between the first character and the second character (inclusive) are to be included in the list. (The second character must have a higher number than the first character). If the second
specification in the range is followed by a backslash (\), then an integer value immediately following the backslash represents an increment. For example, the list 3–24\3 consists of the characters 3, 6, 9, …, 21, 24. If a range-plus-increment is used, only those characters contained within the range are included in the list (e.g., the list 2–5\2 includes only characters 2 and 4).

The special identifier consisting only of an unquoted period refers to the last character in the data matrix (=NCHAR).

A character list composed of the reserved name "ALL" specifies all of the characters in the data matrix.

Examples of valid character lists (assuming that corresponding character identifiers have been defined in the SETS block) are as follows:

| 8 |
| amnion appendages gizzard teeth; |
| 1 two 5 7 |
| 11–. |
| 1 3–7 16 31 28 |
| LLSCALES–CPDSCALES |
| 3–.\3 |
| all |

**Character states**

A character state is a single digit, alphabetic character, or other symbol that represents a valid character state as defined by the SYMBOLS list.

**Tree lists**

A tree list is simply a list of tree numbers referring to one or more trees currently stored in memory. If two tree numbers are separated by a hyphen, this indicates that the range of trees between the first tree number and the second tree number (inclusive) are to be included in the list. To include all trees currently in memory, specify "ALL" as the tree list.

**Input/Output files**

A number of PAUP* commands contain options to input or output data. Unless PAUP* is told otherwise, the default path-name for an input/output file is the path-name of the most recently accessed file. To override this default you must specify an explicit path-name. Path-names must follow operating system conventions. For example:

<table>
<thead>
<tr>
<th>OS</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macintosh</td>
<td>'Harddrivename:Tree Folder:treefile.trees'</td>
</tr>
<tr>
<td>Dos</td>
<td>C:\Tree_Fol\treefile.tre</td>
</tr>
</tbody>
</table>
Unlike the PAUP* convention for identifiers, underscores (_) are not translated into blanks. File-names containing blanks must be enclosed within single-quotes for the Macintosh and Window95/NT releases and are not allowed under either the DOS or Unix releases. See your operating system documentation for other file naming conventions.

Commands used in the TAXA Block

The TAXA block specifies information about taxa. In previous versions of PAUP, both the taxa information and the character matrix were contained in the DATA block. However, in some instances the character matrix is not needed, making the option to input only taxa labels useful. While it is still permitted, we strongly recommend against use of a DATA block or definition of taxa in a CHARACTERS or DISTANCES block because this will prevent some programs from extracting taxon information from the file.

```
BEGIN TAXA;
  DIMENSIONS NTAX=number-of-taxa;
  TAXLABELS taxon-name taxon-name ...;
END;
```

**DIMENSIONS** must appear before **TAXLABELS**, and only one of each command is allowed per block.

**DIMENSIONS**

The **DIMENSIONS** command specifies the size of the data matrix. The syntax is:

```
DIMENSIONS NTAX = number-of-taxa
```

where *number-of-taxa* and are integer values.

**TAXLABELS**

The **TAXLABELS** command defines taxa, specifies their names, and determines their order. The syntax is:

```
TAXLABELS taxon-name1 taxon-name2 ... taxon-name NTAX;
```

See "Taxon identifiers" on page 7 for rules on the format of taxon names.
Taxa may also be defined in the CHARACTERS and DISTANCES blocks, if the NEWTAXA token is included in the DIMENSIONS command; see the descriptions of those blocks for details.

**Commands used in the CHARACTERS Block**

A CHARACTERS block contains the data matrix and other associated information. Taxa are usually not defined in a CHARACTERS block; if they are not defined here, this block must be preceded by a block which defines taxon labels and ordering (e.g., TAXA). The syntax is:

```plaintext
BEGIN CHARACTERS;
  DIMENSIONS
    [ NEWTAXA NTAX=number-of-taxa ]
    NCHAR = number-of-characters;
    [ FORMAT
      [ DATATYPE = { STANDARD | DNA | RNA | NUCLEOTIDE | PROTEIN } ]
      [ RESPECTCASE ]
      [ MISSING = symbol ]
      [ GAP = symbol ]
      [ SYMBOLS = "symbol symbol..." ]
      [ EQUATE = "symbol=entry [ symbol=entry... ]" ]
      [ MATCHCHAR = symbol ]
      [ LABELS = { NO | LEFT | RIGHT } ]
      [ TRANSPOSE ]
      [ INTERLEAVE ]
      [ [No]Tokens ]; ]
    [ ELIMINATE character-set; ]
    [ TAXLABELS taxon-name taxon-name...; ]
    [ CHARSTATELABELS
      character-number [ character-name ]
      [ /state-name [ state-name... ] ],...; ]
    [ CHARLABELS character-name [ character-name... ]; ]
    [ STATELABELS character-name [ character-name... ]; ]
  MATRIX data-matrix;
END;
```

**DIMENSIONS, FORMAT, and ELIMINATE** must all precede CHARLABELS, STATELABELS, and MATRIX. DIMENSIONS must precede ELIMINATE. Only one of each command is allowed per block.

**DIMENSIONS**

The **DIMENSIONS** command specifies the size of the data matrix. Ordinarily, the CHARACTERS block is proceeded by a TAXA block which contains taxa information. However, if new taxa are to be defined in the CHARACTERS block, this must be indicated by the NEWTAXA subcommand. NEWTAXA, if present, must appear before the NTAX subcommand. The number following NCHAR is the number of characters in the data matrix.
**FORMAT**

The `FORMAT` command is used to specify information pertaining to the format of the data file. The `DATATYPE` subcommand must appear first in the command. The `RESPECTCASE` subcommand must appear before the `MISSING`, `GAP`, `SYMBOLS`, and `MATCHCHAR` subcommands.

Any or all of the following option specifications may be given:

1. **DATATYPE** = \{ **STANDARD** | DNA | RNA | NUCLEOTIDE | PROTEIN \}
   
   This subcommand specifies the class of data. If present, it must be the first subcommand in the `FORMAT` command. If `DATATYPE = STANDARD`, the `SYMBOLS` list is taken from the `SYMBOLS = "symbols-list"` item, above (default = "01"). If `DATATYPE` is set to one of the molecular sequence types, a predefined `SYMBOLS` list is used ("ACGT" for DNA, "ACTU" for RNA, and the standard one-letter amino acid codes for PROTEIN). In addition, standard ambiguity codes are implemented by predefined EQUATE macros.

2. **RESPECTCASE**

   By default, PAUP* does not distinguish between upper- and lower-case character-state symbols in the data matrix. If you want upper- and lower-case representations of the same alphabetic character to refer to different character states, specify `RESPECTCASE`. This subcommand must appear before the `SYMBOLS` subcommand and is not applicable to `DATATYPE=DNA`, RNA, NUCLEOTIDE, and PROTEIN.

3. **MISSING** = `symbol`

   The `symbol` specifies a character used to represent missing data. Any alphabetic, numeric, or other character that may be used as a character-state symbol may be used as the `missing-symbol`. If `MISSING` is not specified, it defaults to '?'. Whitespace is illegal as a missing data symbol, as are the following:

   ```
   ( ) [] {} / \, ; := * "`<>^`^`
   ```

4. **GAP** = `symbol`

   The `symbol` a character used to represent alignment gaps, corresponding to insertions and/or deletions. For example, `gap=-` would assign the hyphen as the gap character. The GAP setting is ignored unless `DATATYPE` is DNA, RNA, or PROTEIN.

   Alignment gaps may be treated either as missing data or as an additional character-state (fifth base or 21st amino acid) using the `GAPMODE` option. Whitespace is illegal as a gap symbol, as are the following:

   ```
   ( ) [] {} / \, ; := * `<>^`^`
   ```

5. **SYMBOLS** = "`symbol symbol...`"

   The `symbol` list defines a set of permissible symbols that may be used
to designate character states. The default SYMBOLS list is "01" for the
STANDARD data type (see below), which means that the only (non-
missing) character-state symbols permitted are '0' and '1'. If you
want to use any other symbols to designate character states, you
must explicitly define an alternate SYMBOLS list.

The format of a symbols-list is a sequence of single-character
"symbols"; the entire list is then enclosed within double-quotes.
Whitespace is not needed between elements: SYMBOLS="012" is
equivalent to SYMBOLS="0 1 2".

EQUATE = "symbol = entry"

The EQUATE option provides a simple macro facility for translating
character-state specifications in the data matrix to alternate
character-state specifications. The symbol component must be a
single-character. Entry is either a valid character-state or a character-
state set.

Any number of EQUATE macros may be specified following the equal
sign, but only one pair of double-quotes is used. For example:

format equate="U=T R={AG} .=- X=?";

EQUATE macros may not be defined recursively. That is, you cannot
equate A to B and B to C, expecting A to be expanded to C. If you
equate the same symbol to more than one expansion, the last
definition applies. Case is significant in equate symbols. That is,
MISSING=? EQUATE="E=(012) e=?" means that E will be interpreted as
0, 1, and 2, e as missing data.

MATCHCHAR = symbol

If a symbol is specified, any occurrence of that symbol in the data
matrix is translated to the state (or state-set) occurring in the first row
of the matrix. For example:

format datatype=dna gap=- matchchar=.;
matrix
   One   ATGCT ATCCG TCATG ACCTA 
   Two   ..C... .G.... .--A. .--GG.
   Three .G.... .GGA. .T.... 
   Four  C..AA .---.. A...A .GTC.

Whitespace is illegal as a matching character symbol, as are the
following:

   () {} , ; = * " / <> ^

LABELS = { NO | LEFT | RIGHT }

If LABELS = LEFT, taxon names (or character names, if the data matrix
is transposed) begin each row of the data matrix (i.e., precede the
character-state data). If LABELS = RIGHT, then these names end each
row of the data matrix. The default is LABELS = LEFT. The LEFT and
RIGHT options are PAUP* extensions. We recommend the use of
LABELS or NOLABELS for compatibility with other NEXUS programs. LABELS with no other qualifier is equivalent to LABELS = LEFT.

Example input format:

```plaintext
begin data;
  dimensions ntax=4 nchar=5;
  format label = right;
  matrix
    00111 taxon1
    0111? taxon2
    11001 taxon3
    10000 taxon4
  ;
end;
```

**TRANSPOSE**

If TRANSPOSE is specified, rows of the data matrix correspond to characters and columns correspond to taxa. Otherwise, rows correspond to taxa and columns to characters. The following is an example of a transposed data matrix:

```plaintext
begin data;
  dimensions ntax=4 nchar=5;
  format transpose;
  taxalabels taxon1 taxon2 taxon3 taxon4;
  matrix
    char1   0011
    char2   0110
    char3   1100
    char4   1100
    char5   1?10
  ;
end;
```

**INTERLEAVE**

Specification of allows the data to be entered in "blocks" of characters. If the data is not transposed, then each "block" contains information for some of the characters, for all taxa. Taxa in each section must occur in the same order. This format is especially useful for molecular sequence data, where the number of characters can be large. A small interleaved matrix follows:

```plaintext
matrix
  taxon1   A C C T C G G C
  taxon2   A C C T C G G C
  taxon3   A C G T C G C T
  taxon4   A C G T C G C T
```
The interleaved sections need not all be of the same length. In an interleaved matrix, new line characters are significant; they indicate that the next character information encountered applies to a different taxon (for non-transposed matrices).

**[NO]TOKENS**

The TOKENS subcommand is currently not supported by PAUP* 4.0 beta; however, this subcommand is described here because it will be supported in the final release 4.0. This subcommand specifies whether or not data matrix entries are single symbols, or can be tokens. If TOKENS is specified, then the data values must be full NEXUS tokens, separated by whitespace or punctuation as appropriate, as in the following example:

```plaintext
begin characters;
  dimensions nchar=3;
  format tokens;
  matrix
    taxon_1 absent red big
    taxon_2 absent blue small
    taxon_3 present blue small;
end;
```

[NO]TOKENS is the default and is not allowed for DATATYPES DNA, RNA, and NUCLEOTIDE. If TOKENS is invoked, the standard 3-letter amino acid abbreviations can be used with DATATYPE = PROTEIN, and defined state names for DATATYPE = STANDARD.

**ELIMINATE**

This command allows one to specify a list of characters that are to be excluded from consideration. PAUP* will completely ignore eliminated characters. (This is similar to the ZAP subcommand in version 3.1 of PAUP.) For example:

```plaintext
eliminate 4-100;
```

tells the program to skip over characters 4 through 100 when the matrix is read. Character-set names are not allowed in the character list. This command does not affect character numbers.
**TAXLABELS**

This command allows one to specify the names of the taxa. It serves to define taxa, and is only allowed in a CHARACTERS block if the NEWTAXA token is included in the DIMENSIONS statement.

**CHARSTATELABELS**

CHARSTATELABELS allows one to specify both the names of the characters and names of the states. This command was developed as an alternative to the older commands CHARLABELS and STATELABELS. Here is an example:

```charstatelabels
  1 eye_color/red blue green,
  3 head_shape/round square,
  5 pronotum_size/small medium large
;
```

A forward slash (/) separates the character name and the state names, with a comma separating the information for different characters. If no state names are to be specified, the slash may be omitted; if no character names are to be specified, the slash must be included, but no token needs to be included between the character number and the slash. If state x is the last state to be named, then subsequent states need not be named but states 1 through x must be. If no name is to be applied to a state, enter a single underscore for its name. Character names must not correspond to another character name or number; thus, 1 is not a valid name for the second character listed. PAUP* does not use character-state label information; however, it will extract the name from a CHARSTATELABELS command.

**CHARLABELS**

This command allows one to specify names of characters:

```charlabels
  flange microsculpture body_length
  hind_angles #_spines spine_size
  _ __ head_size pubescent_intervals
  head_color clypeal_margin;
```

Character labels are listed consecutively. If character x is the last character to be named, then subsequent characters need not be named, but characters 1 through x need to be. If no name is to be applied to a character, a single underscore can be used for its name. Character names must not correspond to another character name or number; thus, 1 is not a valid name for the second character listed.

The command should be used only for non-transposed matrices (in transposed matrices, the character labels are defined in the MATRIX command).
STATELABELS

Use this command to assign names to character states. PAUP* does not use this information in any way, however, the information is used by MacClade and possibly other NEXUS programs.

statelabels
  1 absent present,
  2 isodiametric transverse,
  3 '4.5-6.2mm' '6.3-7.0mm' '7.7-11.0mm',
  4 rounded subangulate angulate,
  10 0 '1-4' '6-9' '7-9' '8-9' 7 8 9,
  11 black rufous metallic flavous,
  12 straight concave,

;

State labels need not be specified for all characters. A comma must separate state labels for each character. State labels are listed consecutively within a character. If state x is the last state to be named, then subsequent states need not be named, but states 1 through x must be. If no name is to be applied to a state, enter a single underscore for its name.

MATRIX

In its standard format, the MATRIX command contains a sequence of taxon names and state information for that taxon. The matrix itself may appear in a variety of forms. For example:

begin data;
  dimensions nchar=5;
  matrix
    taxon1    00111
    taxon2    0111?
    taxon3    11001
    taxon4    10000
  ;
end;
begin data;
dimensions nchar=5;
matrix
taxon1
 001
 11
taxon2
 011
 1?
taxon3
 110
 01
taxon4
 100
 00
end;

begin data;
dimensions nchar=5;
matrix taxon1 00111 taxon2 0111? taxon3 11001
taxon4 10000;
end

Taxa need not be in same order as in the TAXA block, and the matrix need not contain all taxa. For interleaved matrices, all sections must have the same taxa in the same order.

**Commands used in the DATA Block**

The DATA block contains the data matrix and other associated information. This block is equivalent to a CHARACTERS block in which the NEWTAXA subcommand is included in the DIMENSIONS command. In versions 3.0-3.07 of MacClade and 3.0-3.1.1 of PAUP, both the data matrix and taxa were saved in a DATA block. However, in some instances the character matrix is not needed, making the option to input only taxa labels useful. All of the options described in the TAXA and CHARACTERS blocks are still permitted under the DATA block; however, we strongly encourage the use of the TAXA and CHARACTERS blocks for the sake of compatibility with other programs using the NEXUS-format.

The following CHARACTER and TAXA blocks are equivalent to the single DATA block:

begin taxa;
dimensions ntax=3;
taxlabels taxon_1 taxon_2 taxon_3;
end;
begin characters;
  dimensions nchar=12;
  format datatype=DNA;
  matrix
    taxon_1  CCATGGTACGT
    taxon_2  TCCATGCTACCC
    taxon_3  TCCATGGAACCC;
end;

begin data;
  dimensionsntax = 3 nchar=12;
  format datatype=DNA;
  matrix
    taxon_1  CCATGGTACGT
    taxon_2  TCCATGCTACCC
    taxon_3  TCCATGGAACCC;
end;

**Commands used in the ASSUMPTIONS Block**

The ASSUMPTIONS block houses assumptions about the data, or gives general directions as to how to treat it (e.g., which characters are to be excluded from consideration). Its syntax is:

```
BEGIN ASSUMPTIONS;
  [OPTIONS
    [ DefType = type-name ]
    [ PolyTCOUNT = { MinSteps | MaxSteps } ]
    [ GapMode = { Missing | NewState | Indel } ]; ]
  [ UserType type-name
    [ ( { StepMatrix | CSTree } ) ] = usertype-description; ]
  [ TypeSet [*] typeset-name [ ( { Standard | Vector } ) ] =
    typeset-definition; ]
  [ WtSet [*] wtset-name [ ( { Standard | Vector } { Tokens | NoTokens } ) ] =
    wtset-definition; ]
  [ ExSet [*] exset-name [ ( { Standard | Vector } ) ] = character-set; ]
  [ AncStates [*] ancstates-name [ ( { Standard | Vector } { Tokens | NoTokens } ) ] =
    ancstates-definition; ]
END;
```

In earlier versions of PAUP, the CHARSET and TAXSET commands also appeared in the ASSUMPTIONS block; now they appear in the SETS block. The GAPMODE subcommand of the OPTIONS command of this block was originally housed in an OPTIONS command in the DATA block. As this subcommand dictates how data are to be treated, rather than provide details about the data themselves, it was moved into the ASSUMPTIONS block.
**OPTIONS**

This command houses a number of disparate subcommands. They are all of the form subcommand = option.

**DEFTYPE = type-name**

This specifies the default character type for parsimony analyses. Whenever a character's type is not explicitly stated, its type is taken to be the default type. The default DEFTYPE is UNORD, but may be changed to one of the following: ORD, UNORD, DOLLO, DOLLO.UP, DOLLO.DN, IRREV, IRREV.UP, or IRREV.DN.

**POLYTCOUNT = { MINSTEPS | MAXSTEPS }**

This option specifies whether polytomies are treated as "hard" or "soft" (see Maddison (1989)) when counting the number of steps required by a character and when reconstructing ancestral states. PAUP* currently supports only POLYTCOUNT = MAXSTEPS ("hard" polytomies), and will ignore the POLYTCOUNT specification.

**GAPMODE = { MISSING | NEWSTATE | INDEL }**

Specifies how gaps are to be treated. GAPMODE = MISSING designates gaps to be treated in the same way as missing data; GAPMODE = NEWSTATE specifies that gaps are to be treated as an additional state (for DNA/RNA data, as a fifth base).

**USER TYPE**

***** Give the predefined character types here. The USER TYPE command defines a character transformation type, as used in parsimony analysis to designate the cost of changes between states. USER TYPES must be defined before they are referred to in any TYPESET. Character-type-description must follow the rules for character-state tree or stepmatrix description.

The STEPMATRIX format is as follows:

```
usertype mymatrix (stepmatrix)=n
  s  s  s  s
  .  k  k  k
  k  .  k  k
  k  k  .  k
  k  k  k  .;
```

where n is the number of rows and columns in the step matrix, the s's are state symbols, and the k's are the cost for going between states. n can take any value _ 2. Diagonal elements may be listed as periods. If a change is to be prohibited, then one enters an "i" for infinity. Typically, the state symbols will be in sequence, but they need not be. The following matrices assign values identically:
usertype mymatrix (stepmatrix)=4
  0  1  2  3
  .  1  5  1
  1  .  5  1
  5  5  .  5
  1  1  5  .;

usertype mymatrix2 (stepmatrix)=4
  2  0  3  1
  .  5  5  5
  5  .  1  1
  5  1  .  1
  5  1  1  .;

The CSTREE format is very similar to the TREE format in a TREES block. That is, character state trees are described in the parenthesis notation following the rules given for Trees of taxa. Instead of taxon labels, character state symbols are used. Thus

usertype cstree-name (cstree) = [(list of subtrees)][state-symbol];

where each subtree has the same format as the overall tree and the subtrees are separated by commas.

**TYPESET**

A **TYPESET** specifies a set of character-type assignments for each character as used in parsimony analysis. Any characters not listed in the character-set have the default character type. The type names to be used are either the predefined ones or those defined in a **USERTYPE** command. Each value in a definition in VECTOR format must be separated by whitespace. The following are equivalent type sets:

```
typeset mytypes = Ord: 1 4 6, Unord: 2 3 5;

typeset mytypes (vector) = Ord Unord Unord Ord Unord Ord;
```

**WTSET**

A **WTSET** specifies a set of character-weight assignments for each character. Any characters not listed in the character-set have weight 1. The weights may be either integers or real numbers. Each value in a definition in VECTOR format must be separated by whitespace, unless the NOTOKENS option is invoked, in which case no whitespace is needed, and all weights must be integers in the range 0-9. The following are equivalent weight sets:

```
wtset mywts = 3: 1 4 6, 1: 2 3 5;
```
**ExSet**

ExSet specifies a set of characters that may be jointly excluded. This is a standard object definition command. Any characters not listed in the character-set are included. The Vector format consists of 0's and 1's - a 1 indicates that the character is to be excluded; whitespace is not necessary between 0's and 1's. The following commands are equivalent, and serve to exclude characters 5, 6, 7, 8, and 12.

```
exset * toexclude = 5-8 12;
```

```
exset * toexclude (vector) = 0001111001;
```

If you precede the `exset-name` with an asterisk, any previously excluded characters are re-included and the characters specified by `character-list` are excluded.

**AncStates**

The AncStates command allows one to specify ancestral states. Any valid state symbol can be used in the description for discrete data, and any valid value for continuous data. Tokens is not allowed for DataTypes DNA and RNA. If Tokens is invoked, the standard 3-letter amino acid abbreviations can be used with DataType = Protein, and defined state names for DataType = Standard. The following commands are equivalent:

```
ancstates ancestor = 0:1-3 5-7 12, 1:4 8-10, 2:11;
```

```
ancstates ancestor (vector) = 000100011120;
```

Any number of `ancstates-name:ancstates-definition` pairs, separated by commas, may be specified. You may also repeat the AncStates command to define multiple ancestors, although only one ancestor can be in effect at any given time. If you precede the ancestor-name with an asterisk, that ancestor becomes the "current" ancestor. You can also assign the current ancestor with the Assume command.

---

**Commands used in the SETS Block**

This block stores sets of objects (characters, states, taxa, etc.). The general structure of the Sets block is as follows:

```
BEGIN SETS;
    [ CHARSet charset-name [[(STANDARD | VECTOR)]]=character-list ;]
```

February, 2002
The `CHARSET` command specifies and names a set of characters; this name can then be used in subsequent CHARSET definitions or wherever a character-list is required. The VECTOR format consists of 0’s and 1’s: a 1 indicates that the character is to be included in the CHARSET; whitespace is not necessary between 0’s and 1’s. The name of a CHARSET cannot be equivalent to a character name or character number.

PAUP* includes the following predefined character-sets for all DATATYPES:

- **Constant**: all invariant characters
- **Gapped**: all characters with a gap for at least one taxon.
- **Missambig**: all characters with a gap or ambiguous character for at least one taxon.
- **Remainder**: all characters not previously referenced in the command.
- **Uninf**: all characters that are constant as well as autapomorphic.

There are four additional predefined character-sets for characters of `DATATYPE = DNA, RNA, NUCLEOTIDE` if a `CODONS` block containing a `CODONPOSSET` is supplied.

- **Pos1**: all characters defined by current CodonPosSet as first positions.
- **Pos2**: all characters defined by current CodonPosSet as second positions.
- **Pos3**: all characters defined by current CodonPosSet as third positions.
- **Noncoding**: all characters defined by current CodonPosSet as non-protein-coding sites.
**TaxSet**

This command defines a set of taxa. A **TaxSet** name can be used in subsequent **TaxSet** definitions or wherever a taxon-set is required. The name of a **TaxSet** cannot be equivalent to a taxon name or taxon number. The taxa to be included are described in a taxon-set. For example, the following command:

```
taxset beetles = Omma-;```

defines the **TaxSet** "beetles" to include all taxa from taxon Omma to the last defined taxon.

The **Vector** format consists of 0's and 1's: a 1 indicates that the taxon is to be included in the **TaxSet**; whitespace is not necessary between 0's and 1's.

**CharPartition, TaxPartition**

The partition divides the objects into several (mutually exclusive) subsets. They follow the same format, and will be described together.

There are several formatting options. The **Vector** format consists of a list of partition names. By default, the name of each subset is a NEXUS word (this is the **Tokens** option). The **Notokens** option is only available in the **Vector** format; this allows one to use single symbols for the subset names. Each value in a definition in **Vector** format must be separated by whitespace if the names are tokens, but not if they are **Notokens**.

**Example 1**

The following two examples are equivalent:

```
taxpartition populations=1:1-3, 2:4-6, 3:7 8;
taxpartition populations (vector notokens) = 11122233;
```

**Example 2**

The following two examples are equivalent:

```
taxpartition mypartition=Chiricahua: 1-3, Huachuca: 4-6, Galiuro: 7 8;
taxpartition mypartition (vector) = Chiricahua Chiricahua Chiricahua Huachuca Huachuca Huachuca Galiuro Galiuro;
```
**Example 3**

The following example of the CHARPARTITION command creates a character partition named gfunc which defines coding and noncoding regions of the sequences.

```
charpartition gfunc = 1:2-457 660-896, 2:1 458-659 897-898;
```

**Example 4**

The following example of the CHARPARTITION command is equivalent to the Example 3 except that two predefined character sets are used to define the characters included in each partition. See the "CharSet" command described on page 23 for a complete list of predefined character sets.

```
charset coding = 2-457 660-896;
charset noncoding = 1 458-659 897-898;
charpartition gfunc = 1:coding, 2:noncoding;
```

**Commands used in the TREES Block**

The TREES block is used to input user-defined trees to PAUP*. A single TREE command is used for each tree; any number of TREE commands may be included in the block.

The syntax for the TREES block follows:

```
BEGIN TREES [ block-name ] ;
[ TRANSLATE token taxon-name , token taxon-name ] … ; ]
[ TREE [*] name = tree-specification ; ]
END;
```

**TRANSLATE**

Use the TRANSLATE command to define mappings of arbitrary tokens appearing in the TREE command to valid taxon names. Ordinarily, the tokens are the integers 1 through NTAX. The tree description requires references to the taxa defined in a TAXA, CHARACTERS, DATA, or DISTANCES block.

**TREE**

Use the TREE command to define trees. If no rooting-specification is supplied, the default in PAUP* is to interpret the tree description as specifying a rooted tree. You can override this behavior by using a "special comment." The comment `[&U]` indicates that the tree should be
considered unrooted and the comment ‘[&R]’ indicates that the tree should be considered rooted. For example:

\[
\text{tree mytree = [&R] ((1,2),(3,4))};
\]

is a rooted tree, whereas

\[
\text{tree mytree = [&U] ((1,2),(3,4))};
\]

is an unrooted tree. You will usually define unrooted trees. These trees are then rooted for output purposes using the outgroup or Lundberg rooting procedures. However, if you wish to define an ancestor for the full tree (see ANCSTATES command), if you are using directed characters, or if you want to evaluate trees under a maximum likelihood "clock" constraint you may wish to define rooted trees instead. In any case, you can convert rooted trees to unrooted trees and vice versa using the ROOT TREES / DEROOT TREES commands.

Note that in order to write the tree descriptions, unrooted trees may be rooted at any convenient point (including a terminal taxon or internal node); the position of the root is simply ignored when the tree is stored.

Another "special comment" stored in the TREES block and used by PAUP* is the tree weight comment. Tree weights are the reciprocal of the number of trees found in either a BOOTSTRAP or JACK KNIFE replicate. This option allows the combination of bootstrap results from runs performed at different times or on different machines and the recovery of results obtained prior to a system crash. For example the TREEFILE created by the BOOTSTRAP command might look like this:

- [Trees found in bootstrap replicate #1]
  \[
  \text{tree B_1.1 = [&W 1] (1,(((2,4),(5),3),6))};
  \]

- [Trees found in bootstrap replicate #2]
  \[
  \text{tree B_2.1 = [&W 1/2] (1,(((2,4),(5),6),3));}
  \text{tree B_2.2 = [&W 1/2] (1,(((2,4),5,6)),3))};
  \]

An example tree with branch lengths is

\[
\text{tree PAUP_1 = [&U] (1:22,(2:12,3:9):9,4:72)};
\]

PAUP* currently ignores the tree names; trees are referred to subsequently only by number, in the order in which they are presented in the TREES block. (MacClade uses the tree names, however.) If the name is preceded by an asterisk (*), the tree becomes the "default" tree. (E.g., a DESCRIBE TREES command with no tree list will result in the description of the default tree.)

If a taxon is omitted from the tree specification, it is assumed to descend from the root of the tree described by the remaining taxa.
Commands used in the CODONS Block

The CODONS block contains information about the genetic code, the regions of DNA and RNA sequences that are protein coding, and the location of triplets coding for amino acids in nucleotide sequences. Numerous other commands used by other NEXUS-compliant programs may be included in the CODONS block. Currently only the CODONPOSSET command is implemented in PAUP*; all other CODONS block commands will be ignored.

```
BEGIN CODONS;
  [ CODONPOSSET [*] name [{ STANDARD | VECTOR}]] =
    N: character-set,
    1: character-set,
    2: character-set,
    3: character-set;
END;
```

**CODONPOSSET**

The **CODONPOSSET** command stores information about protein coding regions and the codon positions of nucleotide bases in protein-coding regions.

Those characters designated as 1, 2, or 3 are coding bases which are specified as being of positions 1, 2, and 3, respectively. Those characters designated as N are considered non-protein-coding. Those characters designated as ? are of unknown nature. Any unspecified bases are considered of unknown nature (equivalent to ?). If no CODONPOSSET statement is present, all bases are presumed of unknown nature.

For example, the following command

```
codonposset * coding=
    N:1-10,
    1:11-.
3,
    2:12-.
3,
    3:13-.
3;
```

designates bases 1-10 as noncoding, and positions of the remaining bases in the order 123123123....

Commands used in the DISTANCES Block

This block contains distance matrices. Taxa are usually not defined in a DISTANCES block; rather, this block should be preceded by a block that
defines taxon labels and ordering (e.g., TAXA). The syntax of the block is as follows:

```
BEGIN DISTANCES;
  [ DIMENSIONS [ NEWTAXA ] NTAX = number-of-taxa
    NCHAR = number-of-characters;]
  [ FORMAT
    [ TRIANGLE = { LOWER | UPPER | BOTH } ]
    [ [NO] DIAGONAL ]
    [ [NO] LABELS ]
    [ MISSING = SYMBOL ]
    [ INTERLEAVE ]; ]
  [ TAXLABELS taxon-name taxon-name...;]
  MATRIX distance-matrix ;
END;
```

Commands must appear in the order listed. Only one of each command is allowed per block.

**DIMENSIONS**

The NTAX subcommand of this command is needed to process the matrix when some defined taxa are omitted from the distance matrix. The NCHAR subcommand is optional, and can be used to indicate the number of characters for those analyses that need to know how many characters (if any) were used to calculate the distances. NCHAR is not required for successful reading of the matrix.

As for the CHARACTERS block, taxa can be defined in a DISTANCES block if NEWTAXA precedes the NTAXA subcommand in the DIMENSIONS command. It is advised that new taxa not be defined in a DISTANCES block, for the reasons discussed in the description of the DATA block. NEWTAXA, if present, must appear before the NTAX subcommand.

**FORMAT**

This command specifies the formatting of the MATRIX. The [NO]LABELS and MISSING subcommands are as described in the CHARACTERS block.

```
TRIANGLE = { LOWER | UPPER | BOTH }
```

This subcommand specifies whether only the lower left half of the matrix is present, or only the upper right, or both halves. Below is one example of an upper triangular matrix and one of a matrix with both halves included.
begin distances;
  format triangle = upper;
  matrix
    taxon_1 0.0 1.0 2.0 4.0 7.0
    taxon_2 0.0 3.0 5.0 8.0
    taxon_3 0.0 6.0 9.0
    taxon_4 0.0 10.0
    taxon_5 0.0;
end;

begin distances;
  format triangle = both;
  matrix
    taxon_1 0 1.0 2.0 4.0 7.0
    taxon_2 1.0 0 3.0 5.0 8.0
    taxon_3 2.0 3.0 0 6.0 9.0
    taxon_4 4.0 5.0 6.0 0 10.0
    taxon_5 7.0 8.0 9.0 10.0 0;
end;

**DIAGONAL**

If **DIAGONAL** is turned off, the diagonal elements are not included

format nodiagonal;
  matrix
    taxon_1
    taxon_2 1.0
    taxon_3 2.0 3.0
    taxon_4 4.0 5.0 6.0
    taxon_5 7.0 8.0 9.0 10.0;

If **TRIANGLE** is not **BOTH**, then there will be one row that contains only the name of a taxon. This row is required. If **TRIANGLE = BOTH**, then the diagonal must be included.

**INTERLEAVE**

The **INTERLEAVE** subcommand in the **DISTANCE** block is currently not supported by PAUP* 4.0 beta; however, this subcommand is described here because it will be supported in the final release 4.0. The **INTERLEAVE** format is similar to that described in the **CHARACTERS** block, although the interleaved distance matrices take a slightly different form:
taxon_1   0  
taxon_2   1  0  
taxon_3   2  3  0  
taxon_4   4  5  6  
taxon_5   7  8  9  
taxon_6   11 12 13  
taxon_4   0  
taxon_5   10  0  
taxon_6   14 15  0;  

As in the CHARACTERS block, new line characters in interleaved matrices are significant, in that they indicate a switch to a new taxon.

**TaxLabels**

**TAXLABELS** allows one to specify the names and ordering of the taxa. This command serves to define taxa, and is allowed only if the NEWTAXA token is included in the DIMENSIONS statement.

**Matrix**

The **Matrix** command contains the distance data.

**Commands used in the PAUP Block**

Commands described in this section are specific to PAUP*. They may be included in the PAUP block of a NEXUS file or typed from the command line.

Unless otherwise specified, options specified in these commands are "persistent," i.e., they retain their values between successful invocations of the command. Persistence of options simplifies typing of commands because one a command requiring a large number of options has been entered once, subsequent invocations of the command need not respecify all of the options. The drawback is that you can become temporarily confused if you forget that a previously specified option remains in effect until you explicitly override it.

**Options and Subcommands Affecting Multiple Commands**

Several options apply to a number of commands. Specification of these options on one command affects all commands that use the same options. To minimize redundancy, these options are described in the following sections rather than in the description for each individual command to which the option applies.
**Tree-searching options**

These options pertain to the commands that request searching for trees.

**KEEP = real-value**

If real-value is zero, only the best trees found will be saved. If real-value ≥ zero, all trees of score ≤ real-value will be saved. By default, real-value = 0, so that only the best trees found will be saved.

**ENFORCE = YES | NO**

ENFORCE requests that topological constraints be enforced; i.e., trees that are not compatible with the constraint tree are not evaluated. If the CONSTRAINTS option (see below) is not used to specify a constraint tree, the "current" constraint tree is used.

**DSTATUS = integer-value | NONE**

Information on the progress of the search (number of trees examined, number of trees saved, etc.) may output to the display buffer using the DSTATUS setting. Specify an integer-value to control how frequently (in seconds) information is output to the display or specify DSTATUS = NO to suppress this information. The default setting for the Macintosh versions of PAUP* is DSTATUS = NONE and DSTATUS = 60 for all other versions.

**CONSTRAINTS = constraint-tree-name**

The specified constraint tree, which must have been defined in a previous CONSTRAINTS command, becomes the current constraint tree. You must also specify ENFORCE if you want to search under constraints.

**CONVERSE = YES | NO**

If CONVERSE is specified in conjunction with ENFORCE, only trees that are not compatible with the constraint tree are evaluated. CONVERSE = NO reverses the effect of a previous CONVERSE specification.

**STATUS = YES | NO**

Information on the progress of the search (number of trees examined, number of trees saved, etc.) is output to a status window. STATUS = NO suppresses this window.

**Tree-rooting options**

**ROOT = OUTGROUP | LUNDBERG | MIDPOINT**

The ROOT option is used to specify how unrooted trees are to be rooted prior to output. You can choose OUTGROUP rooting, using whichever outgroup you have selected; MIDPOINT rooting, which roots the tree at its midpoint; or LUNDBERG rooting, which requires that a previous ANCSTATES command has been issued. By default, OUTGROUP rooting is in effect.
OUTROOT = POLY TOMY | PARAPHYL | MONOPHYL
If outgroup-rooting is currently selected, there are three options for output. The outgroup can make up a polytomy next to the ingroup (POLY TOMY, the default); or it can be made to be paraphyletic relative to the ingroup (PARAPHYL); or the monophyletic sister group to the ingroup (MONOPHYL).

Tree output options

T COMPRESS = YES | NO
Specify T COMPRESS to output tree diagrams in a “vertically compressed” format. The resulting diagram is not as aesthetically appealing, but it allows more of a large tree to be seen on one screen (or in one window), and it takes less paper to print.

Options for character-matrix listings

SHOWEXCLUDED = YES | NO
Unless SHOWEXCLUDED is specified, "excluded" characters are not shown in character-matrix listings.

CMLABELS = YES | NO
By default, character names are used to label the columns of character-matrix listings. If you want to use numbers even when character names are available, specify CMLABELS = NO.

CMCSTATUS = YES | NO
If CMCSTATUS is specified, characters that are constant, "zapped," uninformative, or excluded are identified by asterisks at the top of each column of a character-matrix listing.

CMCOLWID = column-width
The value specified for column-width determines the number of columns used for each character in the data matrix. The default is CMCOLWID=2, so that one blank column appears between each column of character state data. For sequence data, you may want to use CMCOLWID=1 in order to fit more characters onto each line of output.

CMSHOWEQ = YES | NO
Unless CMSHOWEQ has been specified, if the possible state assignments to an interior node correspond to a multistate taxon code specified in an EQUATE macro, the corresponding EQUATE character is shown rather than the equivalent set of character states.

Other options

OPT = ACCTRAN | DELTRAN | MINF
The OPT= subcommand determines how the characters are
optimized on the tree(s) in memory. **ACCTRAN** (the default) uses "accelerated transformation", **DELTRAN** uses "delayed transformation", while **MINF** optimizes so as to minimize the "f-value" (Farris, 1972; Swofford and Maddison, 1987). See the section on character-state optimization for detailed discussion of these options.

**ANCSTATES = ancestral-states-name**

Change the ancestor currently in effect to the ancestral-states-name defined in an earlier **ANCSTATES** command (or to **STANDARD**). This option affects searching and character-state reconstruction algorithms.

**?**

The ? command is a synonym for **HELP**. ? with no arguments requests a list of the available commands. See the "Help" command described on page 69 for further information.

**Syntax**

```plaintext
[PAUP command] ?;
```

**!**

Use the ! command to execute a UNIX command from within **PAUP***. You can type a command that contains a semicolon by enclosing the entire command within single-quotes. You can open a temporary UNIX shell by typing, for example, !csh or !sh. When you are ready to resume your **PAUP*** session, type exit or Ctrl-D to exit the shell and return to **PAUP***. Note, some shells respond differently to this command.

**Syntax**

```plaintext
! [unix-command] ;
```

**AGREE**

Use the **AGREE** command to calculate agreement subtrees.

**Syntax**

```plaintext
AGREE [tree-list] [/options];
```

**Menu equivalent**

Trees > Agreement subtrees ...
Available options

- **ALL** = *NO* | *SETS* | *TREES* | *BOTH*
- *SHOWTREE* = *YES* | *NO*
- *TREEFILE* = *tree-file-name*
- *REPLACE* = *YES* | *NO*
- *APPEND* = *YES* | *NO*
- *TCOMPRESS* = *YES* | *NO*

*Option is nonpersistent

Description of options

**ALL** = *NO* | *SETS* | *TREES* | *BOTH*

Use **ALL** to calculate agreement subtrees for the trees specified in the **AGREE** [tree-list]. If **ALL** = *SETS*, a list of the agreement sets and the taxa included within each set is given. If **ALL** = *TREES*, all of the agreement subtrees are printed, overriding **SHOWTREE** = *NO* if this option was specified.

**SHOWTREE** = *YES* | *NO*

Shows the agreement subtree(s) given in the [tree-list].

**TREEFILE** = *tree-file-name*

If **TREEFILE** is specified, a description of all agreement subtrees is output to a file containing a NEXUS-format TREES block. This option is not persistent; you must specify it on every **AGREE** command for which you want a tree file to be saved. See "Input/Output files" on page 9 for instructions to specify the full path name of a file.

The following options apply only if **FILE** is specified

- **REPLACE** = *YES* | *NO*
- **APPEND** = *YES* | *NO*

If the specified file already exists, you will be prompted for confirmation that the existing file should be replaced. Explicit specification of **REPLACE** suppresses this prompt; the existing file will be quietly overwritten by the new data. Alternatively, you may specify **APPEND**, in which case a new TREES block will be concatenated to the end of an existing file.

**TCOMPRESS** = *YES* | *NO*

See "Tree output options" on page 32.
**ALLTREES**

Use the ALLTREES command to perform an exhaustive search of all possible tree topologies.

**Syntax**

```
ALLTREES [options];
```

**Menu Equivalent**

Analysis > Exhaustive Search ...

**Available options**

- **KEEP = real-value | NO**
- **ENFORCE = YES | NO**
- **CONSTRAINTS = constraint-name**
- **CONVERSE = YES | NO**
- **FD = NO | BARCHART | HISTOGRAM**
- **NCLASSES = integer-value**
- **FDFILE = frequency-distribution-file-name**
- **SCOREFILE = file-name-for-scores**
- ***REPLACE = YES | NO**
- **STATUS = YES | NO**
- **DSTATUS = integer-value | NONE**

*Option is nonpersistent

**Description of options**

**FD = NO | BARCHART | HISTOGRAM**

Unless FD = No is specified, a frequency distribution of tree scores is output. (Normally, obtaining the frequency distribution is the only reason for doing an exhaustive rather than branch-and-bound search, so you will probably never specify this option.) FD = BARCHART is the default so that the number of trees at each score is output. If FD = HISTOGRAM, tree scores are pooled into classes, the size of which is specified by the NCLASSES option.

**NCLASSES = integer-value**

*integer-value* specifies the number of class intervals for the frequency distribution of tree scores. By default, NCLASSES=20, so that adjacent tree scores are pooled into 20 classes of tree scores. This option is only relevant when FD = HISTOGRAM.
FDFile = frequency-distribution-file-name

If FDFile is specified, the data for the frequency distribution of tree scores are saved to a text file for input to other programs. The FDFile option is not persistent. Frequency-distribution-file-name specifies the name of the file to receive the frequency distribution. See "Input/Output files" on page 9 for instructions to specify the full path name of a file.

ScoreFile = file-name-for-scores

Use ScoreFile to save a text file of tree scores found during the exhaustive search.

Replace = Yes | No

If FDFile or ScoreFile options are used and the specified file(s) already exists you will be prompted for confirmation that the existing file should be replaced. REPLACE suppresses this prompt; the existing file(s) will be quietly overwritten by the new data.

See "Tree-searching options" on page 31 under "Options Affecting Multiple Commands" for a description of the following options:

Keep = keep-score
Enforce = Yes | No
Constraints = constraint-tree-name
Converse = Yes | No
Status = Yes | No
DStatus = integer-value | None

AncStates

The ANCSTATES command, used to define ancestral states, is ordinarily issued from within the ASSUMPTIONS block. You may also issue it from the command line or from within a PAUP block. See "Commands used in the ASSUMPTIONS Block" on page 19 for the description of this command.

Assume

Use the ASSUME command to invoke a type set, weight set, or exclusion set, or to select an ancestor. The options under this command are described in the "Commands used in the ASSUMPTIONS Block" on page 19.

Syntax

Assume [options];

Menu equivalent

Data > Choose Assumptions Sets ...
Available options

- TYPESET = typeset-name
- WtSET = wtset-name
- EXSET = exset-name
- ANCSTATES = ancstates-name

**BANDB**

Use the BANDB command to search for trees using the branch-and-bound algorithm.

**Syntax**

```
BANDB [options];
```

**Menu equivalent**

Analysis > Branch and Bound Search ...

**Available options**

- UPBOUND = real-value
- KEEP = real-value | NO
- ENFORCE = YES | NO
- CONSTRAINTS = constraint-name
- CONVERSE = YES | NO
- FDONLY = YES | NO
- FDTYPE = BARCHART | HISTOGRAM
- NCLASSES = integer-value
- FDFILE = frequency-distribution-file-name
- *REPLACE = YES | NO
- ADDSEQ = FURTHEST | ASIS | SIMPLE | MAXMINI | KMAXMINI
- MULTREES = YES | NO
- STATUS = YES | NO
- DSTATUS = integer-value | NONE

*Option is nonpersistent

**Option descriptions**

UPBOUND = upper-bound

Use this option to specify an upper bound on the score of the best tree(s). If you do not specify an upper bound on the score of the best tree (or if you specify UPBOUND=0), PAUP* computes a starting
upper bound via the stepwise addition algorithm.

FDONLY = YES | NO
If FDONLY = YES, then a frequency distribution of tree scores is output for all trees less than or equal to the score specified by the KEEP option. This option is not permitted unless it is used in conjunction with the KEEP score option.

FDTYPE = BARCHART | HISTOGRAM
The default FDTYPE specifies that the number of trees at each tree score is output as a BARCHART. If FDTYPE = HISTOGRAM, tree scores are pooled into classes, the size of which is specified by the NCLASSES option.

NCLASSES = integer-value
Integer-value specifies the number of class intervals for the frequency distribution of tree scores. By default, NCLASSES = 20, so that adjacent tree scores are pooled into 20 classes of tree scores. This option is only available when FDTYPE = HISTOGRAM.

FDFILE = frequency-distribution-file-name
If FDFILE is specified, the data for the frequency distribution of tree scores are saved to a text file for input to other programs. The FDFILE option is not persistent. Frequency-distribution-file-name specifies the name of the file to receive the frequency distribution. See "Input/Output files" on page 9 for instructions to specify the full path name of a file.

REPLACE = YES | NO
If FDFILE is used and the specified file already exists you will be prompted for confirmation that the existing file should be replaced. REPLACE suppresses this prompt; the existing file will be quietly overwritten by the new data.

ADDSEQ = FURTHEST | ASIS | SIMPLE | MAXMINI | KMaxMINI
ADDSEQ specifies the way in which taxa are selected for next addition to the tree at the current node of the search tree. FURTHEST is usually the fastest, although it is not permitted unless all characters are of type ORD or UNORD (it will automatically be overridden by SIMPLE in this case).

MULTREES = YES | NO
Ordinarily, PAUP* saves all minimal trees it finds during the branch-and-bound search. You can use MULTREES = NO to save only one of the best trees found. If you only want to know the score of the best tree(s), use this option. The single tree found is guaranteed to be of minimum score and the search often runs much faster.

See "Tree-searching options" on page 31 under "Options Affecting Multiple Commands" for a description of the following options:
**BASEFREQS**

Use the BASEFREQS command to show base frequencies for each taxon. In addition, this command gives the expected base frequencies for each taxon and the Chi-square test of homogeneity of base frequencies across taxa.

**Syntax**

```
BASEFREQS;
```

**Menu equivalent**

Data > Base Frequencies

**BOOTSTRAP**

Use the BOOTSTRAP command to perform a bootstrap analysis using either a branch-and-bound or a heuristic search.

**Syntax**

```
BOOTSTRAP [options] [heuristic-search-options] |
branch-and-bound-search-options];
```

**Menu equivalent**

Analysis > Bootstrap/Jackknife ...

**Available options**

- BSEED = integer-value
- NREPS = integer-value
- SEARCH = HEURISTIC | BANDB | FASTSTEP | NJ | UPGMA
- CONLEVEL = integer-value
- KEEPALL = YES | NO
- WTS = IGNORE | SIMPLE | REPEATCNT | PROPORTIONAL
- NCHAR = CURRENT | number-of-characters
- GRPFREQ = YES | NO
- TREEFILE = bootstrap-tree-file-name
- FORMAT= NEXUS | ALTNEXUS | FREQPARS | PHYLIP | HENNIG
Commands used in the PAUP Block

• BRLENS = YES | NO
• *REPLACE = YES | NO
• CUTOffPCT = integer-value

*Option is nonpersistent

Description of options

BSEED = integer-value

By default, PAUP* references the system clock to obtain a value used to seed a random number generator. An explicit seed may be specified to override the system clock default. (See "INITSEEDS = 0 | 1" on page 116 for more details.)

NREPS = integer-value

Use NREPS to specify the number of bootstrap replications (resamplings) to be performed. The default is 100.

SEARCH = Heuristic | BandB | FastStep | NJ | UPGMA

A tree search is performed for each bootstrap resampling of the characters using the options specified under SEARCH. If SEARCH = FastStep, tree searches in each replication are performed using one random-sequence-addition replication and no branch swapping. SEARCH = NJ | UPGMA may be used only if the distance criterion has been selected (see the "Set" command described on page 114).

CONLEVEL = integer-value

Use CONLEVEL to specify the minimum proportion of the bootstrap replicates (expressed as a percentage) in which a group must appear if it is to be included in the bootstrap consensus tree. For example, to obtain a bootstrap consensus tree that shows only those groups which occurred on more than 80% of the trees, you would specify CONLEVEL=80. CONLEVEL must be at least 50, which is the default.

WTS = Ignore | Simple | RepeatCnt | Proportional

If WTS = Ignore, any previously applied character weights are ignored. If WTS = Simple, then characters are sampled with equal probability but character weights are applied. If WTS = RepeatCnt, then weights are treated as repeat counts. WTS = RepeatCnt is only allowed if all weights are integers. If WTS=Proportional, then characters are sampled in proportion to their weights. WTS=Proportional is available even when non-unit character weights are in effect.

NCHAR = Current | number-of-characters

Use NCHAR to specify the number of characters to sample in each replicate. You will almost always want to use NCHAR = Current, however, the option to sample more or fewer than the number of currently included characters may be useful in certain specialized contexts. Using character weights is not allowed when NCHAR is set.
to a value other than the number of included characters.

**GRPfreq = YES | NO**

Unless GRPfreq = NO, a table of bootstrap partition frequencies is output to the display buffer.

**KEEPAll = YES | NO**

If you request KEEPAll, groups occurring at frequencies less than CONlevel will also be retained in the bootstrap consensus as long as they are compatible with all groups that are already included in the consensus. Effectively, this forces CONLEVEL=50, because any group occurring in 50% or more of the replicates will automatically be compatible with all more frequently occurring groups.

**TREEFILE = bootstrap-tree-file-name**

If TREEFILE is specified, a description of all trees found in each bootstrap replicate is given in the NEXUS tree format. Trees contain a weight comment for the purpose of combining bootstrap results from runs performed at different times or on different machines and for recovering results obtained prior to a system crash. The weight is the reciprocal of the number of trees found in a replicate. The `bootstrap-tree-file-name` must follow the conventions described under "Input/Output files" on page 9.

**REPLACE = YES | NO**

If TREEFILE is used and the specified file already exists you will be prompted for confirmation that the existing file should be replaced. REPLACE suppresses this prompt and the existing file will be quietly overwritten by the new data.

**FORMAT = NEXUS | ALTNEX | FREQPars | PHYLIP | HENNIG**

Specifies the type of treefile to be produced. NEXUS requests a file containing the standard NEXUS TREES block using a translation table (which greatly reduces the amount of disk space required to store the trees). ALTNEX also specifies a NEXUS TREES block, but no translation table is used (the full taxon names are included in each tree description). FREQPars requests a treefile for the FREQPars program described by Swoford and Berlocher (1987). PHYLIP requests a treefile for input to version 3.x of Felsenstein’s (1991) PHYLIP package. HENNIG requests a treefile for version 1.5 of Farris’s (1988) Hennig86 program.

**BRLENS = YES | NO**

If BRLENS = YES is specified, the descriptions of the trees saved in the bootstrap tree file will include branch lengths if the program corresponding to the FORMAT setting supports them. BRLENS = NO reverses the effect of a previous BRLENS specification. Note, the BRLENS option pertains only to those trees saved in the bootstrap tree file. Invoking this option will have no effect on the bootstrap consensus tree.
CUTOFFPCT = integer-value

Use CUTOFFPCT to specify the minimum bootstrap partition frequency to be displayed in the partition frequency table. Partitions occurring at a frequency below this value are not shown.

Example

In the following example the BOOTSTRAP command is used to execute a heuristic search with random addition sequence on 200 bootstrap replicate data sets. Optimal trees for each replicate are saved to a file named boot.tre.

bootstrap nreps=200 treefile=boot.tre
search=heuristic/ addseq=random;

CD

Use the CD command to change the current working directory for the Windows, Unix and DOS versions.

Syntax

CD <new-directory>;

Entering the command with no arguments simply reports the current directory.

CHARPARTITION

Use the CHARPARTITION to define a partition of the characters.

Syntax

CHARPARTITION partition-name=partition-definition;

The CHARPARTITION command is ordinarily issued from within the SETS block described on page 22. However, you may also issue it from the command line or from within a PAUP block.

CHARSET

Use the CHARSET command to define a "character set." Character sets are simply groups of characters that can be referred to by a single name in other commands.

Syntax

CHARSET character-set-name=character-list;
The character-set-name must not be identical to any of the original character names.

The CHARSET command is ordinarily issued from within the SETS block described on page 22. However, you may also issue it from the command line or from within a PAUP block.

**CLEAR TREES**

Use the CLEAR TREES command to empty the tree buffer.

**Syntax**

```plaintext
CLEAR TREES [NOWARN = YES | NO];
```

**Menu equivalent**

Trees > Clear Trees

Ordinarily you will be prompted for conformation. If you specify NOWARN=YES, the tree buffer is silently emptied.

**CONDENSE**

Use the CONDENSE command to collapse zero-length branches into polytomies for all trees and then keep only those trees that are unique after the collapsing is accomplished.

**Syntax**

```plaintext
CONDENSE [options];
```

**Menu equivalent**

Tree > Condense Trees ...

**Available options**

- `COLLAPSE = NO | MAXBRLEN | MINBRLEN | AMBEQUAL`
- `DELDUPES = YES | NO`

**Description of Options**

`COLLAPSE = NO | MAXBRLEN | MINBRLEN | AMBEQUAL`

Unless `COLLAPSE = NO` is specified, branches are collapsed according to the specified criterion. `MAXBRLEN` is the method used in PAUP version 3 (and Hennig86). `MINBRLEN` collapses a branch if it is possible for it to have zero length. `AMBEQUAL` collapses a branch if the MPRset of the two incident nodes are identical. These latter two
methods were introduced in Goloboff’s NONA program. We do not recommend their use, but they are available for those who wish to use them.

**DELDUPES = YES | NO**

Unless DELDUPES is specified, duplicate trees will be eliminated.

---

**CONSTRAINTS**

Use the **CONSTRAINTS** command to define a constraint tree.

**Syntax**

```
CONSTRAINTS constraint-name [(BACKBONE) | (MONOPHYLY) | (CONVEXITY)] = tree-specification | taxpartition-name;
```

The *tree-specification* must follow the tree format described on page 25. The *taxpartition-name* must follow the format described under *TAXPARTITION* on page 24.

**Example 1**

The following example assumes that there are 10 taxa, and taxa 2, 3, 5, 7 and 9 are a monophyletic assemblage.

```
constraints lagomorph (monophyly) = (1,4,6,8,10,(2,3,5,7,9));
```

**Example 2**

Because monophyly is the default keyword indicating the constraint type and taxa 1, 4, 6, 10 connect directly to the root node, the above example could also be written:

```
constraints lagomorph = ((2,3,5,7,9));
```

---

**CONTREE**

Use the **CONTREE** command to request computation of strict, semistrict (combinable component), Adams, and/or majority-rule consensus trees.

**Syntax**

```
CONTREE [tree-list] [/options];
```

The tree list specifies which trees to include in the consensus; the default is "ALL."
Menu equivalent

Trees > Compute Consensus

Available options

- PERCENT = integer-value
- LE50 = YES | NO
- STRICT = YES | NO
- SEMISTRICT = YES | NO
- MAJRULE = YES | NO
- ADAMS = YES | NO
- USETREEWTS = YES | NO
- INDICES = YES | NO
- GRPFREQ = YES | NO
- SHOWTREE = YES | NO
- TREEFILE = tree-file-name
- *REPLACE = YES | NO
- *APPEND = YES | NO
- TCOMPRESS = YES | NO
- ROOT = OUTFGROUP | LUNDBERG | MIDPOINT
- OUTROOT = POLYTOMY | PARAPHYL | MONOPHYL

*Option is nonpersistent

Description of options

STRICT = YES | NO

By default, a strict consensus tree is computed. Use STRICT = NO to suppress this computation.

SEMISTRICT = YES | NO

Specify SEMISTRICT = YES to request computation of a semistrict (combinable component) consensus tree. SEMISTRICT = NO reverses the effect of a previous SEMISTRICT specification.

MAJRULE = YES | NO

Specify MAJRULE = YES to request computation of a semistrict (combinable component) consensus tree. MAJRULE = NO reverses the effect of a previous MAJRULE specification.

The following options apply only if MAJRULE is in effect:

PERCENT = integer-value

The integer-value specifies the percentage of the trees on which a group must appear in order to be retained in the majority-
rule consensus. A group must appear on more than this percentage of the trees before it is retained. The default is 50.

**LE50 = YES | NO**

If LE50 = YES is specified, groups occurring on less than 50% of the trees are retained in the consensus if they are compatible with the groups already on the tree. LE50 = NO reverses the effect of a previous LE50 specification.

**GRPfreq = YES | NO**

By default, a table is output that shows all partitions (or groups) occurring on at least one tree and the frequency of each such group. GRPfreq = NO can be used to suppress this output.

**ADAMS = YES | NO**

Specify ADAMS = YES to request computation of an Adams consensus tree. ADAMS = NO reverses the effect of a previous ADAMS specification.

**USETREEwts = YES | NO**

Trees output to a treefile in bootstrap and jackknife contain a weight comment (see page 25). These weights are the reciprocal of the number of trees found in a replicate. The "GetTrees" command described on page 67 will optionally store these weights, and the majority-rule consensus calculator will use them when USETREEwts = YES. This allows calculation of majority-rule consensus trees that correspond exactly to the consensus tree output by the original bootstrap or jackknife command. This option allows the combination of bootstrap results from runs performed at different times or on different machines and the recovery of results obtained prior to a system crash. Also, it permits graphics-quality output of bootstrap trees after redefining an outgroup or otherwise changing rooting options by rereading the trees (with weights) and computing/printing a majority-rule consensus tree.

**Example**

The following example recalls bootstrap trees saved during three separate bootstrap executions. See page 67 for information regarding the GETTREES command. By including the USETREEwts option, the CONTREE command will display the bootstrap majority rule tree for the combined trees contained in the three separate bootstrap tree files.

```plaintext
gettrees file=tfile1.out StoreTreeWts=yes mode=3;
gettrees file=tfile2.out StoreTreeWts=yes mode=7;
gettrees file=tfile3.out StoreTreeWts=yes mode=7;
contree all/strict=no majrule=yes usetreewts=yes;
```

**INDICES = YES | NO**

Specify INDICES to request calculation of a variety of consensus
indices. The following indices are computed by PAUP* and are described in Rohlf (1982) and Swofford (1991):

Component information (consensus fork)
Nelson-Platnick term information
Nelson-Platnick total information
Mickevich’s consensus information
Colless weighted consensus fork (proportion max. information)
Schuh-Farris levels sum
Rohlf’s CI(1)
Rohlf’s -ln CI(2)

SHOWTREE = YES | NO

Unless SHOWTREE = NO, the consensus tree (or trees if more than one consensus method is specified) is printed to the display buffer.

TREEFILE = file-specification

If TREEFILE is specified, a description of all consensus trees computed is output to a file containing a NEXUS-format TREES block. This option is not persistent; you must specify it on every CONTREE command for which you want a tree file to be saved. See "Input/Output files" on page 9 for instructions to specify the full path name of a file.

APPEND = { YES | NO }
REPLACE = { YES | NO }

If the specified file already exists, you will be prompted for confirmation that the existing file should be replaced. Explicit specification of REPLACE suppresses this prompt and the existing file will be quietly overwritten by the new data. Alternatively, you may specify APPEND, in which case a new TREES block will be concatenated to the end of an existing file.

See "Options And Subcommands Affecting Multiple Commands" on page 30 for a description of the following options:

ROOT = OUTGROUP | LUNDBERG | MIDPOINT
OUTROOT = POLYTOMY | PARAPHYL | MONOPHYL
TCOMPRESS = YES | NO

CSTATUS

Use the CSTATUS command to request a listing of character-status information for all characters.

Syntax

CSTATUS [options] ;


Menu equivalent

Data > Show Character Status ...

Available options

- **FULL = YES | NO**
- **EXCLUDED = SHOW | HIDE**

Description of options

**FULL = YES | NO**

For each character, the following information is output if FULL = YES:
1. The number and name (if any) of the character.
2. The character's current type.
3. If the character is constant (invariant), excluded, or uninformative.
4. The character's current weight. The weight value is put into parentheses if the character is excluded.
5. A list of the states observed for the character.

**EXCLUDED = SHOW | HIDE**

If EXCLUDE = HIDE then only the status of the currently included characters will be displayed.

**CTYPE**

Use the CTYPE command to assign character types to characters.

Syntax

```
CTYPE type-name:character-list [, type-name:character-list ] ... ;
```

The type-name must be one of the standard character types (ORD, UNORD, DOLLO, DOLLO.UP, DOLLO.DN, IRREV, IRREV.UP, or IRREV.DN) or the name of a user-defined character type (see, "UserType" on page 20). Each character-list consists of one or more character number, character name (see, "CharLabels" on page 16), or character set name (see, "CharSet" on page 23). The characters specified by character-list are assigned the immediately preceding character-type. Any number of character-type:character-list pairs, separated by commas, may be specified.

Menu equivalent

Data > Set Character Types ...
Example

The following example of the Ctype command assigns the user-defined character type "tcost" to only characters at the 3rd codon position. See page 42 for details regarding the CHARSET command.

```plaintext
charset 3rdpos:3-.\3;
ctype tcost:3rdpos;
```

Defaults

Use the Defaults command to specify default option settings for another command. The options set using this command do not persist after you quit the application.

Syntax

```
DEFAULTS command-name default-option-setting ...;
```

Options for the following commands may be set:
- ALLTREES
- BANDB
- BOOTSTRAP
- CONTREE
- DESCRIBE
- HSEARCH
- LAKE
- LENFIT
- RANDTREES
- SAVETREES

Example

```
defaults hsearch swap=nni addseq=closest;
hsearch;
```

is equivalent to:

```
hsearch swap=nni addseq=closest;
```

Delete

Use the DELETE command to delete a taxon from subsequent analyses.

Syntax

```
DELETE taxon-list [/ONLY] [options];
```

Unless ONLY is specified, taxa specified in the taxon-list are simply added to the set of currently deleted taxa. If taxa have already been deleted and
you want only those taxa specified in taxon-list to remain deleted, specify ONLY; any currently deleted taxa not explicitly specified in the list will be restored.

**Menu Equivalent**

Data > Delete-Restore Taxa ...

**Available options**

- *PRUNE = YES | NO
- *CLEARTREES = YES | NO
- CONDENSE = YES | NO

*Option is nonpersistent

**Description of options**

The following three options pertain only if there are trees in memory that will become invalidated by the deletion of taxa. If you do not specify PRUNE or CLEARTREES, the program will prompt for your desired action. PRUNE and CLEARTREES are mainly useful for batch file processing, where you do not want the program to stop and wait for a response from the user before continuing.

**PRUNE = YES | NO**

If PRUNE = YES is specified, newly deleted taxa will be removed ("pruned") from the trees currently in memory, which otherwise remain unmodified.

**CLEARTREES = YES | NO**

If CLEARTREES is specified, any trees currently in memory are simply deleted.

**CONDENSE = YES | NO**

If CONDENSE is specified, any duplicate trees that result from the removal of taxa (PRUNE option) are deleted.

**DEROOT TREES**

Use the DEROOT TREES command to convert all trees in memory from a rooted to an unrooted representation. The circumstances under which you would need to use this command are rather unlikely.

**Syntax**

DEROOT TREES;
**Menu equivalent**

Trees > Deroot Trees

---

**DESCRIBETREES**

Use the DESCRIBETREES command to output tree diagrams and associated information. Information regarding tree length is given according to the currently selected optimality criterion.

**Syntax**

```
DESCRIBETREES [tree-list] [/options];
```

The tree-list specifies the numbers of the trees you wish to describe. If this is the first DESCRIBETREES command and you do not specify a tree list, only the first tree is described.

**Menu equivalent**

Trees > Describe Trees ...

**Available options**

- **PLOT** = None | Cladogram | Phylogram | Both
- **ROOT** = Outgroup | Lundberg | Midpoint
- **OutRoot** = Polytomy | Paraphyl | Monophyl
- **BrLens** = Yes | No
- **LabelNode** = Yes | No
- **XOut** = None | Terminal | Internal | Both
- **MPRSETS** = Yes | No
- **ApoList** = Yes | No
- **ChgLList** = Yes | No
- **Patristic** = Yes | No
- **Homoplasy** = Yes | No
- **FValue** = Yes | No
- **Diag** = Yes | No
- **TCompress** = Yes | No
- **CMLabels** = Yes | No
- **CMShowEq** = Yes | No
- **CMColWid** = integer-value
- **CMCStatus** = Yes | No
Commands used in the PAUP Block

Description of options

PLOT = NONE | CLADOGRAM | PHYLOGRAM | BOTH

If PLOT = CLADOGRAM, branch lengths on the tree have no meaning, and taxa are aligned at the right edge of the diagram. If PLOT = PHYLOGRAM, branch lengths are drawn proportionally to the number of changes assigned to each branch. PLOT = BOTH requests output of the tree diagram in both CLADOGRAM and PHYLOGRAM formats.

BRLENS = YES | NO

Requests output of a table of assigned, minimum-possible, and maximum-possible branch lengths.

CHGLIST = YES | NO

Requests output of a list of changes in each character.

APOLIST = YES | NO

If set to YES a list of the apomorphic characters is displayed. The list includes the characters that have changed along each branch, the consistency index for each character, and the original and transformed character. The double arrow "==>" under the change column represents unambiguous changes and the single arrow "-->" represents ambiguous changes.

DIAG = YES | NO

Requests output of character diagnostics, including the minimum-possible, assigned, and maximum-possible length of each character, and goodness-of-fit measures based on these quantities.

PATRIC = YES | NO

Requests output of the patristic distance matrix.

HOMOPLASY = YES | NO

Requests output of the pairwise homoplasy matrix.

LABELNODE = YES | NO

Ordinarily, internal nodes on the tree diagram are labeled with a node number that is referenced by other output information (change lists, apomorphy lists, etc.). LABELNODE = NO can be used to suppress the labeling of internal nodes.

XOUT = NONE | TERMINAL | INTERNAL | BOTH

Requests output of a table of character-state assignments for each tree. XOUT = INTERNAL requests output of the character-states assigned to internal nodes for each tree. XOUT = TERMINAL requests a listing of the original data matrix. (This option is not particularly useful, as you would ordinarily use the SHOWMATRIX command to list the data matrix.) XOUT = BOTH requests a listing of the original
data matrix plus the states assigned to internal nodes.

\[ \text{MPRSETS} = \text{YES} | \text{NO} \]

Requests a listing of the possible character-state assignments (MPR-sets) for each tree (parsimony criterion only).

\[ \text{FVALUE} = \text{YES} | \text{NO} \]

Requests output of the F-value and F-ratio.

See "Options And Subcommands Affecting Multiple Commands" on page 30 for details.

\[ \text{ROOT} = \text{OUTGROUP} | \text{LUNDBERG} | \text{MIDPOINT} \]
\[ \text{OUTROOT} = \text{POLYTMONY} | \text{PARAPHYL} | \text{MONOPHYL} \]
\[ \text{TCOMPRESS} = \text{YES} | \text{NO} \]
\[ \text{CMLABELS} = \text{YES} | \text{NO} \]
\[ \text{CMSHOWEQ} = \text{YES} | \text{NO} \]
\[ \text{CMCSTATUS} = \text{YES} | \text{NO} \]
\[ \text{CMCOLWID} = \text{column-width} \]

---

**DOS**

Use the DOS command to execute a DOS command and return immediately to PAUP* or to enter a DOS shell.

**Syntax**

\[ \text{DOS} \ [\text{dos-command}] \; \]

If you do not specify a command, PAUP* will open a DOS shell. Type `exit` at the DOS prompt when you want to return to PAUP*. If you specify a command, control is returned to PAUP* immediately after the command has finished. You can type a command that contains a semicolon by enclosing the entire command within single-quotes.

---

**DSCORES**

Use the DSCORES command to calculate scores of trees in memory according to distance criterion. The `tree-list` indicates which trees are to be evaluated.

**Syntax**

\[ \text{DSCORES} \ [\text{tree-list}] [\text{/options}] \; \]

**Menu equivalent**

Trees > Tree Scores > Distance ...
Available options

- `*SORTTrees = No | Yes`
- `SCOREFile = file-name-for-scores`
- `*REPLACE = No | Yes`
- `*APPEND = No | Yes`
- `*DISPLAYOut = No | Yes`
- `DISTANCE = User | Total | Mean | Abs | P | JC | F81 | TajNei | K2P | F84 | HKY85 | K3P | TamNei | GTR | Custom | ML | LogDet | Upholt | NeiLi`
- `RATES = Equal | Gamma`
- `SHAPE = real-value`
- `PINVAR = real-value`
- `REMOVEFreq = Proportional | Equal`
- `ESTFreq = All | Constant`
- `ALLSitesMean = Yes | No`
- `SUBSt = All | TV | TI | TRatio`
- `CLASS = (CAC CAT CCG CCT CGT)`
- `BASEFreq = Equal | Empirical`
- `MISSDist = Infer | Ignore`
- `OBJECTIVE = ME | LSFit`
- `POWER = integer-value`
- `NEGBRLEN = Prohibit | Allow | SetZero | SETABSVal`
- `DCOLLapse = Yes | No`
- `WTS = REPEATCNT | Ignore`

Description of options

`SORTTrees = No | Yes`
When multiple trees are evaluated under the DSCORES command `SORTTrees = Yes` will sort tree scores so that they are displayed in ascending order.

`SCOREFile = file-name-for-scores`
If `SCOREFile` is specified, distance scores under the current objective function for each tree evaluated is saved to a text file. The `file-name-for-scores` must follow the conventions described under "Input/Output files" on page 9.

`REPLACE = Yes | No`
`APPEND = Yes | No`

If the `file-name-for-scores` already exists, you will be prompted for confirmation before the existing file is replaced. Use `REPLACE = Yes` to suppress this prompt; the existing file will
be quietly overwritten by the new data. Alternatively, you may specify APPEND, in which case a new TREES block will be concatenated to the end of an existing file.

DISPLAYOUT  NO | YES

Set DISPLAYOUT = YES if you wish to suppress output to the display buffer.

The remaining options for this command are the same as those used under the DSET command. See page 55 for a description of these options.

**DSET**

Use the DSET command to set options for distance analysis.

**Syntax**

DSET [options];

**Menu equivalent**

Analysis > Distance Settings ...

**Available options**

- **DISTANCE** = USER | TOTAL | MEAN | ABS | P | JC | F81 | TajNei | K2P | F84 | HKY85 | K3P | TamNei | GTR | CUSTOM | ML | LOGDET | Upholt | NeiLi
- **RATES** = EQUAL | GAMMA
- **SHAPE** = real-value
- **PINVAR** = real-value
- **REMOVEFREQ** = PROPORTIONAL | EQUAL
- **ESTFREQ** = ALL | CONSTANT
- **ALLSITESMEAN** = YES | NO
- **SUBST** = ALL | TV | TI | TRATIO
- **CLASS** = (CAC CAG CAT CCG CCT CGT)
- **BASEFREQ** = EQUAL | EMPIRICAL
- **MISSDIST** = INFERR | IGNORE
- **OBJECTIVE** = ME | LSFit
- **POWER** = integer-value
- **NEGBRLEN** = PROHIBIT | ALLOW | SETZERO | SETABSVAL
- **DCOLLAPSE** = YES | NO
- **WTS** = REPEATCNT | IGNORE
## Description of options

**DISTANCE** = **USER** | **TOTAL** | **MEAN** | **ABS** | **P** | **JC** | **F81** | **TajNei** | **K2P** | **HKY85** | **K3P** | **TamNei** | **GTR** | **CUSTOM** | **ML** | **LOGDET** | **Upholt** | **Neili**

Use the **DISTANCE** option to specify the distance measure used to calculate the scores of the trees in memory. The following distances may be used:

<table>
<thead>
<tr>
<th>Distance</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>USER</td>
<td>user-defined distance (see &quot;Commands used in the DISTANCES Block&quot; on page 27)</td>
</tr>
<tr>
<td>TOTAL</td>
<td>total number of pairwise character differences</td>
</tr>
<tr>
<td>MEAN</td>
<td>mean number of pairwise character differences (adjusted for missing data)</td>
</tr>
<tr>
<td>ABS</td>
<td>absolute distances</td>
</tr>
<tr>
<td>P</td>
<td>uncorrected distance often referred to as the ( p )-distance or dissimilarity (( D )) distance.</td>
</tr>
<tr>
<td>JC</td>
<td>Jukes and Cantor (1969); equal base frequencies, one substitution type</td>
</tr>
<tr>
<td>F81</td>
<td>Felsenstein (1981); unequal base frequencies, one substitution type</td>
</tr>
<tr>
<td>TajNei</td>
<td>Tajima and Nei (1984); unequal base frequencies, one substitution type</td>
</tr>
<tr>
<td>K2P</td>
<td>Kimura (1980); equal base frequencies, unequal Ti:Tv</td>
</tr>
<tr>
<td>F84</td>
<td>Felsenstein (1984); unequal base frequencies, unequal Ti:Tv</td>
</tr>
<tr>
<td>HKY85</td>
<td>Hasegawa, Kishino, and Yano (1985); unequal base frequencies, unequal Ti:Tv</td>
</tr>
<tr>
<td>K3P</td>
<td>Kimura (1981); equal base frequency; 3 substitution types</td>
</tr>
<tr>
<td>TamNei</td>
<td>Tamura and Nei (1993); unequal base frequency; 3 substitution types</td>
</tr>
<tr>
<td>GTR</td>
<td>general time-reversible model (Lanave et al. 1984, and Rodriguez et al. 1990); unequal base frequencies, 6 substitution types.</td>
</tr>
<tr>
<td>CUSTOM</td>
<td>user defines the base frequencies and number of substitution types</td>
</tr>
<tr>
<td>ML</td>
<td>maximum likelihood estimator of distance under current maximum likelihood settings</td>
</tr>
</tbody>
</table>
Example 1

The following example of the DSET command demonstrates one of the ways to specify a maximum likelihood model when the DISTANCE option is set to ML. On line two the LSCORES (page 83) command is used to estimate all six substitutions rate classes and the gamma shape parameter on the neighbor joining (see page 94) generated from line one. The LSET (page 87) command is then used to fix the parameter values to those estimated by the LSCORES command.

```
nj;
lscore 1/nst=6 rmatrix=estimate rates=gamma
   shape=estimate;
lset rmatrix=previous shape=previous;
dset distance=ml;
```

The following set of options apply only to the calculation of pairwise distances:

- **RATES** = **EQUAL | GAMMA**
  - Unless RATES = GAMMA, rates across all characters are assumed to be equal. If RATES = GAMMA, rates across sites are assumed to follow a continuous gamma distribution. The shape of the gamma distribution is equal to the value specified for the SHAPE option. This option is not available for ABS, P, LOGDET, or ML distances. To specify gamma distributed rates for ML distances use the "LSet" command described on page 87.

- **SHAPE** = *real-value*
  - Use SHAPE to specify the shape of the gamma distribution used to accommodate among-site rate variation. Again, this option is not available for ABS, P, LOGDET, or ML distances. To specify the gamma-shape parameter for ML distances use the "LSet" command described on page 87.

- **PINVAR** = *real-value*
  - Use PINVAR to specify the proportion of invariable sites (i.e., sites that are unable to accept substitutions); the remaining sites are assumed to vary at the same rate.

The following options are available only if a *real-value* has been specified under PINVAR:

<table>
<thead>
<tr>
<th>Distance</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOGDET</td>
<td>log-determinant (Steel, 1994; Lockhart et al., 1994) or paralinear (Lake, 1994) distances</td>
</tr>
<tr>
<td>UPHOLT</td>
<td>restriction-site distance of Upholt (1977)</td>
</tr>
<tr>
<td>NEILHI</td>
<td>restriction-site distance of Nei and Li (1979)</td>
</tr>
</tbody>
</table>
**REMOVEFREQ = PROPORTIONAL | EQUAL**

If REMOVEFREQ = EQUAL, the same number of identical sites is removed from each nucleotide in a given pairwise comparison. If REMOVEFREQ = PROPORTIONAL, then the number of identical sites removed is proportional to the frequency of each base.

**ESTFREQ = ALL | CONSTANT**

If REMOVEFREQ = PROPORTIONAL, then the frequency of each base may be estimated from the entire data set (ESTFREQ = ALL) or only the invariable sites (ESTFREQ = CONSTANT).

**ALLSITESMEAN = YES | NO**

Adjust the distance so that it represents the mean number of substitutions over all sites, rather than only the variable sites.

**SUBST = ALL | TV | TI | TRATIO**

By default PAUP* counts or estimates substitutions of all types (SUBST = ALL). For many DNA distances, the distance represents the mean number of substitutions per site that have accumulated since a pair of taxa last shared a common ancestor. You can restrict PAUP* to count or estimate changes representing transition, changes from a purine (A or G) to pyrimidine (C or T) (SUBST = TI) or transversion, changes from a purine to a purine and pyrimidine to a pyrimidine (SUBST = TV). Finally, PAUP* will output the transition/traversal ratio for the distance chosen when SUBST = TRATIO.

**CLASS = (CAC CAG CAT CCG CCT CGT)**

If DISTANCE = CUSTOM, then substitution types may be assigned to any of six classes. For example, substitution types may be pooled into common classes to reflect changes between structurally similar molecules (e.g. transitions and transversions). A user is free to decide among the many possible ways that substitution types may be divided or combined.

**Example 2**

The following example pools transitions into a common class and defines two separate classes for transversions.

```plaintext
dset distance=custom class=(a b a a c a);
```

**BASEFREQ = EQUAL | EMPIRICAL**

If DISTANCE = CUSTOM, base frequencies used to estimate pairwise distances may be based on either the empirical base frequency or equal base frequencies (i.e., frequency of each base equals 1/4).
MISSDIST = INFER | IGNORE

Unless MISSDIST = IGNORE, PAUP* infers "missing-data" sites (including gaps) and ambiguity codes by distributing them proportionately to unambiguous changes. You may also choose to ignore sites for the affected pairwise comparison (IGNORE).

The following set of options apply to the calculation of branch lengths and tree scores:

OBJECTIVE = ME | LSFIT

Choose between minimum evolution (ME) and least-squares (LSFIT) objective functions. See Swofford et al. (1996) for a discussion of these objective functions.

POWER = integer-value

Sums of squared deviations in least-squares analyses (OBJECTIVE = LSFIT) may be unweighted (POWER = 0), weighted by the inverse (POWER = 1) of the distance, or weighted by the squared inverse (POWER = 2). POWER = 2 corresponds with the method of Fitch and Margolish (1967).

Example 3

The following use of the DSET command corresponds to the method of Fitch and Margolish (1967).

\[
dset \text{ distance}=\text{jc} \quad \text{objective}=\text{lsfit} \quad \text{power}=2;
\]

NEGBRLEN = PROHIBIT | ALLOW | SETZERO | SETABSVAL

Use NEGBRLEN to specify negative branch length handling. If NEGBRLEN = PROHIBIT, then PAUP* constrains branch lengths to be nonnegative. By default, PAUP* allows but sets to zero negative branch lengths when computing the value of the objective function (SETZERO). You may also allow negative branch lengths (ALLOW) or an absolute value (SETABSVAL) when computing the value of the objective function.

DCOLLAPSE = YES | NO

Use DCOLLAPSE to collapse branches of effectively zero length when searching. If a branch has a length less than or equal to $1 \times 10^{-8}$, it is eliminated from the tree.

WTS = REPEATCNT | IGNORE

If WTS=IGNORE, character weights are ignored. The default (WTS = REPEATCNT) treats integer weights as repeat counts.

EDIT

Edit the command to edit a file using PAUP*’s editor.
Syntax

EDIT [file-specification];

This command is only valid in implementations of PAUP* that provide built-in editing capabilities.

EXCLUDE

Use the EXCLUDE command to exclude one or more characters from tree-score calculations.

Syntax

EXCLUDE character-list [/ONLY];

Unless /ONLY is specified, characters specified in the character-list are simply added to the set of currently excluded characters. If some characters have already been excluded but you want only those characters specified in character-list to remain excluded, specify /ONLY; any currently excluded characters not explicitly specified in the list will be re-included. PAUP* includes several predefined characters that may be used in conjunction with or without a character-list. See "CharSet" command described on page 23 for more details.

Menu equivalent

Data > Include-Exclude Characters ...

EXECUTE

Use the EXECUTE command to request processing of an input file. The input file should be a valid NEXUS file.

Syntax

EXECUTE file-specification;

See "Input/Output files" on page 9 for details regarding the format of file-specification

The input file may contain any or all of the following: TAXA blocks, CHARACTERS blocks, DATA blocks, ASSUMPTIONS blocks, TREES blocks, DISTANCES blocks, CODONS blocks, and valid PAUP commands. Although not required, you should place PAUP commands inside of a PAUP block so that other programs (e.g., MacClade) can use the same file. PAUP commands are processed exactly as if they had been entered from the command line, with only a few exceptions (e.g., the EDIT command cannot be issued from a file). Commands are processed until the end of the file is reached, or a QUIT command is encountered.
**Menu equivalent**

File > Execute "your-data-file"

---

**EXPORT**

Use the EXPORT command to save data in a non-NEXUS format.

**Syntax**

```
EXPORT [options];
```

**Menu equivalent**

File > Export Data ...

**Available options**

- `FILE = export-file-name`
- `FORMAT = PHYLIP | HENNIG | TABTEXT | TEXT | NEXUS`
- `TREES = YES | NO`
- `LINEBREAKS = NATIVE | MACINTOSH | DOSWINDOWS | UNIX`
- `CHARSPERLINE = integer-value | ALL`
- `INTERLEAVED = YES | NO`
- `MSTAXAHENNIG = BINCODE | MISSING`
- `UNORDPHYLIP = EXCLUDE | UNMODIFIED`
- `ORDPHYLIP = EXCLUDE | BINCODE | UNMODIFIED`
- `*REPLACE = YES | NO`

*Option is nonpersistent

**Description of options**

- `FORMAT = PHYLIP | HENNIG | TABTEXT | TEXT | NEXUS`

  The FORMAT option specifies the format in which data are saved to the export file. PHYLIP requests data to be output to version 3.4 of Felsenstein's (1991) PHYLIP package. HENNIG requests the output format for version 1.5 of Farris's (1988) Hennig86 program. Data can also be saved as either tab delimited text (TABTEXT) or simple text (Text). NEXUS requests that the data be stored in the standard NEXUS TAXA and CHARACTER blocks.

- `TREES = YES | NO`

  If either the PHYLIP or HENNIG format is chosen TREES=YES will save the trees currently in memory and the data set to the export file.


**LINEBREAKS = NATIVE | MACINTOSH | DOSWINDOWS | UNIX**

Specifies the line termination used in the output file.

**CHARSPERLINE = integer-value | ALL**

Specifies the number of characters written per line.

**INTERLEAVED = YES | NO**

If INTERLEAVED = YES, data are stored in "blocks", which contain information for some of the characters and all of the taxa.

**MSTAXAHENNIG = BINCODE | MISSING**

**UNORDPHYLIP = EXCLUDE | UNMODIFIED**

**ORDPHYLIP = EXCLUDE | BINCODE | UNMODIFIED**

**FILE = export-file-name**

Specify the export-file-name containing non-NEXUS-formatted data. (See "Input/Output files" on page 9 for details regarding the file-name format).

**REPLACE = YES | NO**

If REPLACE is not specified explicitly and the file already exists, you will receive a warning and will have the opportunity to cancel the command before the contents of the existing file are erased.

---

**ExSet**

The ExSet command, used to define "exclusion sets," is ordinarily issued from within the ASSUMPTIONS block. However, you may also issue it from the command line or from within a PAUP block. See "Commands used in the ASSUMPTIONS Block" on page 19 for the description of this command.

---

**Filter**

Use the Filter command to filter trees according to score, constraints, or other criteria.

**Syntax**

```
FILTER [options] | OFF | PURGE;
```
If OFF is specified, trees that do not satisfy the specified filtering criteria are retained. If PURGE is specified, trees that are currently hidden by a tree filter will be deleted from memory.

**Menu equivalent**

Trees > Filter

**Available options**

- **REVERSE** = YES | NO
- *BEST = YES | NO
- **MAXSCORE** = real-value
- **MINSCORE** = real-value
- **NUMLE** = integer-value
- **NUMGE** = integer-value
- **CONSTRAINTS** = constraint-name
- **SD** = integer-value
- **FROM** = integer-value
- *LESSRESOLV = YES | NO
- **PERMDEL** = YES | NO
- **ALWAYS** = YES | NO
- **BINARY** = YES | NO

*Option is nonpersistent

**Description of options**

Any combination of the following filtering criteria can be specified.

**REVERSE** = YES | NO

If REVERSE = YES, the condition of the specified filter is reversed.

**MAXSCORE** = real-value

Use MAXSCORE to specify the maximum score of trees retained by the filter. Trees with higher (worse) scores are not kept.

**Example**

In line one of the following example the FILTER command retains trees with scores less than or equal to 500. The second line retains trees with scores greater than or equal to 500.

```
filter maxscore=500;
filter maxscore=500 reverse=yes;
```
MINSCORE = real-value

Use MINSCORE to specify the minimum score of trees retained by the filter. Trees with lower (better) scores are not kept.

BEST = YES | NO

If BEST=YES only those trees that are optimal according to the current criterion will be retained.

NUMLE = integer-value

Keep trees only if their position in memory (tree number) is less than or equal to the specified integer-value.

NUMGE = integer-value

Keep trees only if their position in memory (tree number) is greater than or equal to the specified integer-value.

CONSTRAINTS = constraint-name

Only those trees that are compatible with the specified constraint tree are retained.

SD = integer-value FROM = integer-value

Only those trees within integer-value symmetric difference distance units of the specified tree number are retained.

LESSRESOLV = YES | NO

Keep a tree only if more highly resolved compatible trees do not exist.

PERMDEL = YES | NO

Permanently delete those trees not retained by the filter.

ALWAYS = YES | NO

Apply filter even when no trees satisfy the filtering criteria.

BINARY = YES | NO

Keep a tree only if none of its internal nodes are greater than degree three.

FACTORY

Use the FACTORY command to reset all options to factory default settings.

Syntax

FACTORY;
Menu equivalent

Options > Restore Option Settings ...

FSTATUS

Use the FSTATUS command to show current status of data, log, and tree file.

Syntax

FSTATUS;

GAMMAPLOT

Use the GAMMAPLOT command to show a gamma-distribution plot.

Syntax

GAMMAPLOT [options];

Menu equivalent

Options > Gamma Distribution ...

Available options

• SHAPE = real-value | ESTIMATE | PREVIOUS
• NCAT = integer-value
• REP_RATE = MEAN | MEDIAN

Description of options

SHAPE = real-value | Previous

If SHAPE = PREVIOUS, the plot of the gamma distribution is drawn using the most recently estimated shape parameter (see the "LSet" command described on page 87). To obtain a plot of the gamma distribution with a user-defined shape parameter specify SHAPE = real-value. PAUP* uses the default value of 0.5 for this option.

NCAT = integer-value

Use NCAT to specify the number of categories into which the continuous gamma distribution is divided in order to obtain a discrete approximation. The default is 4.

REP_RATE = MEAN | MEDIAN

Use REP_RATE to specify whether the mean or the median is used to represent the rates within each category of the gamma distribution.
**GENERATE TREES**

Use the GENERATE TREES command to generate a set of random trees or all-possible trees.

**Syntax**

```
GENERATE TREES {ALL | RANDOM} [options];
```

If ALL is specified, all possible trees given the total number of terminally labelled taxa are drawn. Depending on the version of PAUP* that you are using, the ALL modifier may reach the upper limit on the number of trees that can be stored. For example, if only unrooted strictly bifurcating trees are drawn, then a maximum of 8 taxa for 16-bit systems, 12 taxa for 32-bit systems, and 19 taxa for 64-bit system can be included in the analysis. When Random is specified, PAUP* will draw trees according to a Equiprobable or Markovian model (see below).

**Menu equivalent**

Trees > Generate Trees ... 

**Available options**

- **MODEL = EQUIPROBABLE | MARKOVIAN**
- **NTREES = integer-value**
- **SEED = integer-value**
- **ROOTED = YES | NO**
- **NONBINARY = YES | NO**
- **CONSTRAINTS = constraint-name**
- ***CONVERSE = NO | YES**

*Option is nonpersistent

**Descriptions of options**

**MODEL = EQUIPROBABLE | MARKOVIAN**

If RANDOM is specified, the EQUIPROBABLE model dictates that every possible tree has the same probability. The MARKOVIAN model assumes that trees are generated by a random (pure-birth) branching process.

**NTREES = integer-value**

If RANDOM is specified, NTREES gives the number of trees to be generated. The default is 100.

**SEED = integer-value**

If RANDOM is specified, PAUP* references the system clock to obtain a value used to seed a random number generator. An explicit seed
may be specified to override the system clock default. (See "INITSEEDS = 0|1" on page 116 for more details.)

ROOTED = { YES | NO }

If ROOTED = YES, rooted trees will be generated, otherwise, the generated trees will be unrooted.

NONBINARY = { YES | NO }

When ALL is specified, NONBINARY = YES requests that trees are drawn from the set of all possible binary and nonbinary trees. By default (NONBINARY = NO), only binary trees are generated.

If ALL is specified the following options apply (see "Options And Subcommands Affecting Multiple Commands" on page 30 for descriptions of these options).

CONSTRAINTS = constraint-name
CONVERSE = NO | YES

GETTREES

Use the GETTREES command to load trees into memory from a file containing a NEXUS-format TREES block.

Syntax

GETTREES [options];

Menu equivalent

Trees > Get Trees from File ...

Available options

• FILE = tree-file-name
• FROM = integer-value
• TO = integer-value
• MODE = 1 | 2 | 3 | 4 | 5 | 7
• ALLBLOCKS = YES | NO
• *ROOTED = YES | NO
• *UNROOTED = YES | NO
• DUPTREES = KEEP | ELIMINATE
• STORERLENS = YES | NO
• STORETREEWTS = YES | NO
• WARNTREE = YES | NO

*Option is nonpersistent
Description of options

FILE = tree-file-name

Specify the tree-file-name containing a NEXUS-format TREES block. (See "Input/Output files" on page 9 for details regarding the file-name format)

FROM = integer-value

If nonzero, integer-value specifies the number of the first tree in the file to get.

TO = integer-value

If nonzero, integer-value specifies the number of the last tree in the file to get.

ALLBLOCKS = YES | NO

If ALLBLOCKS = YES, then all of the TREES blocks contained within the specified file will be processed.

MODE = 1 | 2 | 3 | 4 | 5 | 7

By default (MODE=3), any preexisting trees in memory are replaced by the trees read from the file. The MODE setting allows you to alter this behavior. Let $M =$ the set of trees originally in memory and $T =$ the set of trees from the tree file. The following mode values are then available:

1 = replace $M$ by $T - M$ (i.e., keep trees from the file that are not originally in memory)

2 = replace $M$ by $T \cap M$ (keep trees from the file that are also originally in memory)

3 = replace $M$ by $T$ (i.e., replace all trees in memory by all trees from the file)

4 = replace $M$ by $M - T$ (i.e., keep trees in memory that are not also in the file)

5 = replace $M$ by $M \oplus T$ (i.e., keep trees that are either currently in memory or in the file, but not both places)

7 = replace $M$ by $M \cup T$ (i.e., append trees from file to trees originally in memory)

ROOTED = YES | NO

If directed character types are in effect for one or more characters and the trees being input are unrooted, you will ordinarily be asked if you want to convert the trees to rooted trees (otherwise, you will not be able to use the new trees unless you change the character types or root them later). If you specify ROOTED explicitly, this conversion will occur automatically without a prompt.
UNROOTED = YES | NO
If the trees being input are rooted but all character types are currently undirected, you will ordinarily be asked if you want to convert the trees to unrooted trees. If you specify UNROOTED explicitly, this conversion will occur automatically without a prompt.

DUP TREES = KEEP | ELIMINATE
Duplicate trees from the TREEFILE are eliminated if DUP TREES = ELIMINATE.

STORE BRLENS = YES | NO
If branch lengths are present in the TREES block, then STORE BRLENS = YES stores branch lengths.

STORE TREEWTS = YES | NO
If tree weights are present in the TREES block, then STORE TREEWTS = YES stores tree weights. Tree weights are typically the reciprocal of the number of trees found in either a BOOTSTRAP or JACKKNIFE replicate. This option allows the combination of bootstrap results from runs performed at different times or on different machines and the recovery of results obtained prior to a system crash. (See "USE TREEWTS = YES | NO" on page 46 for more details)

WARN TREE = { YES | NO }
If WARN TREE = NO, trees currently in memory will be quietly overwritten by the trees in the tree-file. Otherwise, you will be prompted for confirmation.

Example
The following example of the GETTREES command reads the trees and branch length information (if present) from the file "treefile.tre" without overwriting the trees currently in memory.

gettrees file=treefile.tre mode=7 storebrlens=yes;

HELP
Use the HELP command to obtain help on using PAUP*’s command-line interface.

Syntax
HELP [{COMMANDS | command-name}]
If invoked with no arguments, HELP produces a list of the available commands. If COMMANDS (or CMD5) is specified, a one-line description of each command is output. If a command-name is specified, HELP provides information of that command.
Example 1

The following example requests a lists of available commands.

```
help;
```

Example 2

The following example requests a list of available commands, with a one-line description of each.

```
help commands;
```

Example 3

The following example requests help on the BANDB command.

```
help bandb;
```

Note: The help file distributed with this beta test version is out-of-date at this time.

**HOMPART**

Use the HOMPART command to perform test for homogeneity of partitioned data sets. This test was described as the incongruence-length difference test by Farris et al. (1995).

**Syntax**

```
HOMPART [options] [/heuristic-search-options | branch-and-bound-search-options];
```

**Menu equivalent**

Analysis > Partition Homogeneity Test ...

**Available options**

- **PARTITION = character-partition-name**
- **NREPS = integer-value**
- **SEED = integer-value**
- **SEARCH = HEURISTIC | BANDB**

**Description of options**

**PARTITION = character-partition-name**

Use **PARTITION** to specify the **character-partition-name** to be used in the analysis. To learn how to setup Character-partitions see
CHARPARTITIONS page 24.

NREPS = integer-value
Use NREPS to specify the number of homogeneity replicates to be performed.

SEED = integer-value
By default, PAUP* references the system clock to obtain a value used to seed a random number generator. An explicit seed may be specified to override the system clock default. (See "INITSEEDS = 0 | 1" on page 116 for more details.)

SEARCH = H | BANDB
A search is performed for each data partition replicate using the option specified for SEARCH. Options for either of the search options may be specified after a slash. (See the "BandB" command described on page 37 and the "HSearch" command described on page 71 for a description of the available options.)

Example
The following example of the HOMPART command uses the character partition definition named "genes" (see page 42), specifies 1000 randomizations using the random number seed 123, and uses a branch and bound search to obtain the sum of tree lengths for each partition.

```
charpartition genes=cytb:1-200, 12S:201-;  
hompart partition=genes nreps=1000 seed=123  
search=bandb;
```

**HSEARCH**

Use the HSEARCH command to search for optimal trees using heuristic algorithms.

**Syntax**

```
HSEARCH [options] ;
```

**Menu equivalent**

Analysis > Heuristic Search ...

**Available options**

- *START = STEPWISE | NJ | CURRENT | tree-number [-tree-number ]
- ADDSEQ = SIMPLE | CLOSEST | ASIS | RANDOM | FURTHEST
- NREPS = integer-value
- RSEED = integer-value
Commands used in the PAUP Block

- SAVEREPS = YES | NO
- RSTATUS = YES | NO
- REFTAX = integer-value
- HOLD = integer-value | NO
- SWAP = NONE | NNI | SPR | TBR
- MULTREES = YES | NO
- KEEP = real-value | NO
- NBEST = integer-value | NO
- ALLSWAP = YES | NO
- RECONLIMIT = integer-value | INFINITY
- ENFORCE = YES | NO
- CONSTRAINTS = constraint-name
- CONVERSE = YES | NO
- USENONMIN = YES | NO
- STEEPEST = YES | NO
- ABORTREP = YES | NO
- NCHUCK = integer-value
- CHUCKSCORE = real-value | NO
- *RETAIN = YES | NO
- STATUS = YES | NO
- DSTATUS = integer-value | NONE
- RANDOMIZE = ADDSEQ | TREES
- TIMELIMIT = integer-value | NONE
- REARRLIMIT = integer-value | NONE
- LIMITPERREP = NO | YES

*Option is nonpersistent

Description of options

START = STEPWISE | NJ | CURRENT | tree-number [-tree-number]

When parsimony or likelihood is selected as the optimality criterion (see the "Set" command described on page 114) stepwise addition becomes the default procedure to obtain starting trees for branch swapping. Neighbor joining becomes the default procedure when distance is selected as the optimality criterion. Neighbor joining (START = NJ) may be used to obtain starting trees only if the optimality criterion is set to maximum likelihood or distance. Alternatively, you can request that all of the trees currently in memory (START = CURRENT) or a subset of the current trees (START = tree-number [-tree-number]) be used as a starting points for branch swapping.
ADDSEQ = \textbf{SIMPLE} | \textbf{CLOSEST} | \textbf{ASIS} | \textbf{RANDOM} | \textbf{FURTHEST}

Use \texttt{ADDSEQ} to specify the addition sequence to be used in the stepwise addition procedure. \texttt{SIMPLE} addition sequence is the default procedure used when parsimony is selected as the optimality criterion; \texttt{ASIS} is the default under the likelihood criterion.

Options for \texttt{ADDSEQ = SIMPLE}:

\texttt{REFTAX = reference-taxon-number}

By default, the first taxon in the data file is used as the reference taxon. Use \texttt{REFTAX} to specify an alternate reference taxon. This option is relevant only for unrooted-tree searches. For rooted-tree searches, the hypothetical ancestor (see "Ancstates" on page 36 and "Assume" on page 36) is used as the reference taxon.

Options for \texttt{ADDSEQ = RANDOM}:

\texttt{NREPS = integer-value}

Use \texttt{NREPS} to specify the number of random-addition-sequence replications to be performed. The default is 10.

\texttt{RSEED = integer-value}

By default, PAUP* references the system clock to initialize the seed used to generate pseudorandom numbers used to obtain random-addition-sequences (i.e., \texttt{RSEED} = 0). An explicit seed may be specified to override the system clock default. (See "\texttt{INITSEEDS} = 0|1" on page 116 for more details.)

\texttt{SAVEREPS = YES|NO}

If \texttt{SAVEREPS = YES}, then optimal trees from each repetition are saved even if they are not optimal over all repetitions.

\texttt{RANDOMIZE = ADDSEQ | TREES}

If \texttt{RANDOMIZE = TREES}, initial trees are random trees rather than trees found by random-addition-sequence.

\texttt{RSTATUS = YES|NO}

If you specify \texttt{RSTATUS = YES}, a status report showing the results of each random-addition-sequence replication is output. The status report can be useful in evaluating the effectiveness of the heuristic search while the search is proceeding.

\textbf{Example 1}

The following example shows the syntax used to execute a heuristic search with 20 random-addition-sequence replicates. A random number seed of 123 is used to generate random-addition-sequences.
hsearch addseq=random nreps=20 rseed=123;

HOLD = integer-value | NO

Specifies the number of trees to be held at each cycle of the stepwise-addition procedure. By default, HOLD = 1, so that a single tree is held at each step. While setting \( n > 1 \) sometimes improves the score of the tree found by stepwise addition it will also increase the time required to complete the addition of sequences.

SWAP = TBR | SPR | NNI | NONE

Specifies the algorithm used by branch-swapping: TBR = tree bisection-reconnection, SPR = subtree pruning-regrafting, NNI = nearest-neighbor interchange, NONE = No branch swapping performed. NNI rearrangements are a subset of those done by SPR, and SPR rearrangements are a subset of those done by TBR. Ordinarily, you will use TBR, but SPR or NNI can be used to reduce search times.

MULTREES = YES | NO

Ordinarily, PAUP* saves all minimal trees it finds during branch swapping. You can override the default with MULTREES=NO to save only one of the best trees found. Use of MULTREES = NO is not recommended, as it can drastically reduce the ability of branch swapping to find the best tree. (This option is synonymous with MULPARS option in earlier versions of PAUP.)

NBEST = integer-value | NO

Use NBEST to save the N best trees discovered during the search according to the optimality criterion in effect. The NBest option cannot be used when random-addition-sequence is in effect (i.e., ADDSEQ = RANDOM).

ALLSWAP = YES | NO

Unless ALLSWAP = YES is specified, the trees saved by setting NBEST > 1 will include only those trees encountered during a search for optimal trees; no special effort is made to find additional trees that might be still better. If ALLSWAP = YES is requested, then all trees saved are themselves input to the branch swapping procedure, making it much more likely that the optimal NBEST trees will be found. Setting ALLSWAP = YES can dramatically increase the search time, however.

RECONLIMIT = integer-value | INFINITY

The reconnection limit option limits the scope of SPR and TBR rearrangements. If an integer-value is specified, the value corresponds to the sum of the number of nodes between each reconnected branch and the nodes incident to the branch that was cut for pruning (SPR) or bisection (TBR). A rearrangement limit of 1 corresponds to nearest-neighbor interchanges. The default limit is set to infinity.
USENONMIN = YES | NO

It is possible that the trees in memory at the time branch-swapping begins are not all equal in score. By default, only the best available trees are input to the branch-swapping procedure. If you want to swap on nonminimal trees as well, specify USENONMIN=YES.

STEEPEST = YES | NO

Specify STEEPEST to request use of the steepest-descent modification in the branch-swapping procedure. STEEPEST = NO reverses the effect of a previous STEEPEST specification.

NCHUCK = integer-value
CHUCKSCORE = real-value | NO

If this pair of options is used, no more than the number of trees specified by the NCHUCK option of score greater than or equal to the score specified by the CHUCKSCORE option will be retained in a search (or in a random-addition-sequence replicate). These options allow a user to effectively set a maxtrees limit (see page 119) when swapping on less "promising" trees and remove the limit for more "promising" trees.

**Example 2**

In the following example of the HSEARCH command the NCHUCK and CHUCKSCORE options are used to save a maximum of 100 trees with scores of 600 or above; no limit is imposed for trees less than 600.

```
hsearch nchuck=100 chuckscore=600;
```

ABORTREP = YES | NO

If ABORTREP is requested and NCHUCK and CHUCKLEN values have been specified, the current random-addition-sequence replicate will be aborted if the "chucking" limits are hit.

RETAIN = number-of-trees-to-retain

The first number-of-trees-to-retain will be retained in memory throughout the search. (Ordinarily, all trees initially in memory will be replaced by trees found during the search.) The RETAIN option is not persistent; you must reset it for every HSEARCH command if you want to continue retaining the same set of initial trees.

TIMELIMIT = integer-value | NONE

If an integer-value is specified, the search will be limited to a user-specified length of time, where the integer-value is the number of seconds to search.

REARRLIMIT = integer-value | NONE

If an integer-value is specified, the search will be limited to a user-specified number of tree rearrangements (branch swaps), where the integer-value is the maximum number of rearrangements to be
LIMITPERREP = NO | YES

By default, the TIMELIMIT and REARRLIMIT options apply to the entire search in random-addition-sequence searches. However, if you request LIMITPERREP=YES, then the limits are imposed separately for each addition-sequence replicate. For replicated searches such as the bootstrap (page 39), the jackknife (page 77), and the partition-homogeneity test (page 70) the limits are always applied separately for each search.

Example 3

The following example of the HSEARCH command imposes a rearrangement limit of 5000 for each of 20 random-addition-sequence replicates.

```
  hsearch addseq=random nreps=20 rearrlimit=5000
  limitperrep=yes;
```

See "Options And Subcommands Affecting Multiple Commands" on page 30 for a description of the following options:

- **KEEP** = keep-score
- **ENFORCE** = YES | NO
- **CONSTRAINTS** = constraint-name
- **CONVERSE** = YES | NO
- **STATUS** = YES | NO
- **DSTATUS** = integer-value | NONE

---

**INCLUDE**

Use the INCLUDE command to re-include characters that were previously excluded.

**Syntax**

```
  INCLUDE character-list [ /ONLY ];
```

Unless /ONLY is specified, characters specified in the character list are simply removed from the set of currently excluded characters. If you want only those characters specified in the list to be included, specify /ONLY; characters not explicitly specified in the list will then be excluded. PAUP* includes several predefined characters that may be used in conjunction with or without a character-list. See "CharSet" command described on page 23 for more details.

**Menu equivalent**

Data > Include-Exclude Characters ...

---
**INGROUP**

Use the INGROUP command to return one or more taxa to the ingroup.

**Syntax**

```
INGROUP  taxon-list  [/ONLY];
```

Unless /ONLY is specified, taxa specified in the taxon-list are simply removed from the current outgroup. If you want only those taxa specified in taxon-list to be included in the ingroup, specify /ONLY; any taxon that is not explicitly specified in the list will be transferred to the outgroup.

**Menu equivalent**

Data > Define Outgroup ...

---

**JACKKNIFE**

Use the JACKKNIFE command to perform jackknife analysis.

**Syntax**

```
JACKKNIFE  [options]  [/heuristic-search-options | branch-and-bound-search-options];
```

**Menu equivalent**

Analysis > Bootstrap/Jackknife ...

**Available options**

- `PCTDELETE = real-value`
- `JSEED = integer-value`
- `NREPS = integer-value`
- `SEARCH = HEURISTIC | BANDB | FASTSTEP | NJ | UPGMA`
- `RESAMPLE = NORMAL | JAC`
- `CONLEVEL = integer-value`
- `KEEPALL = YES | NO`
- `WTS = IGNORE | SIMPLE | REPEATCNT | PROPORTIONAL`
- `GRPfreq = YES | NO`
- `TREEFILE = tree-file-name`
- `FORMAT = Nexus | ALTNEXUS | FREQPARS | PHYLIP | HENNIG`
- `*REPLACE = YES | NO`
- `*CUTOFFPct = integer-value`
*Option is nonpersistent

**Description of options**

**PCTDELETE = real-value**

Use PCTDELETE to specify the percentage of the data set to be deleted for each jackknife replicate.

**JSEED = integer-value**

By default, PAUP* references the system clock to initialize the seed used to generate pseudorandom numbers for character resampling. An explicit seed may be specified to override the system clock default. (See "INITSEEDS = 0 | 1" on page 116 for more details.)

**NREPS = integer-value**

Use NREPS to specify the number of jackknife replications to be performed.

**SEARCH = HEURISTIC | BANDB | FASTSTEP | NJ | UPGMA**

A tree search is performed for each jackknife sample using the method specified under SEARCH. If SEARCH = FASTSTEP, tree searches in each replication are performed using one random-sequence-addition replication and no branch swapping. SEARCH = NJ | UPGMA may be used only for the distance criterion.

**RESAMPLE = NORMAL | JAC**

If RESAMPLE = JAC, then the JAC program in Hennig86 (Farris) is emulated.

**CONLEVEL = integer-value**

Use CONLEVEL to specify the minimum proportion of the bootstrap replicates (expressed as a percentage) in which a group must appear if it is to be included in the bootstrap consensus tree. For example, to obtain a bootstrap consensus tree that shows only those groups which occurred on more than 80% of the trees, you would specify CONLEVEL=80. CONLEVEL must be at least 50, which is the default.

**KEEPALL = YES | NO**

If you request KEEPALL, groups occurring at frequencies less than CONLEVEL will also be retained in the jackknife consensus as long as they are compatible with all groups that are already included in the consensus. Effectively, this forces KEEPALL=50, because any group occurring in 50% or more of the replicates will automatically be compatible with all more frequently occurring groups.

**WTS = IGNORE | SIMPLE | REPEATCNT | PROPORTIONAL**

If WTS = IGNORE, any previously applied character weights are ignored. If WTS = SIMPLE, then characters are sampled with equal probability but character weights are applied. If WTS = REPEATCNT, then weights are treated as repeat counts. WTS = REPEATCNT is only
allowed if all weights are integers. If WTS=PROPORTIONAL, then characters are sampled in proportion to their weights. WTS=PROPORTIONAL is available even when non-unit character weights are in effect.

**GRPFREQ = YES | NO**

Unless GRPFREQ = NO, a table of jackknife partition frequencies is shown.

**TREEFILE = tree-file-name**

If TREEFILE is specified, a description of all trees found in each jackknife replication is given in the NEXUS tree format. Trees contain a weight comment for the purpose of combining jackknife results from runs performed at different times or on different machines and for recovering results obtained prior to a system crash. The weight is the reciprocal of the number of trees found in a replicate. The *tree-file-name* must follow the conventions described under ”Input/Output files” on page 9.

**REPLACE = YES | NO**

If TREEFILE is used and the specified file already exists you will be prompted for confirmation that the existing file should be replaced. REPLACE suppresses this prompt and the existing file will be quietly overwritten by the new data.

**FORMAT = NEXUS | ALTNEX | FREQPARS | PHYLIP | HENNIG**

Specifies the type of treefile to be produced. NEXUS requests a file containing the standard NEXUS TREES block using a translation table (which greatly reduces the amount of disk space required to store the trees). ALTNEX also specifies a NEXUS TREES block, but no translation table is used (the full taxon names are included in each tree description). FREQPARS requests a treefile for the FREQPARS program described by Swofford and Berlocher (1987). PHYLIP requests a treefile for input to version 3.4 of Felsenstein’s (1991) PHYLIP package. HENNIG requests a treefile for version 1.5 of Farris’s (1988) Hennig86 program.

**CUTOFFPCT = integer-value**

Use CUTOFFPCT to specify the minimum jackknife partition frequency to be displayed in the partition frequency table. All partitions below this integer-value are pooled into a single class.

**LAKE**

Use the LAKE command to perform an analysis using Lake’s (1987b) method of linear invariants. This command is available only when DATATYPE = DNA | RNA | NUCLEOTIDE.
Syntax

LAKE [options];

Menu equivalent

Analysis > Lake’s Invariants ...

Available options

- **MODE** = **CHOOSE4** | **ALLQUART** | **FOURGRPS**
- **SPECTDIST** = **YES** | **NO**
- **BRLENS** = **YES** | **NO**
- **SUMTabONLY** = **YES** | **NO**
- **EXACTN** = integer-value
- **TAXA** = taxon-list FOR MODE=CHOOSE4
- **GRP1** = taxon-list 1 FOR MODE=FOURGRPS
- **GRP2** = taxon-list 2 FOR MODE=FOURGRPS
- **GRP3** = taxon-list 3 FOR MODE=FOURGRPS
- **GRP4** = taxon-list 4 FOR MODE=FOURGRPS

Description of options

**MODE** = **CHOOSE4** | **ALLQUART** | **FOURGRPS**

If there are more than 4 (non-deleted) taxa in the data set, this option specifies whether you want to choose 4 taxa for analysis (MODE=CHOOSE4), analyze all possible quartets (MODE=ALLQUART), or divide the taxa into four groups and analyze all quartets containing one member from each group (MODE=FOURGRPS).

**SPECTDIST** = **YES** | **NO**

**SPECTDIST** requests the output of the spectral distribution (the number of positions falling into each of the 36 possible patterns considered informative by Lake’s method).

**BRLENS** = **YES** | **NO**

**BRLENS** requests output of branch-lengths calculated by Lake’s "operator metric" (Lake, 1987a).

**SUMTabONLY** = **YES** | **NO**

**SUMTabONLY** limits the output to a summary table of results rather than outputting results for each quartet.

**EXACTN** = integer-value

An exact binomial test (rather than the chi-square approximation) will be used to test the significance of deviations of invariant scores
from 0 if the number of informative positions is less than n.

**TAXA = taxon-list**

If MODE = CHOOSE4, you must specify exactly four taxa; the *taxon-list* must contain exactly four taxa. If MODE = ALLQUART, you may limit the number of included taxa by selecting at least four taxa.

**GRPA = taxon-list-for-first-group**
**GRPB = taxon-list-for-second-group**
**GRP C = taxon-list-for-third-group**
**GRPD = taxon-list-for-fourth-group**

If MODE = FOURGRPS, you must assign at least one taxon to each of the four groups; GRPA, GRPB, GRPC, and GRPD.

---

**LEAVE**

Use the LEAVE command to terminate processing of an input file. Ordinarily, PAUP* continues processing until the end of an input file is reached. If, for whatever reasons, you do not want some of the commands in the input file to be processed, insert a LEAVE command into the file at the point where you want execution to stop. PAUP* then continues as if the end of the file were reached at that point. LEAVE has no effect if issued interactively.

**Syntax**

```
LEAVE;
```

**LOADCONSTR**

Use the LOADCONSTR command to load constraints from treefile.

**Syntax**

```
LOADCONSTR [options];
```

**Menu equivalent**

Analysis > Load Constraints ...

**Available options**

- **FILE = tree-file-name**
- **APPEND = YES | NO**
- **ASBACKBONE = YES | NO**

*Option is nonpersistent*
**Description of options**

**FILE = tree-file-name**

Use FILE to specify the *tree-file-name* containing constraint trees.

**APPEND = YES | NO**

If APPEND = YES, then the constraints contained in the input file are added to any constraints already in memory.

**ASBACKBONE = YES | NO**

Use ASBACKBONE to load the trees as backbone constraints. Backbone constraint trees should contain only a subset of the taxa currently in memory.

---

**LOG**

By default, output generated by PAUP* goes only to the "display buffer," a region of memory set aside exclusively for this purpose. PAUP*'s main display window is used to view this information. The LOG command may be used to request direction of PAUP output to a file (e.g., for subsequent printing).

**Syntax**

```
LOG [options];
```

**Menu equivalent**

File > Log Output to Disk ...

**Available options**

- **FILE = log-file-name**
- ***REPLACE = YES | NO**
- ***APPEND = YES | NO**
- ***START = YES | NO**
- ***STOP = YES | NO**
- **FLUSHLOG = YES | NO**

*Option is nonpersistent

**Description of options**

**FILE = log-file-name**

The name and location of the log file may be specified using the FILE command. If the *file-specification* contains any of the characters equal-sign (=), semicolon (;), colon (:), or blank, it must be enclosed within single-quotes. See "Input/Output files" on page 9 for
information on how to specify platform specific path names.

**REPLACE = YES | NO**

If REPLACE is not specified explicitly and the file already exists, you will receive a warning and will have the opportunity to cancel the command before the contents of the existing file are erased.

**APPEND = YES | NO**

If APPEND is specified, subsequent output is appended to the previous contents (if any) of the file. Otherwise, subsequent output will overwrite the original contents of the file. The APPEND/REPLACE setting is retained between invocations of the LOG command, unless the file is changed by a FILE= directive.

**START = YES | NO**

If START is specified logging is initiated to the named file. If FILE is not specified explicitly, a default name is assigned.

**FLUSHLOG = YES | NO**

Specification of FLUSHLOG causes the file's buffer to be flushed after every line of output. Ordinarily, this degrades system performance and is not recommended. However, there may be situations in which immediate flushing is useful.

**Example**

The following example uses the LOG command to save basic information about the trees (see the "DescribeTrees" command described on page 51) in memory to the file named "myoutput.log"; after which logging is stopped. In the final line logging is resumed and the subsequent output is appended to the original log file.

```
log file=myoutput.log;
describetrees;
log stop;
log start append;
```

---

**LSCORES**

Use the LSCORES command to calculate the likelihoods of trees in memory.

**Syntax**

```
LSCORES [tree-list] [/options];
```

**Menu equivalent**

Trees > Tree Scores > Likelihood ...
Available options

- SITELIKES = YES | NO
- CATEGLIKES = YES | NO
- *SORTTREES = YES | NO
- STOREASWTS = YES | NO
- SCOREFILE = file-name-for-scores
- *REPLACE = YES | NO
- *APPEND = YES | NO
- *DISPLAYOUT = NO | YES
- *PARSAPPROX = YES | NO
- KHTest = NONE | NORMAL | RELL | FULLOpt
- SHTest = NONE | RELL | FULLOpt
- BOOTREPS = integer-value
-TAILKH = 1 | 2
-NST = 1 | 2 | 6
- TRATIO = real-value | ESTIMATE | PREVIOUS
- RMATRIX = (rAC rAG rAT rCG rCT) | ESTIMATE | PREVIOUS
- RCLASS = (cAC cAG cAT cCG cCT cGT)
- VARIANT = HKY | F84
- BASEFreq = EMPIRICAL | EQUAL | ESTIMATE | PREVIOUS | (frqA frqC frqG)
- RATES = EQUAL | GAMMA | SITEspec
- SHAPE = real-value | ESTIMATE | PREVIOUS
- NCAT = integer-value
- REPRate = MEAN | MEDIAN
- WTS = REPEATCNT | IGNORE
- INITBRLEN = ROGERS | LS | real-value
- MAXPASS = integer-value
- SMAXPASS = integer-value
- DELTA = real-value
- SDELTA = real-value
- USEAPPROX = YES | NO
- APPROXlim = real-value
- ADJUSTAPPLim = YES | NO
- LOGiter = YES | NO
- PINVAR = real-value | ESTIMATE | PREVIOUS
- RECON = MARGINAL | JOINT
- ALLPROBS = YES | NO
• **SITE**RATES = PARTITION\[charpartition-name\] | RATESET\[rateset-name\] | PREVIOUS
• **CLOCK** = YES | NO
• USERBRLENS = YES | NO
• MINMEMREQ = YES | NO
• STARTVALS = PARSAPPROX | ARBITRARY
• PARAMCLOCK = STANDARD | RAMBAUT | BRLENS | SPLITTIMES | MDRAMBAUT | THORNE
• LCOLLAPSE = YES | NO
• MLDISTFORLS = YES | NO
• OPTBRLENS = NEWTON1D | BRENT1D | PRAXIS

*Option is nonpersistent

**Description of options**

SITELIKES = YES | NO

Use SITELIKES to output single-site likelihood scores.

CATEGLIKES = YES | NO

If gamma and/or invariable-sites rates are specified, the relative contribution to the likelihood for a site from each rate category is available when single-site likelihoods are requested (i.e., SITELIKES=Yes)

SORTTREES = YES | NO

When multiple trees are evaluated under the LSCORES command SORTTREES = YES will sort tree scores so that they are displayed in ascending order. Note, SORTTREES = YES may noticably increase the time required to display tree scores.

STOREASWTS = YES | NO

Use STOREASWTS to store the site-likelihood scores as character-weights. The reason for doing this are esoteric; there would ordinarily be no reason to use this option.

SCOREFILE = file-name-for-scores

If SCOREFILE is specified, likelihood scores and parameter estimates for each tree evaluated are saved to a text file. The file-name-for-scores must follow the conventions described under "Input/Output files" on page 9.

REPLACE = YES | NO
APPEND = YES | NO

If the file-name-for-scores already exists, you will be prompted for confirmation before the existing file is replaced. Use REPLACE = YES to suppress this prompt; the existing file will be quietly overwritten by the new data. Alternatively, you
may specify APPEND, in which case a new TREES block will be
concatenated to the end of an existing file.

**DISPLAYOUT**  **NO|YES**

Set DISPLAYOUT = YES if you wish to suppress output to the
display buffer.

**PARSAPPROX**  **YES|NO**

Use PARSAPPROX to specify parsimony-based approximations of
likelihood model parameters (i.e., the gamma shape parameter and
the parameters used in the instantaneous rate matrix).

**KHTEST**  **NONE|NORMAL|RELL|FULLOPT**

Use KHTEST to perform the Kishino-Hasegawa test (Kishino and
Hasegawa, 1989) and to specify the distribution of the test statistic.
If NONE (the default) is specified, the test is not performed. If
NORMAL is specified a normal distribution is used for the test
distribution. RELL generates a test distribution by the resampling
estimated log-likelihood method (Kishino et al. 1990). FULLOPT is
similar to RELL except that log-likelihood scores are estimated using
a fully optimized model.

**TAILKH**  **1|2**

Use TAILKH to select whether P-values are calculated from
one or two tails of the test distribution.

**SHTEST**  **NONE|RELL|FULLOPT**

Use SHTEST to perform the Shimodaira-Hasegawa test (Shimodaira
and Hasegawa, 1999; see also Goldman et al., 2000) and to specify the
distribution of the test statistic. If NONE (the default) is specified, the
test is not performed. RELL generates a test distribution by the
resampling estimated log-likelihood method (Kishino et al. 1990).
FULLOPT is similar to RELL except that log-likelihood scores are
estimated using a fully optimized model.

**BOOTREPS**  **integer-value**

Use BOOTREPS to specify the number of bootstrap replicates used to
generate a test distribution when RELL or FULLOPT is selected for the
KHTEST or SHTEST options. The default number of bootstrap
replicates is 1000.

**Example**

The following example of the LSCORES command returns the empirical base
frequencies, the estimated transition/transversion ratio, and the negative
log likelihood of all trees in memory.

```
lscore all/nst=2 basefreq=empirical tratio=estimate;
```

See the "LSet" on page 87 for a description of the remaining options.
LSET

Use the LSET command to set options for maximum likelihood analysis.

Syntax

LSET [options];

Menu equivalent

Analysis > Likelihood Settings ...

Available options

- NST = 1 | 2 | 6
- TRATIO = real-value | ESTIMATE | PREVIOUS
- RMATRIX = (rAC rAG rAT rCG rCT) | ESTIMATE | PREVIOUS
- RCLASS = (cAC cAG cAT cCG cCT cGT )
- VARIANT = HKY | F84
- BASEFREQ = EMPIRICAL | EQUAL | ESTIMATE | PREVIOUS | (frqA frqC frqG)
- RATES = EQUAL | GAMMA | SITE_SPEC
- SHAPE = real-value | ESTIMATE | PREVIOUS
- NCAT = integer-value
- REPRATE = MEAN | MEDIAN
- WTS = REPEATCNT | IGNORE
- INITBRLEN = ROGERS | LS | real-value
- MAXPASS = integer-value
- DELTA = real-value
- USEAPPROX = YES | NO
- APPROXLIM = real-value
- ADJUSTAPPLIM = YES | NO
- LOGITER = YES | NO
- PINVAR = real-value | ESTIMATE | PREVIOUS
- RECON = MARGINAL | JOINT
- ALLPROBS = YES | NO
- SITERATES = PARTITION[:charpartition-name] | RATESET[:rateset-name] | PREVIOUS
- CLOCK = YES | NO
- ZEROLENTEST = NO | FULL | CRUDE
- USERBRLENS = YES | NO
- MINMEMREQ = YES | NO
Commands used in the PAUP Block

- **STARTVALS =** *ParsApprox* | Arbitrary
- **PARAMCLOCK =** *Standard* | Rambaut | brlens | SplitTimes | MDRambaut | Thorne
- **LCollapse =** *Yes* | No
- **MLDistForLS =** *Yes* | No
- **OptBrLens =** Newton1D | Brent1D | Praxis

*Option is nonpersistent*

**Description of options**

The following options are used to specify the substitution model parameters:

- **NST =** 1 | 2 | 6
  
  Use NST to specify the number of substitution types. For example, if NST = 1, then all substitution types are pooled into a single rate.

- **TRATIO =** real-value | ESTIMATE | PREVIOUS
  
  Use TRATIO to specify a transition/transversion ratio. If TRATIO = PREVIOUS, then the Transversion:Transition ratio in memory will be applied. Use TRATIO = ESTIMATE to obtain the maximum likelihood estimate for the data set and tree topology currently in memory. The default value for this option is 2. TRATIO is ignored unless NST = 2.

- **RMATRIX =** *(rAC rAG rAT rCG rCT)* | ESTIMATE | PREVIOUS
  
  If NST = 6, then the values for a six-parameter instantaneous rate matrix may be specified, estimated using maximum likelihood (ESTIMATE), or set to the values currently in memory (PREVIOUS).

- **RCLASS =** *(cAC cAG cAT cCG cCT cGT)*
  
  If RMATRIX = ESTIMATE, then a submodel of the six-parameter rate matrix may be specified. For example, substitution types may be pooled into common classes to reflect changes between structurally similar molecules (e.g. transitions and transversions). A user is free to decide among the many possible ways that substitution types may be divided or combined. One restriction of the GTR model is the Tamura-Nei model.

**Example 1**

The following example pools transitions into a common rate class and defines two separate rate classes for transversions. Rate classes will be estimated using maximum likelihood.

```
lset nst=6 rmatix=estimate rclass=(a b a a c a);
```

Use the following options to specify the base frequency parameters:
VARIANT = HKY | F84

If TRATIO is used, then you may choose between two variants of the 2-parameter model for unequal base frequencies; that is, the model described by Felsenstein (1984) or Hasegawa-Kishino-Yano (1985).

BASEFREQ = EMPIRICAL | EQUAL | ESTIMATE | PREVIOUS | (freqA freqC freqG)

By default PAUP* uses the empirical base frequencies (EMPIRICAL). Base frequencies may also be estimated by maximum likelihood for a data set and tree topology (ESTIMATE), assumed equal (EQUAL), explicitly specified (freqA freqC freqG), or set the values currently in memory (PREVIOUS).

The following options are used to specify among-site rate variation parameters:

RATES = EQUAL | GAMMA | SITE SPEC

Use RATES to specify a model of among-site rate variation. By default, PAUP* assumes that all sites change at the same rate; however, many molecular studies suggest that equal rates is not a valid assumption. You may choose between two models to compensate for among site rate-variation.

SHAPE = real-value | ESTIMATE | PREVIOUS

Use the SHAPE option to specify the shape of the gamma distribution used to accommodate among-site rate variation. If SHAPE = ESTIMATE, then the maximum likelihood estimate of this parameter is obtained for a given data set and tree topology. If SHAPE = PREVIOUS, then the value of SHAPE already in memory is used. The default value for this option is 0.5.

NCAT = integer-value

Use NCAT to specify the number of categories to divide the discrete approximation of the gamma distribution.

REPRATE = MEAN | MEDIAN

Use REPRATE to specify whether the mean or the median is used to represent the rates within each category of the discrete approximate gamma distribution.

PINVAR = real-value | ESTIMATE | PREVIOUS

Use PINVAR to specify the proportion of sites unable to accept substitutions; the remaining sites are assumed to vary at the same rate. The default value for this option is 0.

SITERATES = PARTITION[:charpartition-name] | RATESET[:rateset-name ] | PREVIOUS

Use SITERATES to obtain a single rate estimate for a set of characters. The default for this option is none.
Example 2

The following example uses a discrete gamma distribution with four rate categories to estimate across-site rate heterogeneity. The shape parameter of the gamma distribution is estimated using maximum likelihood.

lset rates=gamma ncat=4 shape=estimate;

Example 3

The following example estimates a single rate for each subset of the data as defined in the CHARPARTITION command. See "CharPartition" on page 42 for more detail regarding this command.

charpartition genes=g1:1-300, g2:301-600, g3:601-700;
lset rates=sitespec siterates=partition:genes;

Example 4

The following example defines a specific rate for each subset of the data as defined by the RATESET command. See "RateSet" on page 106 for more details regarding this command.

rateset genes=1:1-300, 2:301-600, 3:601-700;
lset rates=sitespec siterates=rateset:genes;

Use the following options to specify the starting parameter values for the likelihood estimation:

STARTVALS = PARSAPPROX | ARBITRARY

By default, PAUP* uses parsimony-based approximations for the starting values of some parameters estimated by maximum likelihood. If STARTVALS = ARBITRARY, then arbitrary values are used. The parsimony-based starting point is usually much closer to the optimal value and convergence to the optimum will therefore occur more quickly. In some cases, however, the parsimony estimate can be a poor choice and convergence will occur more quickly from an arbitrary starting point.

INITBRLEN = ROGERS | LS | real-value

Use INITBRLEN to specify the method for initializing starting branch lengths. By default, PAUP* uses the Rogers-Swofford method (ROGERS); however, you may also specify a least-squared method (LS), or an arbitrary value (real-value).

MLDISTFORLS = YES | NO

Development of this option is in progress.

USEAPPROX = YES | NO

Use USEAPPROX to reject trees if approximate likelihood exceeds the exact likelihood by more than a specified amount. By default PAUP*
rejects all trees with a likelihood score greater than the five percent of the exact value. In so doing, PAUP* evaluates fewer topologies dramatically reducing overall search times.

**APPROXLIM = real-value**

Use APPROXLIM to specify the percent deviation from the exact likelihood score before a tree is no longer considered for branch swapping.

**ADJUSTAPPLIM = YES | NO**

Use ADJUSTAPPLIM to dynamically readjust the limit specified under APPROXLIM.

Use the following options to specify performance tuning settings:

**MAXPASS = integer-value**

Use MAXPASS to set the maximum number of branch-length smoothing passes. Setting MAXPASS to a smaller value can speed search times, but the objective function may not be fully optimized.

**DELTA = real-value**

Use DELTA to set the value for stopping smoothing passes. In other words, when a score changes less than the real-value specified, PAUP* assumes that the branch lengths have converged to their optimal values for a given tree.

**OPTBRLENS = NEWTON1D | BRENT1D | PRAXIS**

This option is currently under development.

**LOGITER = YES | NO**

If LOGITER = YES, then the progress of the branch-length iterations will be output to the display buffer. This output can be extensive and it is ordinarily not useful.

**MINMEMREQ = YES | NO**

If MINMEMREQ = YES, then the memory requirements will be minimized. The speed of most operations will be penalized if this option is specified.

Miscellaneous options:

**RECON = MARGINAL | JOINT**

Use RECON to specify the method used to reconstruct ancestral state characters.

**ALLPROBS = YES | NO**

Use ALLPROBS to show marginal probabilities of all base assignments when ancestral states are reconstructed.
CLOCK = YES | No

If CLOCK = YES, then the molecular clock model is enforced.

PARAMCLOCK = STANDARD | Rambaut | brLens | SplitTimes | MDRambaut | Thorne

If PARAMCLOCK=STANDARD (the default), the multidimensional version of Rambaut's parameterization is used when one or more substitution-model parameters are being estimated. If no parameters other than branch lengths are being estimated, the one-dimensional version of Rambaut's parameterization is used. To force a specific method to be used regardless of the number of parameters being estimated, use PARAMCLOCK=<anything-other-than-standard>.

ZEROLENTEST = NO | Full | Crude

Unless ZEROLENTEST=NO, a likelihood-ratio test for whether a branch-length is zero is performed when branch lengths are output under the DESCRIBETREES command (page 51). The best test, ZEROLENTEST=FULL, optimizes all branch lengths under the constraint that one of the branches is zero, for each branch tested. The Full option can be slow for large trees, so an alternative test is available (ZEROLENTEST=Crude) in which the likelihood of the tree is determined after setting each branch, in turn, to zero length, with no readjustment to the other branches. This is the same test implemented by Joe Felsenstein in DNAML (who also used the word "crude" to describe this method in his documentation).

USERBRLENS = YES | No

If USERBRLENS = YES, then user-input branch lengths are used when evaluating user-trees.

LCOLLAPSE = YES | No

Use LCOLLAPSE to collapse branches of effectively zero length when searching. Branches have length less than or equal to $1 \times 10^{-8}$ are collapsed.

WTS = REPEATCNT | Ignore

If WTS=Ignore, character weights are ignored. The default (WTS = REPEATCNT) treats integer weights as repeat counts.

**MATRIXREP**

Use dthe MATRIXREP command to save trees in "matrix representation." A NEXUS file is created that contains a dummy character for each clade on the tree; analysis of the resulting data set under parsimony will regenerate the original tree.
Syntax

MATRIXREP [options];

Menu equivalent

Trees > Matrix Representation ...

Available options

- FILE = tree-file-name
- BRLENS = NO | YES
- FROM = starting-tree-number
- TO = ending-tree-number
- *REPLACE = NO | YES
- *APPEND = NO | YES

*Option is nonpersistent

Description of options

BRLENS = NO | YES

Use BRLENS=YES to save branch lengths as character weights; a weighted parsimony analysis using these weights will regenerate the original tree and branch lengths.

FILE = tree-file-name

Specifies a name for the tree file. If you do not explicitly specify a file name, a default file name will be used.

REPLACE = YES | NO
APPEND = YES | NO

If FILE = tree-file-name option is specified and the tree-file-name already exists, you will be prompted for confirmation that the existing file should be replaced. Explicit specification of REPLACE = YES suppresses this prompt; the existing file will be quietly overwritten by the new data. Alternatively, you may specify APPEND = YES, in which case a new TREES block will be concatenated to the end of an existing file.

FROM = starting-tree-number

If nonzero, starting-tree-number specifies the number of the first tree to save.

TO = ending-tree-number

If nonzero, ending-tree-number specifies the number of the last tree to save.
Use the MPRSETS command to request output of possible character-state assignments (MPR-sets) for one or more characters on one or more trees, by superimposing the possible character-states for each node on a diagram of the tree.

**Syntax**

```
MPRSETS  character-list  [/options];
```

The `character-list` specifies the character(s) for which possible character-state assignments are shown, and consists of one or more character numbers, character names, or character-set names.

**Menu equivalent**

Trees > Show Reconstructions ...

**Available options**

- `TREES = tree-list`
- `TCOMPRESS = YES | NO`

**Description of options**

`TREES = tree-list`

The `tree-list` specifies the tree numbers for which possible character-state assignments are to be shown. If this is the first MPRSETS command and you do not specify a tree list, reconstructions are shown for the first tree only.

`TCOMPRESS = YES | NO`

See "Options And Subcommands Affecting Multiple Commands" on page 30 for details.

If no characters are specified for either a RECONSTRUCT (page 107) or MPRSETS command, the characters are taken to be those plotted in the last invocation of either of these commands. For example, `RECONSTRUCT 1 3 5 7; MPRSETS;` will cause both commands to output information for characters 1, 3, 5, and 7.

**NJ**

Use the NJ command to calculate a tree using the neighbor-joining method.

**Syntax**

```
NJ  [options];
```
**Menu equivalent**

Analysis > Neighbor Joining/UPGMA ...

**Available options**

- **ENFORCE = YES | NO**
- **CONSTRAINTS = constraint-name**
- **BRLENS = YES | NO**
- **BREAKTIES = SYSTEMATIC | RANDOM**
- **TIESEED = integer-value**
- **SHOWTREE = YES | NO**
- **TREEFILE = tree-file-name**
- ***REPLACE = YES | NO**
- ***APPEND = YES | NO**

*Option is nonpersistent

**Description of options**

**BRLENS = YES | NO**

If BRLENS is specified, a list of branch lengths will be output to the display buffer and tree descriptions will include branch lengths. BRLENS = NO reverses the effect of a previous BRLENS specification.

**BREAKTIES = SYSTEMATIC | RANDOM**

Unless BREAKTIES = RANDOM, ties encountered during tree construction are broken systematically according to the input order of the taxa.

**TIESEED = integer-value**

If BREAKTIES = RANDOM, PAUP* references the system clock to initialize the seed used to generate pseudorandom numbers for breaking ties found during tree construction. An explicit seed may be specified to override the system clock default. (See "INITSEEDS = 0 | 1" on page 116 for more details.)

**SHOWTREE = YES | NO**

If SHOWTREE = YES, the neighbor-joining tree is printed to the display buffer.

**TREEFILE = tree-file-name**

If TREEFILE is specified, a description of the trees found by the neighbor-joining method is output to a file in the NEXUS tree format. If BRLENS = YES the tree description in the tree-file will contain branch length information. The tree-file-name must follow the conventions described under"Input/Output files" on page 9.
REPLACE = YES | NO
APPEND = YES | NO

If the specified file already exists, you will be prompted for confirmation before the existing file is replaced. Use REPLACE = YES to suppress this prompt; the existing file will be quietly overwritten by the new data. Alternatively, you may specify APPEND, in which case a new TREES block will be concatenated to the end of an existing file.

See "Options And Subcommands Affecting Multiple Commands" on page 30 for a description of the following options:

ENFORCE = YES | NO
CONSTRAINTS = constraint-name

OUTGROUP

Use the OUTGROUP command to assign one or more taxa to the outgroup.

Syntax

    OUTGROUP taxon-list [/ONLY];

Unless /ONLY is specified, taxa specified in the taxon-list are simply added to the current outgroup. If taxa have already been assigned to the outgroup and you want only those taxa specified in taxon-list to remain in the outgroup, specify /ONLY; any taxon that is not explicitly specified in the list will be transferred to the ingroup.

Menu equivalent

Data > Define Outgroup ...

PAIRDIFF

Use the PAIRDIFF command to show nucleotide-pair frequencies.

Syntax

    PAIRDIFF [taxon-list] [/options];

Menu equivalent

Data > Pairwise Base Differences ...

Available options

- SHORTFMT = YES | NO
- LONGFMT = YES | NO
**Description of options**

**SHORTFmt = YES | NO**

If SHORTFmt is specified, then nucleotide-pair frequencies, proportion of sites differing, and apparent transition/transversion ratio is given on a single line for each sequence pair.

**LONGFmt = YES | NO**

If LONGFmt is specified, then a 4 X 4 matrix of nucleotide-pair frequencies, proportion of sites differing, and apparent transition/transversion ratio is given for each sequence pair both before and after adjustments are made for gaps/ambiguities.

**PERMUTE**

Use the PERMUTE command to perform Archie-Faith-Cranston randomization tests.

**Syntax**

```
PERMUTE [options] [/heuristic-search-options | branch-and-bound-search-options];
```

**Menu equivalent**

Analysis > Permutation Tests ...

**Available options**

- **TEST = PTP | TPTP | COMPARE2**
- **PSEED = integer-value**
- **NREPS = integer-value**
- **SEARCH = HEURISTIC | BANDB**
- **RANDOMIZE = ALL | INGROUP**
- **CONVERSE = YES | NO**
- **CONSTRAINTS = constraint-name**
- **FIRST = constraint-tree-name**
- **SECOND = constraint-tree-name**

**Description of options**

**TEST = PTP | TPTP | COMPARE2**

TEST = PTP does a simple permutation test for the existence of phylogenetic structure. TEST = TPTP does a "topology-dependent" PTP test; comparing the best unconstrained tree to threees forces to be compatible with a constraint tree. If TEST = COMPARE2, then the difference between two topologies is compared to a null distribution...
of differences.

PSEED = integer-value
By default, PAUP* references the system clock to initialize the seed used to generate sequences of pseudorandom numbers for randomizing characters. An explicit seed may be specified to override the system clock default. (See "INITSEEDS = 0|1" on page 116 for more details.)

NREPS = integer-value
Use NREPS to select the number of times the original data set is permuted for the null distribution of tree scores or tree score differences.

SEARCH = HEURISTIC | BANDB
Use SEARCH to select a tree searching strategy to be used on each permutation of the original data set.

RANDOMIZE = ALL | INGROUP
By default PAUP* randomizes the character states of all taxa used in the analyses. If RANDOMIZE = INGROUP, then only the character states of the ingroup taxa are randomized.

FIRST = constraint-tree-name
SECOND = constraint-tree-name
If TEST = COMPARE2, use the FIRST and SECOND options to name the constraint trees to be compared.

CONSTRAINTS = constraint-name
Specifies the constraint tree to be used for the T-PTP test.

CONVERSE = YES | NO
See "Options And Subcommands Affecting Multiple Commands" on page 30 for a description of this option.

PSCORES
Use the PSCORES command to request a listing of tree lengths and/or fit measures for one or more trees.

Syntax

PSCORES [tree-list] [/options];

If no tree-list is specified, ALL is assumed. By default, only tree lengths (for single characters, overall, or both) are output.
Menu equivalent

Trees > Tree Scores > Parsimony ...

Available options

- **SINGLE = NO | VAR | ALL**
- **RANGE = YES | NO**
- **TOTAL = YES | NO**
- **TL = YES | NO**
- **CI = YES | NO**
- **RI = YES | NO**
- **RC = YES | NO**
- **HI = YES | NO**
- **GFIT = YES | NO**
- **KHTEST = YES | NO**
- **NONPARAMTEST = YES | NO**
- **TESTDETAILS = YES | NO**
- **SORTTREES = YES | NO**
- **SCOREFILE = score-file-name**
- ***APPEND = YES | NO**
- ***REPLACE = YES | NO**
- ***DISPLAYOUT = YES | NO**

*Option is nonpersistent

Description of options

**SINGLE = ALL | VAR | NO**

The SINGLE option specifies the type of single-character output. If SINGLE = ALL, lengths (or fit measures) are output for all trees specified by tree-list. If SINGLE = VAR, lengths (or fit measures) are output only for those characters whose lengths vary among the trees specified by tree-list. If SINGLE = NO, no single-character tree lengths (or fit measures) are output.

**RANGE = YES | NO**

If RANGE is specified, only the minimum and maximum tree lengths (or best and worst fit measures) are output for each character.

**TOTAL = YES | NO**

If TOTAL = NO is specified, overall tree lengths and fit measures are not output.
TL = YES | NO
Unless TL = No is specified, tree lengths are output. The default is to show tree lengths and no other fit measures.

CI = YES | NO
Use CI to request output of consistency indices.

RI = YES | NO
Use RI to request output of retention indices.

RC = YES | NO
Use RC to request output of rescaled consistency indices.

HI = YES | NO
Use HI to request output of homoplasy indices.

GFIT = { YES | NO }
Use GFIT to request output of Goloboff-fits.

KHTEST = YES | NO
Use KHTEST to request that the Kishino-Hasegawa test be used to compare pairs of topologies.

NONPARAMTEST = YES | NO
Use NONPARAMTEST to request that the Templeton (Wilcoxon signed-rank) and winning-sites (sign) tests be used to compare pairs of topologies.

TESTDETAILS = YES | NO
If NONPARAMTEST = YES, then use TESTDETAILS to display a detailed summary of the Templeton (Wilcoxon signed-rank) test calculations.

SORTTREES = YES | NO
When multiple trees are evaluated under the PSCORES command SORTTREES = YES will sort tree scores so that they are displayed in ascending order. Note, SORTTREES = YES may noticeably increase the time required to display tree scores.

SCOREFILE = score-file-name
If SCOREFILE is specified, parsimony scores for each tree evaluated are saved to a text file. The score-file-name must follow the conventions described under "Input/Output files" on page 9.

APPEND = YES | NO
REPLACE = YES | NO
If the score-file-name already exists, you will be prompted for confirmation before the existing file is replaced. Use REPLACE
= YES to suppress this prompt; the existing file will be quietly overwritten by the new data. Alternatively, you may specify APPEND, in which case a new TREES block will be concatenated to the end of an existing file.

DISPLAYOUT = YES | NO

Set DISPLAY = YES if you wish to suppress output to the display buffer. The DISPLAYOUT option must be used in conjunction with the SCOREFILE option.

PSet

Use the PSet command to set options for parsimony analysis.

Syntax

PSet [options];

Menu equivalent

Analysis > Parsimony Settings ...

Available options

- COLLAPSE = NO | MAXBRLEN | MINBRLEN | AMBEQUAL
- MSTAXA = UNCERTAIN | POLYMORPH | VARIABLE
- OPT = ACCTRAN | DELTRAN | MINF
- STEPMATRIX = OBSONLY | ALLSTATES | THREEPLUS1
- INCLUDEANC YES | NO
- ANCSTATES = ancsstates-name
- GK = integer-value
- GOLBOFF = YES | NO
- GUNINF = EXCLUDE | INCLUDE
- GPEEWE = YES | NO
- MINFORFIT = MINLENGTH | RANGE
- GAPMODE = MISSING | NewState

Description of options

COLLAPSE = NO | MAXBRLEN | MINBRLEN | AMBEQUAL

Use COLLAPSE to specify the criterion for collapsing branch lengths. MAXBRLEN is the default method used in PAUP* and the method used in PAUP version 3 (and Hennig86). MINBRLEN collapses a branch if it is possible for it to have zero length. AMBEQUAL collapses a branch if the MPRset of the two incident nodes are identical. These latter two methods were introduced in Goloboff’s NONA program.
We do not recommend their use, but they are available for those who wish to use them.

**MSTAXA = UNCERTAIN | POLYMORPH | VARIABLE**

If one or more taxa are coded as having multiple states use MSTAXA to specify how those characters are treated. If MSTAXA = VARIABLE the punctuation used to enclose multistate characters is respected. More specifically, characters enclosed by "{}" are treated as variable and characters enclosed by "()" are treated as polymorphic.

**MINFORFIT = MINLENGTH | RANGE**

If MSTAXA is specified, then use MINFORFIT to specify the "minimum" values used for calculating CI, RI, and RC indices. You may specify minimum-possible single-character lengths (MINLENGTH) or character "ranges" (RANGE) be used.

**STEPMatrix = OBSONLY | ALLSTATES | THREEPLUS1**

By default PAUP* allows assignment of states not observed in terminal taxa to internal nodes but only those states that can be identified as potential shortcuts by the "3+1" test (STEPMatrix = THREEPLUS1). If STEPMatrix = ALLSTATES, then any possible character state may be assigned to an internal node. If STEPMatrix = OBSONLY, then internal-node state assignments are limited to states observed in the terminal data.

**INCLUDEANC = YES | NO**

Use INCLUDEANC to include a hypothetical taxon possessing putative ancestral states for all characters in the searches. This taxon specifies the root of the tree.

**GOLOBOFF = YES | NO**

Use GOLOBOFF to specify the Goloboff-fit criterion.

**GK = integer-value**

Use GK to specify the concavity parameter in Goloboff’s implied weights method. Note that this value corresponds to the definition of K given by Goloboff (1993) and not the CONC parameter in Goloboff’s Pee-Wee program; which is equal to K+1. The default value for this option is 2.

**GUNINF = EXCLUDE | INCLUDE**

If GUNINF = INCLUDE, then fits for "uninformative" characters are included.

**GPeEWee = YES | NO**

Although it is not recommended, you may specify GPeEWee to emulate results obtained by the program Pee-Wee written by P. Goloboff. Calculations are performed using integer arithmetic with weights ranging from 0 to 100, and fractional values are truncated rather than rounded.
**GAPMODE = MISSING | NEWSTATE**

If GAPMODE = MISSING, gap characters in sequence data are treated as "missing." If GAPMODE = NEWSTATE, gap characters are treated as a fifth base or 21st amino acid.

See "Options And Subcommands Affecting Multiple Commands" on page 30 for a description of the following options:

- **ANCSTATES = ancsates-name**
- **OPT = ACCTRAN | DELTRAN | MINF**

---

**PUZZLE**

Use the PUZZLE command to find a tree by the quartet puzzling method. This method is currently supported only for the maximum likelihood criterion.

**Syntax**

```
PUZZLE [options];
```

**Menu equivalent**

Analysis > Quartet Puzzling ...

**Available options**

- **NPUZZLES = integer-value**
- **SEED = integer-value**
- **SHOWTREE = YES | NO**
- **GRPfreq = YES | NO**
- **CUTOFFPCT = integer-value**
- **USEAPPROXL = YES | NO**
- **TREEFILE = tree-file-name**
- ***REPLACE = YES | NO**
- ***APPEND = YES | NO**
- **DSTATUS = integer-value | NONE**
- **MINMEMREQ = YES | NO**

*Option is nonpersistent

**Description of options**

- **NPUZZLES = integer-value**
  
  Use NPUZZLES to specify the number of puzzling steps. The default value for this option is 1000
SEED = integer-value

By default, PAUP* references the system clock to initialize the seed used to generate sequences of pseudorandom numbers used to determine the order of sequence insertion during the "puzzling" step. An explicit seed may be specified to override the system clock default. (See "INITSEEDS = 0 | 1" on page 116 for more details.)

SHOWTREE = YES | NO

Use SHOWTREE to print the tree found by quartet-puzzling to the display buffer.

GRPFREQ = YES | NO

Use GRPFREQ to show all observed bipartitions found during the "puzzling" step and the frequency at which they occurred.

CUTOFFPCT = integer-value

Use CUTOFFPCT to specify the minimum puzzle partition frequency to be displayed in the partition frequency table. Partitions occurring at a frequency below this value are not shown.

USEAPPROXL = YES | NO

If USEAPPROXL = YES, then approximate rather than "exact" likelihoods will be used.

TREEFILE = tree-file-name

If TREEFILE is specified, a description of the tree found at each puzzling step is output to a file in the NEXUS tree format. The tree-file-name must follow the conventions described under "Input/Output files" on page 9.

REPLACE = YES | NO
APPEND = YES | NO

If the specified file already exists, you will be prompted for confirmation that the existing file should be replaced. Explicit specification of REPLACE suppresses this prompt and the existing file will be quietly overwritten by the new data. Alternatively, you may specify APPEND, in which case a new TREES block will be concatenated to the end of an existing file.

DSTATUS = integer-value | NONE

See "Options And Subcommands Affecting Multiple Commands" on page 30 for a description of this option.

MINMEMREQ = YES | NO

Specifying MINMEMREQ = YES minimizes memory requirements but also can increase the amount of time required to complete an analysis.
QUIT

The QUIT command causes PAUP* to terminate. Unless you specify the option WARNTSAVE = NO, PAUP* will prompt you before quitting if there are unsaved trees in memory. WARNTSAVE is the only option under this command.

Syntax

QUIT [options];

Menu equivalent

File > Quit

Available options

• WARNTSAVE = YES | NO

RANDTREES

Use the RANDTREES command to randomly sample trees from the set of all possible trees and compute their scores under the current optimality criterion. The results are shown in the form of a frequency distribution of tree scores.

Syntax

RANDTREES [options];

Menu equivalent

Analysis > Evaluate Random Trees ...

Available options

• NREPS = integer-value
• SEED = integer-value
• FDTYPE = BARCHART | HISTOGRAM
• NCLASSES = integer-value
• FDFILE = frequency-distribution-file-name
• *REPLACE = YES | NO

*Option is nonpersistent
Description of options

NREPS = integer-value

   integer-value specifies the number of random trees to be evaluated. The default is NREPS = 1000.

SEED = integer-value

   By default, PAUP* references the system clock to initialize the seed used to generate sequences of pseudorandom numbers used to randomly sample tree topologies. An explicit seed may be specified to override the system clock default. (See "INITSEEDS = 0 | 1" on page 116 for more details.)

FDTYPE = BARCHART | HISTOGRAM

   The default FDTYPE specifies that the number of trees at each tree score is output as a BARCHART. If FDTYPE = HISTOGRAM, tree scores are pooled into classes, the size of which is specified by the NCLASSES option.

NCLASSES = integer-value

   Integer-value specifies the number of class intervals for the frequency distribution of tree scores. By default, NCLASSES = 20, so that adjacent tree scores are pooled into 20 classes of tree scores.

FDFILE = frequency-distribution-file-name

   If FDFILE is specified, data for the frequency distribution of tree scores are saved to a text file for input to other programs. The FDFILE option is not persistent. Frequency-distribution-file-name specifies the name of the file to receive the frequency distribution. (See "Input/Output files" on page 9 for more details).

   REPLACE = YES | NO

   If FDFILE is used and the specified file already exists you will be prompted for confirmation that the existing file should be replaced. REPLACE suppresses this prompt and the existing file will be quietly overwritten by the new data.

RATESET

Use the RATESET command to define a "rate set".

Syntax

   RATESET rate-set-name = rateset-definition ;

Example 1

In the following example, the RATESET command is used to define three gene fragments according to their position in the data matrix.
Example 2

In the following example, the RATESET command is used to defined codon positions base on previously defined character sets (see the "CharSet" command described on page 23).

```plaintext
charset 1stpos = 2-457\3 660-896\3;
charset 2ndpos = 3-457\3 661-896\3;
charset 3rdpos = 4-457\3 662-.\3;
rateset codons=1:1stpos, 2:2ndpos, 3:3rdpos;
```

**RECONSTRUCT**

Use the RECONSTRUCT command to request output of character-state reconstructions for one or more characters on one or more trees. The reconstruction is shown by superimposing the character-states assigned to each node on a plot of the tree. Reconstructions are available under either the parsimony or likelihood criterion.

**Syntax**

```plaintext
RECONSTRUCT [character-list] [/options];
```

The `character-list` specifies the character(s) for which reconstructions are shown, and consists of one or more character numbers, character names, or character-set names.

**Menu equivalent**

Trees > Show Reconstructions ...

**Available options**

- **TREES = tree-list**
- **TCOMPRESS = YES | NO**

**Description of options**

**TREES = tree-list**

The `tree-list` specifies the tree numbers for which reconstructions are to be shown. If this is the first RECONSTRUCT command and you do not specify a tree list, reconstructions are shown for the first tree only. If other options follow the TREES option you must the put the `tree-list` list in double quotes.

**TCOMPRESS = YES | NO**

See "Options And Subcommands Affecting Multiple Commands" on page 30 for details.
If no characters are specified for either a RECONSTRUCT or MPRSETS (page 94) command, the characters are taken to be those plotted in the last invocation of either of these commands. For example, `reconstruct 1 3 5 7; mprets;` will cause both commands to output information for characters 1, 3, 5, and 7.

**RESTORE**

The RESTORE command is synonymous with the UNDELETE command. See "Undelete" on page 132 for a description of available options.

**REVFILTER**

Use the REVFILTER command to "reverse" the effect of the current filter. All trees that are currently hidden by the filter will become visible, and all trees that were previously visible will be hidden. There are no options.

**Syntax**

```
REVFILTER;
```

**Menu equivalent**

Trees > Filter > Reverse Filter

**REWEIGHT**

Use the REWEIGHT command to assign weights to the characters based on their fit to the trees currently in memory.

**Syntax**

```
REWEIGHT [options];
```

**Menu equivalent**

Data > Reweight Characters ...

**Available options**

- `INDEX = RC | CI | RI`
- `FIT = MAXIMUM | MINIMUM | MEAN`
- `BASEWT = integer-value`
- `TRUNCATE = YES | NO`
- `MINFORFIT = RANGE | MINLENGTH`
Description of options

BASEWT = integer-value

Base-weight specifies the maximum possible weight that a character can be assigned, corresponding to an index value (see below) of 1. Weights are scaled from 0 to this value. The default is BASEWT=1.

INDEX = RC | CI | RI

The INDEX option is used to specify which fit measure to use when calculating the new character weights (RC = rescaled consistency index, CI = consistency index, RI = retention index).

FIT = MAXIMUM | MINIMUM | MEAN

The FIT option is used to specify whether the new weights are based on the maximum, minimum, or mean of the fit values for each character over all of the trees in memory.

TRUNCATE = YES | NO

Because PAUP* uses integers to represent weights, they are ordinarily scaled to the nearest integer by rounding. Use the TRUNCATE option if you want to simply discard the fractional part (e.g., 8.7 goes to 8 rather than 9). This option is primarily intended to duplicate the weights obtained using the Hennig86 program (Farris, 1988).

MINFORFIT = RANGE | MINLENGTH

If the data matrix contains polymorphic or uncertain characters, use MINFORFIT to specify the "minimum" values used for calculating CI, RI, and RC indices. You may specify minimum-possible single-character lengths (MINLENGTH) or character "ranges" (RANGE) be used.

RootTrees

Use the RootTrees command to convert all trees in memory from an unrooted to a rooted representation. Trees are rooted according to the currently specified outgroup.

Syntax

RootTrees  [options] ;

Menu equivalent

Trees > Root Trees

Available options

• OUTROOT = POLYTOMY | PARAPHYL | MONOPHYL
• **METHOD** = **OUTGROUP** | **LUNDBERG** | **MIDPOINT**
• **USERBRLENS** = **YES** | **NO**

**Description of options**

**OUTROOT** = **POLYTOMY** | **PARAPHYL** | **MONOPHYL**

See "Options And Subcommands Affecting Multiple Commands" on page 30 for details.

**METHOD** = **OUTGROUP** | **LUNDBERG** | **MIDPOINT**

The **METHOD** option is used to specify how unrooted trees are to be rooted prior to output. You can choose **OUTGROUP** rooting, using whichever outgroup you have selected; **MIDPOINT** rooting, which roots the tree at its midpoint; or **LUNDBERG** rooting, which requires that a previous **ANCSTATES** command has been issued. By default, **OUTGROUP** rooting is in effect.

**USERBRLENS** = **YES** | **NO**

If **METHOD** = **MIDPOINT**, then you may specify user-defined branch lengths.

**SAVEASSUM**

Use the **SAVEASSUM** command to save the current character-type, character-weight, character-exclusion, ancestral-states, taxon-deletion, and outgroup status to a file in **ASSUMPTIONS** and a **PAUP** block. You can restore the settings in effect at the time the **SAVEASSUM** command was issued simply by executing the commands stored in the file (use the "Execute" command described on page 60 for this purpose).

**Syntax**

```
SAVEASSUM [options] ;
```

**Menu equivalent**

Data > Save Current Assumptions ...

**Available options**

• **FILE** = **settings-file-name**
• **REPLACE** = **YES** | **NO**

*Option is nonpersistent

**Description of options**

**FILE** = **settings-file-name**

The **FILE** option is used to specify the name and location of the file
with the current assumptions settings. The settings-file-name must follow the conventions described under "Input/Output files" on page 9.

\[
\text{REPLACE} = \text{YES} | \text{NO}
\]

By default, if the specified file already exists, you will be asked if you want to replace it. To suppress this warning, specify REPLACE; in this case the file will be quietly overwritten.

**SAVEDIST**

Use the SAVEDIST command to save distance matrix to a file.

**Syntax**

\[
\text{SAVEDIST [options]};
\]

**Menu equivalent**

File > Save Distances To File ...

**Available options**

- \(\text{FORMAT} = \text{ONECOLUMN} | \text{TabText} | \text{NEXUS} | \text{PHYLIP}\)
- \(\text{FILE} = \text{export-file-name}\)
- \(\text{TRIANGLE} = \text{LOWER} | \text{UPPER} | \text{BOTH}\)
- \(\text{DIAGONAL} = \text{YES} | \text{NO}\)
- \(\text{UNDEFINED} = \text{TWICEMAX} | \text{ASTERISK}\)
- \(\text{NDECIMALS} = \text{integer-value}\)
- \(*\text{REPLACE} = \text{YES} | \text{NO}\)
- \(*\text{APPEND} = \text{YES} | \text{NO}\)

*Option is nonpersistent

**Description of options**

**FORMAT = \text{ONECOLUMN} | \text{TabText} | \text{NEXUS} | \text{PHYLIP}**

Use FORMAT to request that pairwise distances be output as tab-delimited text either as a full matrix format (TabText) or in a single-column (ONECOLUMN) useful for saturation plots, etc.

**TRIANGLE = \text{LOWER} | \text{UPPER} | \text{BOTH}**

If any FORMAT other than ONECOLUMN is selected than the distances matrix may be output as a lower half triangle (LOWER), an upper half triangle (UPPER), or full matrix (BOTH).
**DIAGONAL** = YES | NO

Use the **DIAGONAL** option to include the diagonal values if relevant.

**UNDEFINED** = TWICEMAX | ASTERISK

Use **UNDEFINED** to specify whether undefined distances are output as twice the maximum defined distance (TWICEMAX) or as an asterisk (ASTERISK).

**NDECPALS** = integer-value

Use **NDECPALS** to specify the maximum number of decimals allowed for pairwise distances.

**FILE** = export-file-name

Use the **FILE** to output pairwise distances to a file in one of two formats. The **export-file-name** must follow the file-name conventions described "Input/Output files" on page 9.

**REPLACE** = YES | NO
**APPEND** = YES | NO

If **FILE = export-file-name** option is specified and the **export-file-name** already exists, you will be prompted for confirmation that the existing file should be replaced. Explicit specification of **REPLACE = YES** suppresses this prompt; the existing file will be quietly overwritten by the new data. Alternatively, you may specify **APPEND = YES**, in which case new distances in the specified format will be concatenated to the end of an existing file.

---

**SAVE TREES**

Use the **SAVE TREES** command to write trees currently in memory to a file as a NEXUS-format TREES block or as a treefile accepted by another program.

**Syntax**

```
SAVE TREES [options];
```

**Menu equivalent**

Trees > Save Trees to File ...

**Available options**

- **FILE = tree-file-name**
- **FORMAT** = NEXUS | ALTNEXUS | FREQPARS | PHYLIP | HENNIG
- **ROOT** = YES | NO
- **BRLENS** = YES | NO
- **SAVEBOOTP** = NO | BRLENS | NODELABELS | BOTH
• MAXDECIMALS = integer-value
• FROM = integer-value
• TO = integer-value
• *REPLACE = YES | NO
• *APPEND = YES | NO

*Option is nonpersistent

**Description of options**

**FORMAT = NEXUS | ALTNEX | FREQPARS | PHYLIP | HENNIG**

Specifies the type of tree-file to produce. NEXUS requests a file containing the standard NEXUS TREES block using a translation table (which greatly reduces the amount of disk space required to store the trees). ALTNEX also specifies a NEXUS TREES block, but no translation table is used (the full taxon names are included in each tree description). FREQPARS requests a treefile for the FREQPARS program described by Swofford and Berlocher (1987). PHYLIP requests a treefile for input to version 3.4 of Felsenstein's (1991) PHYLIP package. HENNIG requests a treefile for version 1.5 of Farris's (1988) Hennig86 program.

**BRLENS = YES | NO**

If BRLENS is specified, tree descriptions will include branch lengths if the program corresponding to the FORMAT setting supports them. BRLENS = NO reverses the effect of a previous BRLENS specification. Branch lengths are calculated according to the current optimality criterion. If the SAVETREE command is given following the BOOTSTRAP (page 39) or JACKKNIFE command (page 77), branch lengths will represent bootstrap support values. To save branch lengths for individual bootstrap or jackknife replicate trees use the TREEFILE and BRLENS options under the BOOTSTRAP (page 39) or JACKKNIFE (page 77) commands.

**SAVEBOOTP = NO | BRLENS | NODELABELS | BOTH**

Use SAVEBOOTP to include bootstrap or jackknife proportions as branch lengths (BRLENS), internal node labels (NODELABELS), or both (BOTH). Note, branch lengths saved as node labels are only recognized by other programs.

**MAXDECIMALS = integer-value**

If branch lengths will be included in tree descriptions, use MAXDECIMALS to specify the maximum number of decimals stored in each tree description.

**FILE = tree-file-name**

Specifies a name for the tree file. If you do not explicitly specify a file name, a default file name will be used.
REPLACE = YES | NO
APPEND = YES | NO

If FILE = tree-file-name option is specified and the tree-file-name already exists, you will be prompted for confirmation that the existing file should be replaced. Explicit specification of REPLACE = YES suppresses this prompt; the existing file will be quietly overwritten by the new data. Alternatively, you may specify APPEND = YES, in which case a new TRES block will be concatenated to the end of an existing file.

FROM = integer-value

If nonzero, starting-tree-number specifies the number of the first tree to save.

TO = integer-value

If nonzero, ending-tree-number specifies the number of the last tree to save.

ROOT = YES | NO

If the current trees in memory are unrooted and ROOT is specified, trees are rooted (using the rooting options currently in effect) before they are saved. Note that the process of rooting the trees slows down the saving operation considerably. If you are saving the trees only with the intention of rereading them into PAUP*, there is no need to root the trees. However, if you are exporting the trees to another program, rooting them may be desirable.

The ROOT option has no effect if the trees in memory are already rooted. ROOT = NO can be used to reverse the effect of a previous ROOT specification.

**SET**

The SET command is used to set a variety of options whose scope extends beyond single commands.

**Syntax**

```
SET [options];
```

**Menu equivalent**

Options

**Available options**

- ROOT = OUTGROUP | LUNDBERG | MIDPOINT
- INITSEEDS = 0 | 1
- MONITOR = YES | NO
• SEMIGRAPH = Yes | No
• MAXTREES = integer-value
• INCREASE = No | Prompt | Auto
• AUTOINC = integer-value
• SHOWEXCLUDED = Yes | No
• ALLOWPUNCT = Yes | No
• CMLABELS = Yes | No
• CMShowEq = Yes | No
• CMColWid = integer-value
• CMCSTATUS = Yes | No
• CONSTRAINTS = constraint-name
• ERRORBEEP = Yes | No
• QUERYBEEP = Yes | No
• KEYBEEP = Yes | No
• NOTIFYBEEP = Yes | No
• ERRORSTOP = Yes | No
• AUTOCLOSE = Yes | No
• TORDER = Standard | Right | Left | Alphabet
• CHECKEVTS = Yes | No
• TCOMPRESS = Yes | No
• SHOWTAXNUM = Yes | No
• BACKGROUND = Yes | No
• STATUS = Yes | No
• OUTROOT = Polytomy | Paraphyl | Monophyl
• VISNOTIF = None | ShowAlert | FlashOnly
• FLUSHLOG = Yes | No
• ALLOWEND = Yes | No
• ALLDigLab = Prohibit | Warn | NoWarn
• CRITERION = Parsimony | Likelihood | Distance
• DSTATUS = integer-value | None
• DEFAULTMODE = Yes | No
• STOREBRLENS = Yes | No
• STORETREEWTS = Yes | No
• WARNRESET = Yes | No
• WARNTREE = Yes | No
• WARNTSAVE = Yes | No
• WARNBLKNAME = Yes | No
• WARNROOT = Yes | No
- WarnRedef = Yes | No
- ShowAbbrev = Yes | No
- Pause = No | Silent | Beep | Msg
- TaxLabels = Full | Truncate
- DropMode = Edit | Conditional | Execute

**Description of options**

**Monitor = Yes | No**

Monitor = No suppresses output to the "main display" (window or terminal screen) and is useful when you want to send output to the log file and/or printer only. Monitor = Yes reactivates the main display.

At least one output destination must be active at all times. Consequently, if no log file is active or the "echo to printer" (Echo) option is not set, output will be sent to the main display even if Monitor = No has been requested.

**InitSeeds = 0 | 1**

A few commands used in PAUP* require sequences of "random" numbers (i.e., Bootstrap, JackKnife, HomPart, Permute, RandTrees, Puzzle, and SurfCheck). Other commands also use "random" numbers, but only when certain options are specified (i.e., GenerateTrees, HSearch, NJ, and StarDecomp). PAUP* uses a linear congruential method starting with an integer between 1 and 2,147,483,646 to seed a random number generator. By default InitSeeds = 0, instructs PAUP* to obtain the initial seed from the system clock. Users may also set InitSeeds=1, in which case all seeds are initialized to 1. If you do not specify a starting seed for subsequent runs, the seed defaults to the next number in the random number sequence initiated during the previous run. Users are always given the option to specify a value for the seed on any command that accepts seed settings, thus overriding the PAUP* default of referencing the system clock. This InitSeeds option ONLY applies if a seed value has not been initialized during the current run of the program. You can reset the sequence using a clock-based seed value by specifying a seed value of 0 on any command that accepts seed settings.

**AllowPunct = Yes | No**

Unless AllowPunct is specified, taxon and character names in input data matrices must conform to the NEXUS specification; namely they cannot contain special punctuation characters like parentheses, hyphens, etc. (see "Identifiers" on page 6). If AllowPunct = Yes is set prior to processing of a Data or Characters block, then taxon and character names are allowed to contain these special characters. This option applies only to the Data and Characters blocks; names containing special characters must be enclosed within single quotes in other contexts. This option allows backward compatibility with files prepared for PAUP 3.1;
new data files should always conform to the NEXUS standard to prevent incompatibilities with other programs.

**SEMIGRAPH = YES | NO**

PAUP* uses special characters in its internal font to draw trees and other items. On the IBM-PC, these characters are nonstandard "high ASCII" characters. On the Macintosh, these characters are neither in the standard 128 ASCII characters nor in the set of special characters normally included with Macintosh fonts. Thus, although the trees look nice when drawn in the main display window, they may not look right when printed on some printers. Therefore, PAUP* ordinarily translates these "semigraphics" characters to standard ASCII substitutes when output is directed to a printer, file, or document window. If you want to override this behavior, specify SEMIGRAPH. (E.g., many IBM-PC printers can print the high ASCII characters, and the Apple LaserWriter can create a "bit map" version of PAUP*'s internal "PAUPMonaco" font).

This option is relevant only for DOS, Windows, and Macintosh interfaces.

**AUTOCLOSE = YES | NO**

After a search has ended the status window will remain in the foreground until the user closes it. Use AUTOCLOSE = YES to close the status window automatically after a run has ended.

**NOTIFYBEEP = YES | NO**

Unless NOTIFYBEEP = NO, a "beep" is sounded at the end of a search.

**TORDER = STANDARD | RIGHT | LEFT | ALPHABET**

Specifies the convention used to "order" the tree.

**FLUSHLOG = YES | NO**

Specification of FLUSHLOG causes the file's buffer to be flushed after every line of output. Ordinarily, this degrades system performance and is not recommended. However, there may be situations in which immediate flushing is useful.

**DROPMODE = EDIT | CONDITIONAL | EXECUTE**

The DROPMODE option allows the user to always edit (EDIT) or always execute (EXECUTE) when a PAUP* document is dragged onto the application icon or PAUP*'s main window. Otherwise, under the default setting (DROPMODE=CONDITIONAL) the file will be executed if no active data file has been set. If a data file is already active, the file will be edited. The DROPMODE option is only available to the Macintosh and Windows interfaces.

**ALLOWEND = YES | NO**

The NEXUS convention is to terminate blocks with END; however, earlier versions of PAUP used ENDBLOCK. Unless ALLOWEND = NO, PAUP* will accommodate both character strings for block
termination.

\texttt{ALLDIGLAB = PROHIBIT | WARN | NOWARN}

By default, PAUP* issues a warning if all digit taxa or character labels are included. Use \texttt{ALLDIGLAB} to prohibit the use of all-digit labels (\texttt{PROHIBIT}) or to allow all-digit labels and suppress warnings (\texttt{NOWARN}). See "Identifiers" on page 6 for a description of valid taxa and character labels.

\texttt{CRITERION = PARSIMONY | LIKELIHOOD | DISTANCE}

Use \texttt{CRITERION} to selection from the three optimality criterian.

\texttt{DEFAULTMODE = YES | NO}

By default when option settings or other information is required, a dialog box will be opened. If \texttt{DEFAULTMODE = YES}, then PAUP* will take a default action. Because the default action will not be appropriate in every situation, this option is not recommended unless you know what affect the default action will have on your analyses.

\texttt{STOREBRLENS = YES | NO}

If branch lengths are present in the TREES block, then \texttt{STOREBRLENS = YES} stores branch lengths for subsequent use within the program. Otherwise, the branch lengths are discarded.

\texttt{STORETREEWTS = YES | NO}

If tree weights are present in the TREES block, then \texttt{STORETREEWTS = YES} stores tree weights. When tree weights are the reciprocal of the number of trees found in either a \texttt{BOOTSTRAP} or \texttt{JACKKNIFE} replicate, this option allows the combination of bootstrap results from runs performed at different times or on different machines and the recovery of results obtained prior to a system crash. (See "\texttt{USETREEWTS = YES | NO}" on page 46 for more details)

\texttt{SHOWABBREV = YES | NO}

Specifies whether help shows command and option names so as to indicate the shortest acceptable abbreviation.

\texttt{TAXLABELS = FULL | TRUNCATE}

If \texttt{TAXLABELS = FULL}, then the full 127 characters of long taxon labels will be output to the display buffer (although they will still be truncated somewhat if the total output width cannot accommodate the long names). Otherwise, taxon names are truncated to 16 characters.

\texttt{ERRORSTOP = YES | NO}

Ordinarily, PAUP* stops processing an input file when unrecognized commands, \texttt{OPTIONS-command} keywords, or formats are encountered. If \texttt{ERRORSTOP = NO} is specified, a warning message is issued and processing is allowed to continue.
**WARNRESET = YES | NO**
Ordinarily, PAUP* issues a warning message when an input file containing a DATA block is executed and a DATA block has already been processed. Specification of WARNRESET = NO suppresses this warning.

**WARNTree = YES | NO**
Use WARNTree to issue a warning about treefile operations that could delete unsaved trees.

**WARNTSave = YES | NO**
Use WARNTSave to issue a warning before quitting if there are unsaved trees in memory.

**WARNBLKName = YES | NO**
Use WARNBLKName to issue a warning when unrecognized blocknames are included in a data set.

**WARNROOT = YES | NO**
Use WARNROOT to issue a warning about the rooting status of user-input trees.

**WARNREDEF = YES | NO**
Use WARNREDEF to issue a warning about redefining names for sets, constraints, etc.

**PAUSE = NO | SILENT | BEEP | MSG**
By default, output is displayed to the display buffer without pause. Alternatively, PAUP* will display one screen of output at a time either pausing silently (SILENT), issuing a warning beep (BEEP), or printing a message to the screen (MSG) for the user press return key before displaying the next screen.

**SHOWTaxNUM = YES | NO**
When SHOWTaxNUM is set to YES trees are displayed with both taxa labels and taxa numbers. The number are based on the order in which the taxa appear in the CHARACTERS or DATA blocks.

The following three options affect the setting of the maximum number of trees that PAUP* can store at any given time:

**MAXTrees = integer-value**
The MAXTrees parameter specifies the maximum number of trees that can be saved. Setting MAXTrees to a large value will reduce the likelihood that the tree buffer will become full during a search or tree-file operation, at the expense of a larger chunk of memory being tied up and therefore unavailable for other purposes.

Ordinarily, if the number of trees found during a search reaches the value of MAXTrees, you will be given a chance to increase MAXTrees...
before proceeding. This behavior can be altered using the INCREASE option (see below). MAXTREES is initially set to 100.

The MAXTREES option apply to the entire search in random-addition-sequence searches. If you would like to impose a maximum tree limit for each addition-sequence replicate then you must use the NCHUCK and CHUCKSCORE options under the HSEARCH command (page 71). For replicated searches such as the bootstrap (page 39), the jackknife (page 77), and the partition-homogeneity test (page 70) the limits are always applied separately for each search.

**INCREASE = PROMPT | AUTO | NO**

The setting of the INCREASE option determines the action taken by PAUP* if the limit on the number of trees that can be stored (=MAXTREES, see above) is reached during a search or a tree-file operation. If INCREASE = PROMPT, you will be given the opportunity to increase MAXTREES. If INCREASE = AUTO, MAXTREES will automatically be increased by a number of trees equal to the current AUTOINC setting (see below). If INCREASE = NO, MAXTREES will not be increased, and no prompt will be issued. In this case, a "tree-buffer overflow" occurs which can affect the effectiveness of the search in progress. (The tree-buffer overflow condition will be documented in the output.)

**AUTOINC = integer-value**

The AUTOINC value species the number of trees by which MAXTREES is increased when the number of trees saved reaches MAXTREES and the INCREASE = AUTO option is in effect. AUTOINC is initially set to 100.

**Example 1**

In the following example, a maximum tree limit of 100 for each random-addition-sequence replicate is set. The NCHUCH and CHUCKSCORE options of the HSEARCH command (page 71) are used to set the limit for each replicate search.

```
set maxtrees=1000 increase=no;
hsearch addseq=random nreps=10 nchuck=100
chuckscore=1;
```

The following three options specify whether PAUP* sounds a "beep" when various kinds of errors occur:

**ERRORBEEP = YES | NO**

Ordinarily, PAUP* beeps to alert you that an error message has been issued. Specify ERRORBEEP = NO to suppress these beeps.

**QUERYBEEP = YES | NO**

Ordinarily, PAUP* beeps to alert you when it stops for your input before it can continue a process. Specify QUERYBEEP = NO to suppress these beeps.
KEYBEEP = YES | NO

Ordinarily, PAUP* beeps when you type a key that is invalid in the current context. Specify KEYBEEP= NO to suppress these beeps.

The following three options are specific to the Macintosh version.

BACKGROUND = YES | NO

Ordinarily, PAUP* continues processing when it is moved to the background. Specify BACKGROUND = NO to suppress background processing, thereby giving more time to the foreground application.

CHECKEVTS = YES | NO

CHECKEVTS = NO disables "event-checking," causing all mouse clicks and key presses to be ignored. Speed of PAUP* searches is improved somewhat, but it will not be possible to stop the search (without restarting the computer) or to switch to a different application under MultiFinder.

VISNOTIF = NONE | SHOWALERT | FLASHONLY

When a background job ends an alert box will be sent to the foreground and the PAUP* icon on the task-menu will flash. Use VISNOTIF to suppress the alert box (FLASHONLY) or both of the alert box and the flashing PAUP* icon (NONE).

The following options are described in "Options And Subcommands Affecting Multiple Commands" command described on page 30:

CONSTRAINTS = CONSTRAINT-TREE-NAME
STATUS = YES | NO
DSTATUS = integer-value | NONE
ROOT = OUTGROUP | LUNDBERG | MIDPOINT
OUTROOT = POLY TOMY | PARAPHYL | MONOPHYL
TCOMPRESS = YES | NO
SHOWEXCLUDED = YES | NO
CMSHOWEQ = YES | NO
CMLABELS = YES | NO
CMCSTATUS = YES | NO
CMCOLWID = integer-value

SHOWANC

Use the SHOWANC command to request a listing of the ancestral character-states currently in effect. No options are available.

Syntax

SHOWANC;
**SHOWCHARPARTS**

Use the SHOWCHARPARTS command to show one or all character-partition definitions.

**Syntax**

```plaintext
SHOWCHARPARTS [partition-name];
```

If no `partition-name` is specified, all defined partitions are output.

**Menu equivalent**

Data > Show Other > AncStates

**SHOWCONSTR**

Use the SHOWCONSTR command to show one or more constraint-tree definitions.

**Syntax**

```plaintext
SHOWCONSTR [ {constraint-name | ALL} ];
```

If you do not specify a name (or ALL), the current default constraint tree will be shown. Specify ALL to show all constraint trees that have been defined.

**Menu equivalent**

Analysis > Show Constraints

**SHOWDIST**

Use the SHOWDIST command to output a matrix of "distances" between taxa. There are no options.

**Syntax**

```plaintext
SHOWDIST;
```

**Menu equivalent**

Data > Show Pairwise Distances
Use the DSET command (page 55) to specify the distance measure to be calculated.

**SHOWMATRIX**

Use the SHOWMATRIX command to list the current data matrix.

**Syntax**

```
SHOWMATRIX [options];
```

**Available options**

- `SHOWEXCLUDED = YES | NO`
- `CMLabels = YES | NO`
- `CMShowEQ = YES | NO`
- `CMColWID = integer-value`
- `CMCstatus = YES | NO`

The options available here are described under "Options And Subcommands Affecting Multiple Commands" on page 30.

**SHOWRATESETS**

Use the SHOWRATESETS command to show one or all rate-set definitions.

**Syntax**

```
SHOWRATESETS [rate-set-name];
```

**Menu equivalent**

Data > Show Other > RateSets

**SHOWTAXPARTS**

Use the SHOWTAXPARTS command to show one or all taxon-partition definitions.

**Syntax**

```
SHOWTAXPARTS [partition-name];
```

**Menu equivalent**

Data > Show Other > TaxPartitions
**SHOWTREES**

Use the SHOWTREES command to request a diagram of one or more trees with no other information (see also the DESCRIBE command).

**Syntax**

```
SHOWTREES [tree-list] [/options];
```

**Menu equivalent**

Trees > Show Trees ...

**Available options**

- **TCOMPRESS** = YES | NO
- **SHOWTAXNUM** = YES | NO
- **ROOT** = OUTGROUP | LUNDBERG | MIDPOINT
- **OUTROOT** = POLYTOMY | PARAPHYL | MONOPHYL
- **USERBRLENS** = YES | NO

**Description of options**

**USERBRLENS** = YES | NO

If **USERBRLENS** = YES, then user-supplied branch lengths are used.

**SHOWTAXNUM** = YES | NO

When **SHOWTAXNUM** is set to YES trees are displayed with both taxa labels and taxa numbers. The numbers are based on the order in which the taxa appear in the CHARACTERS or DATA blocks.

See "Options And Subcommands Affecting Multiple Commands" on page 30 for a description of the following options:

- **TCOMPRESS** = YES | NO
- **ROOT** = OUTGROUP | LUNDBERG | MIDPOINT
- **OUTROOT** = POLYTOMY | PARAPHYL | MONOPHYL

**SHOWUSERTYPE**

Use the SHOWUSERTYPE command to show all user-defined character types. There are no options for the command.

**Syntax**

```
SHOWUSERTYPE [user-type-name];
```
**Menu equivalent**

Data > Show Other > UserTypes

---

**SORTTREES**

Use the SORTTREES command to sort trees that are currently in memory according to the current optimality criterion.

**Syntax**

```
SORTTREES;
```

**Menu equivalent**

Trees > Sort Trees

---

**STARDECOMP**

Use the STARDECOMP command to find a tree by star-decomposition search.

**Syntax**

```
STARDECOMP [options];
```

**Menu equivalent**

Analysis > Star Decomposition Search ...

---

**Available options**

- `BREAKTIES = SYSTEMATIC | RANDOM`
- `TIESEED = integer-value`
- `ENFORCE = YES | NO`
- `CONSTRAINTS = constraint-name`

**Description of options**

**BREAKTIES = SYSTEMATIC | RANDOM**

Unless `BREAKTIES = RANDOM`, ties encountered during tree construction are broken systematically according to the input order of the taxa.

**TIESEED = integer-value**

If `BREAKTIES = RANDOM`, PAUP* references the system clock to initialize the seed used to generate pseudorandom numbers for breaking ties found during tree construction. An explicit seed may be specified to override the system clock default. (See "INITSEED = …"
ENFORCE = YES | NO
CONSTRAINTS = constraint-name

**SURFCHECK**

Use the SURFCHECK command to check likelihood surface for multiple peaks.

**Syntax**

```
SURFCHECK [options];
```

**Available options**

- NREPS = integer-value
- SEED = integer-value
- TREENUM = integer-value
- BRLENS = YES | NO

**Description of options**

**NREPS = integer-value**

Use NREPS to specify the number of passes...

**SEED = integer-value**

PAUP* references the system clock to initialize the seed used to generate pseudorandom numbers for sampling "random" branch lengths. An explicit seed may be specified to override the system clock default. (See "INITSEEDS = 0 | 1" on page 116 for more details.)

**TREENUM = integer-value**

Use TREENUM to specify the tree for which the likelihood surface is checked.

**BRLENS = { YES | NO }**

If BRLENS = YES, then user-supplied branch lengths are used.

**TAXPARTITION**

Define a partition of the taxa.
**Syntax**

TAXPARTITION  *partition-name*  =  *partition-definition*;

The TAXPARTITION command is ordinarily issued from within the SETS block (page 22). However, you may also issue it from the command line or from within a PAUP block. TAXPARTITIONS are need for "convexity" constraints.

**TAXSET**

Use the TAXSET command to define a "taxon set." Taxon sets are simply groups of taxa that can be referred to by a single name in other commands.

**Syntax**

TAXSET  *taxon-set-name*  =  *taxon-list*;

The taxon-set-name must not be identical to any of the original taxon names. The TAXSET command is ordinarily issued from within the SETS block (page 22). However, you may also issue it from the command line or from within a PAUP block.

**TIME**

Use the TIME command to output the current time and date.

**Syntax**

TIME;

**TONEXUS**

Use the TONEXUS command to convert a file to NEXUS format.

**Syntax**

TONEXUS  [options];

**Menu equivalent**

File > Import Data ...

**Available options**

- **FORMAT** = PHYLIP | HENNIG86 | TABTEXT | TEXT | GCG | MEGA | PIR | FREQPARS
- **FROMFILE** = foreign-file-name
• ToFile = NEXUS-file-name
• DataType = NUCLEOTIDE | PROTEIN | RESTSITE | STANDARD | DISTANCE | DNA
• Interleave = YES | NO
• GAPsymbol = single-character-value
• MISSsymbol = single-character-value
• IDENTsymbol = single-character-value
• *REPLACE = YES | NO

*Option is nonpersistent

Description of options

Format = PHYLIP | HENNIG86 | TabText | TEXT | GCG | MEGA | PIR | FREQPARS

Use Format to specify the import file-type. You may choose from the following formats:
1. PHYLIP (Felsenstein)
2. Hennig68 (Farris)
3. GCG  MSF
4. MEGA (Kumar, Tamura, and Nei)
4. NBRF-PIR
5. Text (tab or space delimited)
6. FREQPARS (Swofford and Berlocher)

FROMFILE = foreign-file-name
Use FROMFILE to specify the foreign-file-name to be imported.

ToFile = NEXUS-file-name
Use ToFile to specify the NEXUS-file-name used to save the NEXUS-formatted data set.

DataType = NUCLEOTIDE | PROTEIN | RESTSITE | STANDARD | DISTANCE | DNA
If Format = PHYLIP | TabText | TEXT, then use DataType to specify the type of data being imported. If Format = MEGA, then DataType = NUCLEOTIDE | PROTEIN | DISTANCE may be selected. Note that PAUP* currently does not support distance formats.

Interleave = YES | NO
Use Interleave if Format = PHYLIP and the data set in the PHYLIP file are interleaved.

GAPsymbol = single-character-value
If Format = TabText | TEXT | MEGA, then a single-character-value may
be entered to represent gaps.

MISSSYMBO L = single-character-value

If FORMAT = T A B T E X T | T E X T | M E G A , then a single-character-value may be entered to represent missing data.

IDENTSYMBO L = single-character-value

If FORMAT = T A B T E X T | T E X T | M E G A , then a single-character-value may be entered to represent an identity character. This is equivalent to what PAUP* refers to as MATCHCHAR (see page 13).

REPLACE = YES | NO

If the NEXUS-file-name used under the ToFILE option already exists you will be prompted for confirmation that the existing file should be replaced. REPLACE suppresses this prompt; the existing file will be quietly overwritten by the new data.

**TREEDIST**

Use the TREEDIST command to request output of a matrix of tree-to-tree distances computed according to the symmetric-difference or "partition" metric, or one of two metrics based on agreement subtrees.

**Syntax**

TREEDIST [options];

**Menu equivalent**

Trees > Tree-to-Tree Distances ...  

**Available options**

- **METRIC** = SYMDIFF | AGD1 | AGREEMENT
- **FROMTREE** = integer-value
- **FD** = YES | NO
- **SHOWALL** = YES | NO
- **FILE** = export-file-name
- *REPLACE = YES | NO
- *APPEND = YES | NO

*Option is nonpersistent

**Descriptions of options**

**METRIC** = SYMDIFF | AGD1 | AGREEMENT

Use **METRIC** to specify the metric used to calculate tree-to-tree
distances. By default, the symmetric-difference metric (SYMDIFF) (Penny and Hendy, 1985) is used; however, you may also choose between two agreement-subtree metrics d (AGREEMENT) and d1 (AGD1) (Goddard et al. 1994).

\textbf{FROMTREE = integer-value}

If FROMTREE is specified, then the tree given by the integer-value will be compared to all other trees retained in memory. The default (FROMTREE = 0) specifies that all pairwise tree comparison be made.

\textbf{FD = YES | NO}

By default, the frequency distribution of tree-to-tree distances is output. Use FD=NO to suppress this output, or FD to reverse the effect of a previous FD=NO specification.

\textbf{SHOWALL = YES | NO}

By default, a matrix of the tree-to-tree distances for all comparisons performed is output. Use SHOWALL=NO to suppress the output, or SHOWALL to reverse the effect of a previous SHOWALL=NO specification.

\textbf{FILE = export-file-name}

Use the FILE option to save the tree-to-tree distances (as specified under the METRIC option) to a file.

\textbf{REPLACE = YES | NO}

\textbf{APPEND = YES | NO}

If FILE = export-file-name option is specified and the export-file-name already exists, you will be prompted for confirmation that the existing file should be replaced. Explicit specification of REPLACE = YES suppresses this prompt and the existing file will be quietly overwritten by the new data. Alternatively, you may specify APPEND = YES, in which case a new TREES block will be concatenated to the end of an existing file.

\textbf{TREEINFO}

Use the TREEINFO command to obtain information on the status of trees currently in memory. No options are available.

\textbf{Syntax}

\texttt{TREEINFO;}

\textbf{Menu equivalent}

Trees > Tree Info > Brief Status
**TREEWTS**

Use the TREEWTS command to show current tree weights or specify new tree weights.

**Syntax**

```
TREEWTS {SHOW | list-of-tree-weights};
```

**Menu equivalent**

Trees > Tree Info > Tree Weights

**TSTATUS**

Use the TSTATUS command to obtain information on which taxa, if any, are deleted and which taxa have been assigned to the outgroup.

**Syntax**

```
TSTATUS [options];
```

**Menu equivalent**

Data > Show Taxon Status ...

**Available options**

- FULL = NO | YES
- DELETED = SHOW | HIDE

**Description of options**

**FULL = NO | YES**

By default (FULL = NO) PAUP* briefly summarizes the number of taxa, in the data matrix, deleted, and assigned to the outgroup. If FULL = YES one line per taxon is given.

**DELETED = SHOW | HIDE**

Unless DELETED = HIDE, TSTATUS will display information for all of the taxa included in the DATA (PAGE 18) or TAXA (PAGE 10) block.

**TYPESET**

The TYPESET command, used to define a type set, is ordinarily issued from within the ASSUMPTIONS block. However, you may also issue it from the command line or from within a PAUP block. See "Commands used in the ASSUMPTIONS Block" on page 19 for the description of this command.
UNDELETE

Use the UNDELETE command to restore previously deleted taxa (or delete taxa not in list).

**Syntax**

UNDELETE  taxon-list  [/ONLY]  [CLEAR TREES]  [options];

Unless /ONLY is specified, taxa specified in the taxon list are simply removed from the set of currently deleted taxa. Specify /ONLY to delete, in addition, any taxon not explicitly specified in the list.

**Menu equivalent**

Data > Delete-Restore Taxa ...

**Available options**

- *PRUNE = YES | NO
- *CLEAR TREES = YES | NO

**Description of options**

The following two options are ignored unless the "/Only" option is also requested, in which case the effect of the command may be a deletion of currently nondeleted taxa.

PRUNE = YES | NO

If PRUNE = YES is specified, newly deleted taxa will be removed ("pruned") from the trees currently in memory, which otherwise remain unmodified.

CLEAR TREES = YES | NO

If CLEAR TREES is specified, any trees currently in memory are simply deleted.

UPGMA

Use the UPGMA command to calculate a UPGMA tree.

**Syntax**

UPGMA  [options];

**Menu equivalent**

Analysis > Neighbor Joining/UPGMA ...
**Available options**

- **BRLENS = YES | NO**
- **BREAKTIES = SYSTEMATIC | RANDOM**
- **TIESEED = integer-value**
- **SHOWTREE = YES | NO**
- **TREEFILE = tree-file-name**
- ***REPLACE = YES | NO**
- ***APPEND = YES | NO**

*Option is nonpersistent

**Description of options**

**BRLENS = YES | NO**

If BRLENS = YES is specified, tree descriptions will include branch lengths. BRLENS = NO reverses the effect of a previous BRLENS specification.

**BREAKTIES = SYSTEMATIC | RANDOM**

Unless BREAKTIES = RANDOM, ties encountered during tree construction are broken systematically according to the input order of the taxa.

**TIESEED = integer-value**

If BREAKTIES = RANDOM, PAUP* references the system clock to initialize the seed used to generate pseudorandom numbers for breaking ties found during tree construction. An explicit seed may be specified to override the system clock default. (See "INITSEEDS = 0 | 1" on page 116 for more details.)

**SHOWTREE = YES | NO**

If SHOWTREE = YES, the UPGMA tree is printed to the display buffer.

**TREEFILE = tree-file-name**

If TREEFILE is specified, a description of the UPGMA tree is output to a file in the NEXUS tree format. The tree-file-name must follow the conventions described under "Input/Output files" on page 9.

**REPLACE = YES | NO**

**APPEND = YES | NO**

If the specified file already exists, you will be prompted for confirmation that the existing file should be replaced.Explicit specification of REPLACE suppresses this prompt and the existing file will be quietly overwritten by the new data. Alternatively, you may specify APPEND, in which case a new TREES block will be concatenated to the end of an existing file.
USER TREE

Use the USER TREE command to input a single user-defined tree. Ordinarily, you should use a TREES block (see "Commands used in the TREES Block" on page 25) to input one or more user-defined trees. This command merely provides a mechanism for quickly specifying a user-defined tree from the command line, which may be useful in certain situations.

USER TYPE

The USER TYPE command, used to define a user-defined character type, is ordinarily issued from within the ASSUMPTIONS block. However, you may also issue it from the command line or from within a PAUP block. See "Commands used in the ASSUMPTIONS Block" on page 19 for the description of this command.

WEIGHTS

Use the WEIGHTS command to assign weights to one or more characters.

Syntax

```
```

Each character-weight must be a valid character weight. Each character-list consists of one or more character numbers, character names, or character-set names (see "Character lists" on page 8 for details). The characters specified by character-list are assigned the immediately preceding character-weight. Any number of character-weight:character-list pairs, separated by commas, may be specified.

Menu equivalent

Data > Set Character Weights . . .

WTS

The WTS command is a synonym for the WEIGHTS command. For some reason, I have a hard time typing "weights."

WTSET

The WTSET command, used to define a weight set, is ordinarily issued from within the ASSUMPTIONS block. However, you may also issue it from the command line or from within a PAUP block. See "Commands used in the ASSUMPTIONS Block" on page 19 for the description of this command.
Adams, E. N., III. 1972. Consensus techniques and the comparison of taxonomic

Adams, E. N., III. 1986. N-trees as nestings: complexity, similarity, and consen-

Archie, J. W. 1989. Homoplasy excess ratios: new indices for measuring levels of
homoplasy in phylogenetic systematics and a critique of the consistency in-


cleavage maps within a maximum-likelihood framework. Systematic Zool-
ogy 34:21-34.


Naturalist 106:645-668.

26:77-88.


Farris, J. S. 1988. Hennig86, version 1.5. Distributed by the author, Port Jefferson
Station, N. Y.

Farris, J. S. 1989a. The retention index and homoplasy excess. Systematic Zool-
References


Kishino, H. and M. Hasegawa. 1989. Evaluation of the maximum likelihood estimate of the evolutionary tree topologies from DNA sequence data, and the


Maddison, W. P. In press. Missing data versus missing characters in phylogenetic analysis. Systematic Biology


Miyamoto, M. M. 1985. Consensus cladograms and general classifications. Clad-


